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Objective

Audience

Preface

This preface explains the objectives, intended audience, and organization of Cisco AON Development
Studio User Guide and describes the conventions that convey instructions and other information.

The preface contains the following sections:

Objective

Audience

Document Organization
Document Conventions

Related Documentation
Obtaining Documentation
Documentation Feedback

Cisco Product Security Overview
Product Alerts and Field Notices
Obtaining Technical Assistance

Obtaining Additional Publications and Information

This user guide provides procedures and reference information for the Cisco AON development studio
(ADS). This guide does not provide background information and basic instructions and procedures for
the AON software itself.

This guide isintended for Cisco AON users who need more detailed information on how to use and
implement the ADS features.

| oL-11798-01
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M Document Organization

Document Organization

This guide contains the following chapters:
- Chapter 1, “Getting Started with Cisco ADS,” describes how to get started using ADS.

» Chapter 2, “ Setting Bladelet Properties, Variables, and Rules,” explains how to set Bladelet
Properties, manage Variables, and set Rules within each Bladelet Properties window.

- Chapter 3, “ADS Bladelets Reference,” provides detailed reference information that you need to
choose and use ADS Bladelets.

« Chapter 4, “ADS PEP Attributes Reference,” provides detailed reference information that you need
to use ADS to assign Policy Execution Plan (PEP) attributes.

« Chapter 5, “ADS Message Types Reference,” provides detailed reference information that you need
to use ADS to assign message types.

» Chapter 6, “E-Mail to Cisco ADS Support,” provides detailed information about the E-mail to ADS
Support.

Document Conventions

This guide uses the convention where the symbol » represents the key |abeled Control. For example, the
key combination ~z means hold down the Control key while you press the z key.

Command descriptions use these conventions:

« Examplesthat contain system prompts denote interactive sessions, indicating the commands that
you should enter at the prompt. The system prompt indicates the current level of the EXEC
command interpreter. For example, the prompt router> indicates that you should be at the user
level, and the prompt router# indicates that you should be at the privileged level. Access to the
privileged level usually requires a password. Refer to the related software configuration and
reference documentation listed in “ Related Documentation” for additional information.

» Commands and keywords are in boldface font.

» Arguments for which you supply values arein italic font.

» Elementsin square brackets ([ ]) are optional.

- Alternative but required keywords are grouped in braces ({}) and separated by vertical bars (]).
Examples use these conventions:

« Terminal sessions and sample console screen displays are in screen font.

- Information you enter iSin boldface screen font.

» Nonprinting characters, such as passwords, are in angle brackets (< >).

» Default responses to system prompts are in square brackets ([]).

« Exclamation points (!) at the beginning of aline indicate a comment line.

A

Caution  Meansreader be careful. You are capable of doing something that might result in equipment damage or
loss of data.

Cisco AON Development Studio User Guide
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N

Note  Means reader take note. Notes contain hel pful suggestions or references to materials not contained in
this manual.

Q)

Timesaver  Means the described action saves time. You can save time by performing the action described in the
paragraph.

A

Warning  This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. To see translations of the warnings that appear in
this publication, refer to the Regulatory Compliance and Safety Information document that
accompanied this device. Statement 1074

Related Documentation

The Cisco AON documentation set includes the following guides:
» Release Notes for Cisco Application-Oriented Networking 2.4
» AON Installation and Upgrade Guide
< AON Administration Guide

» For further technical information regarding the third-party software, see the Trading Metrics
documentation at www.tradingmetrics.com/downl oads.

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. This section explains the
product documentation resources that Cisco offers.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_|anguages.shtml

Cisco AON Development Studio User Guide
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Product Documentation DVD

The Product Documentation DV D isalibrary of technical product documentation on a portable medium.
The DV D enablesyou to access installation, configuration, and command guides for Cisco hardware and
software products. With the DV D, you have access to the HTML documentation and some of the

PDF files found on the Cisco website at this URL:

http://www.cisco.com/univercd/home/home.htm

The Product Documentation DVD is created and released regularly. DV Ds are available singly or by
subscription. Registered Cisco.com users can order a Product Documentation DVD (product number
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation
Store at this URL:

http://www.cisco.com/go/marketpl ace/docstore

Ordering Documentation

You must be aregistered Cisco.com user to access Cisco Marketplace. Registered users may order Cisco
documentation at the Product Documentation Store at this URL:

http://www.cisco.com/go/marketplace/docstore
If you do not have a user ID or password, you can register at this URL:
http://tools.cisco.com/RPF/register/register.do

Documentation Feedback

You can provide feedback about Cisco technical documentation on the Cisco Support site area by
entering your comments in the feedback form available in every online document.

Cisco Product Security Overview

Cisco provides afree online Security Vulnerability Policy portal at this URL:
http://www.cisco.com/en/US/products/products_security vulnerability policy.html
From this site, you will find information about how to do the following:

» Report security vulnerabilities in Cisco products

« Obtain assistance with security incidents that involve Cisco products

» Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for Cisco productsis
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS)
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss feed.html

Cisco AON Development Studio User Guide
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Reporting Security Problems in Cisco Products

Tip

Cisco is committed to delivering secure products. We test our products internally before we release
them, and we strive to correct all vulnerabilities quickly. If you think that you have identified a
vulnerability in a Cisco product, contact PSIRT:

» For emergencies only— security-al ert@cisco.com

An emergency is either a condition in which asystem isunder active attack or a condition for which
a severe and urgent security vulnerability should be reported. All other conditions are considered
nonemergencies.

» For nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone;
- 1877 228-7302
» 1408 525-6532

We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been
encrypted with PGP versions 2.x through 9.x.

Never use arevoked encryption key or an expired encryption key. The correct public key to use in your
correspondence with PSIRT is the one linked in the Contact Summary section of the Security
Vulnerability Policy page at this URL:
http://www.cisco.com/en/US/products/products_security_vulnerability _policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT to find other means of encrypting the data before sending
any sensitive material.

Product Alerts and Field Notices

Modificationsto or updates about Cisco products are announced in Cisco Product Alertsand Cisco Field
Notices. You can receive these announcements by using the Product Alert Tool on Cisco.com. Thistool
enables you to create a profile and choose those products for which you want to receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. Registered users can access
the tool at this URL:

http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?l ocal=en
To register as a Cisco.com user, go to this URL:
http://tools.cisco.com/RPF/register/register.do

| oL-11798-01
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Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The

Cisco Support website on Cisco.com features extensive online support resources. In addition, if you
have avalid Cisco service contract, Cisco Technical Assistance Center (TAC) engineers provide
telephone support. If you do not have a valid Cisco service contract, contact your reseller.

Cisco Support Website

Note

Tip

The Cisco Support website provides online documents and tools for troubleshooting and resolving
technical issues with Cisco products and technologies. The website is available 24 hours a day at
this URL:

http://www.cisco.com/en/US/support/index.html

Accessto all toolson the Cisco Support website requires a Cisco.com user 1D and password. If you have
avalid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Before you submit arequest for service online or by phone, use the Cisco Product I dentification Tool
to locate your product serial number. You can access this tool from the Cisco Support website

by clicking the Get Tools & Resources link, clicking the All Tools (A-Z) tab, and then choosing
Cisco Product Identification Tool from the alphabetical list. Thistool offers three search options:

by product ID or model name; by tree view; or, for certain products, by copying and pasting show
command output. Search results show an illustration of your product with the serial number |abel
location highlighted. Locate the serial number label on your product and record the information
before placing a service call.

Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to update the web page
by holding down the Ctrl key while pressing F5.

To find technical information, narrow your search to look in technical documentation, not the
entire Cisco.com website. After using the Search box on the Cisco.com home page, click the
Advanced Search link next to the Search box on the resulting page and then click the
Technical Support & Documentation radio button.

To provide feedback about the Cisco.com website or a particular technical document, click
Contacts & Feedback at the top of any Cisco.com web page.

Cisco AON Development Studio User Guide
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Submitting a Service Request

Using the online TAC Service Reguest Tool is the fastest way to open S3 and $4 service requests.

(S3 and $4 service requests are those in which your network is minimally impaired or for which you
require product information.) After you describe your situation, the TAC Service Request Tool provides
recommended solutions. If your issue is not resolved using the recommended resources, your service
request is assigned to a Cisco engineer. The TAC Service Request Tool islocated at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone.
(S1 or S2 service requests are those in which your production network is down or severely degraded.)
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2704 55 55
USA: 1800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity
definitions.

Severity 1 (S1)—An existing network is“down” or thereisacritical impact to your business operations.
You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network isimpaired while most business operations
remain functional. You and Cisco will commit resources during normal business hoursto restore service
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or
configuration. Thereislittle or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online
and printed sources.

» The Cisco Online Subscription Center is the website where you can sign up for avariety of Cisco
e-mail newsletters and other communications. Create a profile and then select the subscriptions that
you would like to receive. To visit the Cisco Online Subscription Center, go to this URL:

http://www.cisco.com/offer/subscribe

| oL-11798-01
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» The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief
product overviews, key features, sample part numbers, and abbreviated technical specifications for
many Cisco products that are sold through channel partners. It is updated twice ayear and includes
the latest Cisco channel product offerings. To order and find out more about the Cisco Product
Quick Reference Guide, go to this URL:

http://www.cisco.com/go/guide

- Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo
merchandise. Visit Cisco Marketplace, the company store, at this URL :

http://www.cisco.com/go/marketplace/

» Cisco Press publishes a wide range of general networking, training, and certification titles. Both
new and experienced users will benefit from these publications. For current Cisco Press titles and
other information, go to Cisco Press at this URL:

http://www.ciscopress.com

« Internet Protocol Journal is a quarterly journal published by Cisco for engineering professionals
involved in designing, devel oping, and operating public and private internets and intranets. You can
access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

» Networking products offered by Cisco, as well as customer support services, can be obtained at
this URL:

http://www.cisco.com/en/US/products/index.html

» Networking Professionals Connection is an interactive website where networking professionals
share questions, suggestions, and information about networking products and technol ogies with
Cisco experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

» “What's New in Cisco Documentation” is an online publication that provides information about the
latest documentation releases for Cisco products. Updated monthly, this online publication is
organized by product category to direct you quickly to the documentation for your products. You
can view the latest release of “What’s New in Cisco Documentation” at this URL :

http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

» World-class networking training is available from Cisco. You can view current offerings at
this URL:

http://www.cisco.com/en/US/learning/index.html

Cisco AON Development Studio User Guide
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Note

= CHAPTER 1

Getting Started with Cisco ADS

Revised: March, 2007, OL-11798-01

Cisco Application-Oriented Networking (AON) technology is the foundation for a class of
network-embedded products and solutions that help converge intelligent networks with application
infrastructure.

AON technology works at the application-message level by inspecting a full message, including all
headers and content. It therefore understands the context of the message and can operate on those
messages while they are in transit and according to business policies. AON enables you to embed
intelligence capabilities into the network and significantly improve application communication.

To enable AON technology in your network, you use the following tools:

» Cisco AON Development Studio (ADS)—Windows-based tool for configuring how application
messages are handled at runtime.

» Cisco AON Management Console (AMC)—Linux- and web-based server for managing an AON
network. AMC synchronizes and processes input from all ADS systems on your network to ensure
consistent, up-to-date configurations across all AON-enabled switches and routers.

This chapter describes how to get started using ADS.

For more information on implementing an AON network, see the following:

» Other chaptersin this guide:
— Setting Bladelet Properties, Variables, and Rules
— ADS Bladelets Reference
— ADS PEP Attributes Reference
— ADS Message Types Reference
— E-Mail to Cisco ADS Support

« Other guidesin the AON library:
— AON Installation and Administration Guide (for information on the AMC server and nodes)

— AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)
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Chapter1  Getting Started with Cisco ADS |

W Contents

Contents

Prerequisites for Cisco ADS Installation and Operation, page 1-2
Information About Cisco ADS, page 1-2

How to Use Cisco ADS, page 1-2

Where To Go Next, page 1-24

Prerequisites for Cisco ADS Installation and Operation

S,

Ensure that you have a Microsoft Windows 2000 or Windows XP operating system.
Ensure that you have minimum 1 GB RAM; 2 GB RAM is recommended.
Ensure that you have minimum 500 MB hard disk space; 1 GB free disk space is recommended.

Contact your Cisco representative to learn how to access the Cisco ADS application. Download
Cisco ADS 2.1 and make a note of where the download package resides on your system.

Ensure that your system can connect to an AMC 2.1 server.

Note ~ ADS 2.1 must connect to AMC 2.1 for AON 2.1 software to work properly.

Information About Cisco ADS

AON technology operates on your network switches and routers by means of Bladelets, Policy
Execution Plans (PEPs), and message types that specify how to process particular traffic streams.

A Bladelet is an operation that is performed on a message. It is a user defined software component
that implements certain interfaces and provides a useful unit of functions. For example,
Authentication bladelet provides authentication against various authentication schemes such as,
LDAP, Kerberos, and Netegrity; it will not do anything else.

ADS provides a repository of predefined Bladelets that are organized by category—for example,
general, logic, message handling, routing, security, transformation, and so on.

A PEP is an assembly of Bladelets in a particular sequence.
A message type is afilter that determines what type of message a PEP is to process.

You use ADS to assemble and interconnect multiple Bladelets into a PEP and assign to the PEP one or
more message types. You then synchronize your ADS with your network’s AMC server to deploy the
PEP across your network switches and routers. AON-enabled switches and routers constitute a logical
network of nodes that operate at Layer 5 and Layer 6 of the Open System Interconnection (OSl) model.

How to Use Cisco ADS

This section provides the following information:

Installing Cisco ADS, page 1-3
Starting Cisco ADS, page 1-3

Cisco AON Development Studio User Guide
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How to Use Cisco ADS Il

- Exploring Cisco ADS, page 1-4

e Set E-mail and SMTP Server Information, page 1-10
» Creating PEPs, page 1-11

e , pagel1-17

Installing Cisco ADS

To install ADS, perform the following steps.

Stepl  Locate the ADSInstallerWin32.exe executable file.
Step2  Double-click the file icon. The Install Shield Wizard starts up.
Step3  In the Welcome window, click Next.
Step4  Inthe License Agreement window, click Accept.
Step5  Provide the requested information (name, organization, and e-mail address) and click Next.
Step6  Specify whereto install ADS as follows:
» To usethe displayed location, click Next.
- To specify another location, click Browse, select a new location, and click Next.
Step7  Specify a database port as follows:
» To usethe displayed port, click Next.

» To specify another port, type another port number and click Check Port Availability. Repeat as
needed until a message confirms that the port is available. Then click Next.

Step8  Review the displayed summary information and do one of the following:

- If all settings are correct, click Install.

- If any setting isincorrect, click Back, correct the setting, return to this window, and click Install.
Step9  Click Finish.
Step10  Reboot your system.

Note  Touninstall ADS, in Microsoft Windows choose Start > Programs > AON Development Studio >
Uninstall AON Development Studio and follow instructions.

Starting Cisco ADS

To start ADS, perform the following steps.

N
Note  For help at any time, from the toolbar click Help and then either Help, Context Sensitive Help, or
Support > FAQs.
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Step1  In Microsoft Windows, choose Start > Programs > AON Development Studio > AON Development
Studio (or click the AON Development Studio icon on your desktop).

>

Note  Startup time depends on your system hardware: more RAM and faster bus and processor speeds
mean shorter startup time.

Login Window
Step2  Atthe ADS Login window Figure 1-1, do the following:
a. Provide the following requested information:

« Username

» Password
» Connect to AMC (click the dropdown arrow to display AMC choices; choose or provide the
hostname or | P address for your AMC server)

« Port (port on which the AMC server listens for traffic; default is 7010)

Figure 1-1 ADS Login Window

AON Development Studio Log on

&)

Cisco SYSTEMS

Liser name: |
Password: |

Connect ko AMC: j (v | Port: |?DID

Cancel
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b. Click Connect. ADS connects to and synchronizes with the AMC server.

N
Note  On first login, you must connect to your AMC server so that your ADS can display existing
nodes. On future logins, you can either connect or work offline.

Exploring Cisco ADS

To explore and familiarize yourself with Cisco ADS, examine the following:

« Initial ADS Window, page 1-5

Cisco AON Development Studio User Guide
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» ADS Toolbar and Icon Bar, page 1-6
» Project Explorer Pane, page 1-6

» Navigator Pane, page 1-7

« PEP Developer Pane, page 1-7

» Problems Pane, page 1-8

» Task Pane, page 1-9

Initial ADS Window

You must familiarize yourself with the initial ADS window (Figure 1-2) and all the panes.

N

Note  All the panes other than the Task pane are empty when you start up for the first time.

Figure 1-2 Initial ADS Window
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ADS Toolbar and

Note

Icon Bar

The toolbar and an icon bar (icons are dimmed until operable) appear across the top.

Icons (Figure 1-3) provide shortcuts to various ADS functions, most of which you can also access both
from the toolbar and by means of a mouse right-click. You can determine what an operable (that is,
undimmed) icon does by holding your mouse over it.

Figure 1-3 ADS Toolbar and Icon Bar

File Edit “iew PEP Message Twpe Tools Help
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All the panes other than the Task pane are empty when you start up for the first time. However, the panes
are shown below as they would look if you were in the midst of PEP design.

Project Explorer Pane

Note

The Project Explorer pane (Figure 1-4) in the upper left portion of the window displays the hierarchy of
available system nodes and associated PEPs and message types that reside in your ADS.

A project contains all of the resources, such as PEPSs, message types, and property sets, created by ateam.
A teamworking in aproject isisolated from all other projects. The team can create and deploy resources
to the AON network without regard for what other teams are doing.

You must explicitly open aproject in the project explorer in order to access any resourcesin that project.
When aproject isopened for thefirst time, ADS synchronizesthe project with AMC automatically. ADS
does not synchronize with AMC when the project is opened on subsequent occasions.

The PEPs and message types are of your own creation or were created by others and downloaded to your
ADS during synchronization with the AMC server. You can turn the display on or off by clicking View
and checking or unchecking Project Explorer.

Figure 1-4 ADS WIndow: Project Explorer Pane
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For you to be able to create a PEP and message type, at least one node must have been created on the

AMC server and displayed on your ADS. You can create any number of PEPs and message types beneath
anode.

After you synchronize your ADS with the AMC server, the Project Explorer pane refreshes to display
any additional PEPs that other users may have posted to the AMC server.

You can update the list of projects displayed in the pane, including those that have been created while
ADS has been open, by selecting File > Get Project List.

The Navigator pane (Figure 1-5) in the lower left portion of the window displays a map of the entire PEP
that you are configuring and, in blue, the portion of that mat that is displayed in the PEP Devel oper pane
(described below). It enables you to navigate to different parts of the PEP quickly and easily, which is

particularly useful if the PEP islarge and complex. You can turn the display on or off by clicking View
and checking or unchecking Navigator.

Figure 1-5 ADS Window: Navigator Pane
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PEP Developer Pane

The PEP Developer pane (Figure 1-6) in the middle of the window is your workspace for designing a

PEP. You drag and drop various Bladelets to that pane and interconnect them to create a PEP. This pane
is always displayed.

You can display multiple PEPs at one time, each within its own tabbed view in the pane. PEP names are
displayed in the tabs and also in the Project Explorer pane hierarchy.

| oL-11798-01
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Figure 1-6 ADS WIindow: PEP Developer Pane
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N

Note  To create PEPs, see Creating PEPs, page 1-11.

Problems Pane
The Problems pane (Figure 1-7) beneath the PEP Devel oper window displays alist of critical problems,
errors, and alerts, as follows:

- Critical problems (denoted by red circles with one X in them) prevent the PEP from performing a
valid action. You must resolve all critical problems before you can synchronize your ADS with the
AMC server or save the PEP as atemplate for future PEP development.

» Errors(denoted by red circles with one horizontal line across them) prevent the PEP from operating
properly.

- Alerts (denoted by yellow triangles) prevent the PEP from operating properly.
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Figure 1-7 ADS Window: Problems Pane
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You can rearrange the display by clicking any of the column headings (Severity, Description, and
Location). By default, problems are displayed by severity type (critical problem or alert) and, within a
severity type, in al phabetical order. You can toggle between ascending and descending order by clicking
a heading. You can turn the display on or off by clicking View and checking or unchecking Problems.
Double-clicking any individual problem selects the offending Bladelet in the PEP Developer pane.

Task Pane

The Task pane (Figure 1-8) on the right side of the window is the source from which you drag and drop
Bladelets into the PEP Developer pane. You can turn the pane display on or off by clicking View and
checking or unchecking Task.
ADS provides a predefined list of Bladelets for you to use. Different Bladelet categories have different
functions.

~

Note - Two Bladelet types of particular importance are the Break and Exception markers, at the top of the

Task pane.

— The Break marker can be placed only inside loops and you cannot place any other bladel ets after
the Break marker. The Break marker is used to exit out of the loops.

— The Exception marker tracks and records exceptions in the PEP.
For information on these and other predefined Bladelets, see “ADS Bladelets Reference” chapter.

« Although doing so should rarely be necessary, you can create custom Bladel ets. Custom Bladelets
are best created by programmers. The programmer develops the Bladelet, uses the ADS Packaging
Wizard to package the resulting filesinto a single file, and uploads the file to the AMC server. The
new Bladelet becomes available to ADS users after synchronization.

When a PEP is selected, the custom Bladel etsvisible are only those that are applicable to the project
containing the PEP. The applicable bladelets are the custom bladel ets added under the project and
the bladel ets added under the system project.

For information on custom Bladelets, see the AON Programming Guide.
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Figure 1-8 ADS Window: Task Pane
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Set E-mail and SMTP Server Information

Stepl  Set your E-mail Preferences and SMTP Server:
a. From thetoolbar, click Tools > Options > Email Preferences.

b. Inthe Email Preferences window (Figure 1-9), enter your E-mail address and SMTP Server
information.

Cisco AON Development Studio User Guide
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Figure 1-9 Options to set Email Preferences
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c. Click OK.
When you are done with your work session, you can close ADS by choosing File > Quit.

For more information about using the ADS e-mail feature, see E-mail Support, page 6-1.

Creating PEPs

Q)

To create a PEP, perform the following steps.

Timesaver ~ Most steps instruct you to click an icon or, alternatively, choose a command sequence. Instructions to
choose a command sequence (example: choose PEP > New) refer to commands on the ADS toolbar. In
many cases you can access the same command sequence by right-clicking the relevant entry in the
Project Explorer pane or the relevant Bladelet in the PEP Developer pane.

Stepl  Start ADSandlogin.
Step2  Inthe Project Explorer pane, click the AON node where the PEP is to reside.
Step3  Start anew PEP by clicking the New icon (or choosing PEP > New).
A
Note  Onsubsequent use, if you have saved a PEP template, select PEPs and right-click on New > New
PEP from Template. Preview your saved templates, select one, and click OK.
Step4  Inthe PEP Attributes window (Figure 1-10), provide the required information (name, package,
description, and interaction style€) to the new PEP and click OK.
Cisco AON Development Studio User Guide
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« PEP Name—Maximum characters 128.

The PEP name must start with an alphabet and should consist of underscores and a pha humeric
characters. The PEP name cannot start with either a number or an underscore.

» Package Name—Maximum characters 383.

The Package name consists of a project prefix and a user defined package name. The project prefix
isfrom AMC and cannot be changed in ADS and must start with an alphabet and should consist of
underscores and alpha numeric characters. The Package name cannot start with either a number or
an underscore.

Caution

S

Note

You cannot rename a PEP after you synchronize your PEP with AMC.

You will set Variables when you assign the Bladelet Properties. For information on Bladelet Properties
and Variables, see the “ Setting Bladelet Properties, Variables, and Rules’ chapter.

Figure 1-10 PEP Attributes Window
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N
Note  We recommend that you define most PEP attributes when you start to create a PEP; however,
you can define or modify them later.

Usethe default name (PEP N) or assign anew name. If a PEP with the same name exists, the OK
button in this window is dimmed, enforcing the rule that every PEP name must be unique.

The package is an optional mechanism for organizing your PEPsin one area of anode. You can
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assign one or more PEPs to a package. The default is to leave the user-defined portion of the
package field blank. (Only the user-defined portions of the package name can be | eft blank.) We
recommend that you either leave it blank or define it later, just before you deploy the PEP. If
you define it now, make sure it is defined correctly; you cannot change it later.
For information on PEP attributes, see “ADS PEP Attributes Reference” chapter.

Drag and drop Bladelets from the Task pane to the PEP Developer pane.

~

Note  Alternatively, copy and paste Bladelets from another PEP or from different areas of the same

PEP.

Reposition Bladelets by dragging and dropping as needed:

- To select asingle Bladelet for dragging, click it.

- Toselect multiple Bladeletsfor dragging as a unit, hold the left mouse button down, draw a box
around the Bladelets, and release the button.

(Optional) Add portions of this or another PEP as needed by clicking a corner of its PEP
Development screen, dragging the cursor to draw arectangle around the relevant area, dropping the
cursor, copying the selected area, and pasting it into the new PEP.

Add paths between Bladel ets by either of the following methods:

» Drag and drop: Drag a Bladelet until it touches or overlaps another Bladelet and a plus sign
appears, then drop it.

- Edge creation: Click the Edge Creation icon. Then click a Bladelet, drag the cursor to another
Bladelet, and release.

The line and arrow connecting the two Bladelets show the path over which and direction in which

information passes through the PEP.

~

Note  You can turn edge creation on or off by clicking the Toggle Edge Creation icon. When it is
on, the background of the PEP Developer pane changes from white to blue.

(Optional) Change paths between Bladelets as follows:

« Toremove a path altogether, click the path in the middle, then either press Delete on your
keyboard or drag it away and drop it.

« To connect a path to another Bladelet, click the end of the path that you want to redirect, then
drag it elsewhere—to another bladelet or to an exception marker—or leave it open-ended for
now.

As needed, create paths for branching Bladelets (Figure 1-11) as follows:

» To create a success path, drag the path starting from the top half of the branching Bladelet or
drop the target Bladelet over the top half of the branching Bladelet.

» To create afailure path, drag the path starting from the bottom half of the branching Bladelet
or drop the target Bladelet over the bottom half of the branching Bladelet.

Cisco AON Development Studio User Guide
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Figure 1-11 Branching Bladelet with Success and Failure Paths
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j- Configure each Bladelet as follows:
1. Right-click a Bladelet and click Bladelet Properties.

2. Adjust import and export parameters and other settings as needed. Parameters and settings
differ for different Bladelet categories.

N
Note  For information on Bladelet properties, see“ Setting Bladelet Properties, Variables, and
Rules’ chapter.
3. Click OK.

4. Repeat for al Bladelets.
k. Edit your work by selecting one or more Bladelets and clicking an icon (or clicking Edit and an
option).

Typical GUI edit options are available, including those listed in Table 1(listed in their order of
appearance on the icon bar).

Table 1 ADS Edit Operations
Operation Notes
Undo, Redo « Permits you to undo and redo a virtually unlimited series of

changes. However, if you perform one or more undo operations and
then make new changes, the original chain of operationsis broken
and anew chain is started. The default is to use the most recent
chain.

Cut, Copy, Paste » Retains one cut or copied item on the clipboard. The item can come
from ADS or any other application and can be used by ADS or any
other application.

» Deletesthat item from the clipboard if a second item is added.

- If you paste an item, positions it in the center of the window, rather
than at the cursor position.

Delete « Completely removes the item from the PEP.

Select All « Isuseful when the scope of the PEP falls beyond the viewable pane.

« Operateson asingle PEP only. If you are working on multiple PEPs,
it operates only on the active PEP.

- Isavailable only from the toolbar and not from the icon bar.
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Typical GUI view options are available, including those listed in Table 2 (listed in their order of
appearance on the icon bar).

Table 2 ADS View Operations
Operation Notes
Zoom * +10%, —10% zoomsthe current PEP by plus or minus 10% per click.

e 1:1 returns any zoom level to the default setting.

Fit to Screen « Provides a high-level view of your PEP, which is useful for very
large PEPs. If Bladelet images and text become too small to read,
view your PEP in the Navigator pane instead.

Zoom Rectangle » Permitsyou to create a“rubber band” rectangle around a portion of
the PEP Developer pane and zoom it in any number of times.

Typical GUI layout options are available, including those listed in Table 3 (listed in their order of
appearance on the icon bar).

Table 3 ADS Layout Operations

Operation Notes

Toggle Edge Creation « When toggled on, permits you to create paths between Bladel ets by
connecting them with arrows, without having to move Bladelets
around the screen.

« When toggled off (default state), permits you to create paths
between Bladelets only by dragging one Bladel et over another until
aplus sign indicates that a path is created.

Layout « Rearranges your PEP in a hierarchal manner with the top layer on
the left and the bottom layer on the right.
Toggle Automatic » When toggled on, adjusts the spacing between Bladelets and paths
Layout to achieve minimal line intersections, text runover, and graphical

overlaps. Any Bladel et that you drag and drop on the PEP Devel oper
window is automatically placed on the left side of the window.

« When toggled off (the default setting), displays Bladeletsin the
window where you drop them.

I. Validate your PEP often as follows:

1. Address problemsthat are displayed in the Problems pane. Double-click a problem to select the
offending Bladelet in the PEP Developer pane.

2. Address problems that are displayed in the PEP Validation Report (Figure 1-12). Generate the
report by clicking PEP > Validate PEP.

Note  We recommend that you address problems as they arise. Validation ensures adherence to all
rules and parameters that govern individual Bladelets, paths among Bladelets, and the
routing of messages through a PEP. A PEP must be valid before you can deploy it during
synchronization of your ADS with the AMC server.
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Figure 1-12 PEP Validation Report
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m. Save your PEP often:
» To save the PEP with its current name, click the Save icon (or choose PEP > Save).
» To save the PEP with a new name, choose PEP > Save As.
n. Optionaly, save the PEP as a template for future use by choosing PEP > Save PEP as Template.
o. Optionally, close the PEP by clicking the Close icon (or choosing PEP > Close.)
Step5  Asneeded, create additional PEPs.
§l

Note  Navi gate among multiple open PEPs by clicking the appropriate tab in the PEP Developer pane
(or clicking Window and the desired PEP).

Step6  Asneeded, modify or finish defining attributes for each PEP as follows:
a. Click the appropriate tab in the PEP Developer pane.
b. Click the Attributesicon.

c. Inthe PEP Attributes window (similar to that for creating a new PEP except that the name and
package, if already defined, are uneditable), provided the requested information and click OK.
Y

Note  For information on PEP attributes, see “ADS PEP Attributes Reference” chapter.

Step7  Close each open PEP by clicking its tab and then clicking the Close icon (or choosing PEP > Close).
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Step8  Optionally, print your PEP as follows:
a. Set up the page by clicking the Print Preview icon (or choosing PEP > Page Setup).

b. Preview the page by clicking the Print Preview icon (or choosing PEP > Print Preview).
c. Print the page by clicking the Print icon (or choosing PEP > Print).
Step9  Optionally, exit ADS by choosing File > Quit.

Save a PEP with a New Name

To save an existing PEP with a new PEP name, perform the following steps.

Stepl  Inthe ADStoolbar, click PEP > Save PEP as.

Step2  Enter anew name and package name (Figure 1-14). You must follow the foll owing recommendation.
» PEP Name—Maximum characters 128.

The PEP name must start with an alphabet and should consist of underscores and alpha numeric
characters. The PEP name cannot start with either a number or an underscore.

» Package Name—Maximum characters 383.

The Package name must start with an al phabet and should consist of underscores and alpha numeric
characters. The Package name cannot start with either a number or an underscore.

Figure 1-13 Save PEP with a New PEP Name
ESaue PEP as..

Flease enter the new name For the PEP Cisco SYSTEMS
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Package

Cancel
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Step3  Click OK.
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Save a PEP as a Template

To save an existing PEP as a template, perform the following steps.

Stepl  Inthe ADStoolbar, click PEP > Save PEP as Template.
Step2  Enter aname and package name (Figure 1-14). You must follow the following recommendation.
« PEP Name—Maximum characters 128.

The PEP name must start with an alphabet and should consist of underscores and alpha numeric
characters. The PEP name cannot start with either a number or an underscore.

» Package Name—Maximum characters 383.

The Package name must start with an al phabet and should consist of underscores and alpha numeric
characters. The Package name cannot start with either a number or an underscore.

Figure 1-14 Save PEP as a Template
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Step3  Click OK.

Create a New PEP from a Template

To create a new PEP from an existing template, perform the following steps.

Stepl  Inthe Project Explorer pane, select PEPs and right-click on New > New PEP from Template.
Step2  Select atemplate from the tree view (Figure 1-15).
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Figure 1-15 Create New PEP from a Template
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Step3  Click OK.

Deploying PEPs and Message Types

Deploying PEPs involves synchronizing your ADS with the AMC server. ADS posts your valid PEPs
and message types to the server. The server posts new nodes, PEPs, Bladel ets, message types, and other
information to your ADS for your use.

To deploy one or more PEPs (and associated message types) under a project, perform the following
steps.

Q)

Timesaver  Most steps instruct you to click an icon or, alternatively, choose a command sequence. Instructions to

choose a command sequence (example: choose PEP > New) refer to commands on the ADS toolbar. In
many cases you can access the same command sequence by right-clicking the relevant entry in the
Project Explorer pane or the relevant Bladelet in the PEP Developer pane.

Stepl  Start ADSandlogin.
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Caution  You cannot rename a PEP after you synchronize your PEP with AMC.

Step2  Synchronize your ADS with the AMC server as follows:

a. Ensurethat you are connected to an AMC server. If you are working offline, click the Connect icon
(or choose File > Connect) and connect now.

b. Click the Synchronizeicon (or choose File > Synchronize).

c. Inthe Synchronization window, select valid PEPs (Figure 1-16) and message types (Figure 1-17) as
needed, and click OK.

During synchronization, your selections post to the AMC server, and any updates on the server post to
your ADS.

Figure 1-16 Synchronization Window: PEPs
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Figure 1-17 Synchronization Window: Message Types
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If AMC fails to update the resource (PEPs and MessageTypes), a synchronization error (Figure 1-18)
may appear:

Figure 1-18 Synchronization Error
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® upl.n2.Sendonly | Mode (n2) not assigned to the Project!
® upl MTSendOnly ¢ Mode (n2) not assigned to the Project!

182164

A synchronization error can occur due to any of the following conditions:
« synchronization of the project has created, updated, or deleted resources of unassigned nodes
» resource creation, updating, or deletion failed in AMC
» an attempt to synchronize the project using a user which is unassigned from the project

If any network nodes are unassigned from the project, an unassigned nodes dial og (Figure 1-19) appears:
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Figure 1-19 Unassigned Nodes Dialog

wynchronization - Unassigned Modes E|
@

Save FLFE &5 Templates of sl unassagned nodes Cisco SvsTems

Thw liloway nodes am unasegped ljom L progs:L.
Select the PEPs of unassinged nodés 1o seve a5 templates

M PEP: To Be Saved

Corkins ]

16H63

You may choose any of the following options against each unassigned nodes to save a PEP as a
Template:

« None: No PEPs will be saved as Template
» Updated: All Updated PEPs will be saved as Template
« All: All PEPs will be saved as Template

Saved PEP templates are saved in a separate folder of hame:

<<currentdate>>_<<userproject prefix>>_syncbackup_unassignednodes_<<nodename>>

inthe ads templates directory.

Create Message Types

Once you create a new PEP, you can apply one or more message types to it. A message type acts as the
determining factor for what messages will be drawn through the particular PEP. For this reason, the
order of the message types is critical as each level of message type filters what goes through it. If you
do not order the message types properly, you may make one or more of them ineffective.

Stepl  To create your first message type, proceed to the node and select M essage Type label in the Project
Explorer pane.

Step2  Create and assign message types for a PEP as follows:

a. Inthe Project Explorer pane, under the appropriate node, select M essage Types. Then choose
M essage Type > Message Type.

b. Inthe Message Type Definition window (Figure 1-20), provide the requested information and click
OK.

S

Note  For information on message types, see “ADS Message Types Reference” chapter.
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Step 3

Step 1

How to Use Cisco ADS Il

Figure 1-20 Message Type Definition Window

Message[ype Definition (Project Finance) [z
@

Cisco SYSTEMS

Mame: | Fir StockQuote
| I

- (locally created) - (locally created)

Message Classifier: i{S} Classifier1 w |

LRI ! laxisiservices/urn;stock-trade |

Parameter Rules l Header Rulss || Content Ru-l-e-s:

| NPy poReguestInfol 1] poRequestipurchs iequals vl : 1onoo| |

Trim trailing and leading spaces in the values specified in each line

Palicies

PEF: |Fin.stockkrades, SkockQuate v
Encoding: ifin.encndel w |
Delivery: ﬁﬁéiveryl vi

Q05 I{S}- Bulk Diaka Transfer w |

230101

[ oK J [ Cancel

The new message type now appears in the Project Explorer pane.
c. Asneeded, create additional message types for the PEP.
Click OK.

S

Note  Until you reorder the message types, the message types are displayed in the Project Explorer
pane in the order in which you create them. Because message types contain conditions that
govern whether or not a message proceeds to the PEP for processing, their order is
important. You can reorder them later, after you synchronize your ADS with the AMC
server.

Reorder Message TypesAs needed, reorder your message types as follows:
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N
Note  Because message types contain conditions that govern whether or not a message proceedsto the
PEP, the order in which you list multiple message types is important.
a. Save and close all open PEPs.
b. Inthe Project Explorer pane under the relevant node, select M essage Types (#N) and choose
M essage Type > Reorder M essage Types.
¢. Inthe Reorder Message Types window (Figure 1-21), select a message type, click up or down as
needed, and click OK.
Figure 1-21 Reorder Message Types Window
B Reorder Message Types
il 4 d in the order th defined 2
255308 LYpes arg processed In the order they are derined.
Select the order in which these rules must be processed Cisco SysTEMS
Only message types that have been synchronized with AMC can be reordered
MessageType LRI S-Tuple PEFR Encoding
1|fin, StockQuaote laxisfservices/ur, ., |[Classifierl finstocktrades. s, [fin.encodel
Z|Fin. StockSale * Classifier1 fin.stocktrades. ... [fin.encodel

a4 ] I Cancel

30103

Step2  Synchronize with AMC again to preserve the new order.

Step3  Exit ADS by choosing File > Quit.

Where To Go Next

For information on predefined Bladelets and rules, see ADS Bladelets Reference chapter.
For information on PEP attributes, see ADS PEP Attributes Reference chapter.
For information on message types, see ADS Message Types Reference chapter.

For information on contacting Cisco technical support for ADS, see E-Mail to Cisco ADS Support
chapter.

For information on the AMC server and nodes, see the Cisco AON Installation and Administration
Guide.

For information on custom Bladelets, custom adapters, and application program interfaces, see the
Cisco AON Programming Guide.

Cisco AON Development Studio User Guide
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Setting Bladelet Properties, Variables, and Rules

Revised: March, 2007, OL-11798-01
Basic tasks involving creating PEPs are discussed in Getting Started with Cisco ADS.

This section explains how to set Bladelet Properties, manage Variables, and set Rules within each
Bladelet Properties window. However, each Bladelet and its Bladelet Propertiesis explained in ADS
Bladelets Reference.

For more information on implementing an AON network, see the following:

= Other chaptersin this guide:

Getting Started with Cisco ADS
ADS Bladelets Reference

ADS PEP Attributes Reference
ADS Message Types Reference
E-Mail to Cisco ADS Support

- Other guidesin the AON library:

AON Installation and Administration Guide (for information on the AMC server and nodes)

AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)

- Assigning Bladelet Properties, page 2-2

- Managing Variables, page 2-3

» Managing Rules Workbench, page 12

» Rules Workbench—New Rules, page 13

» Rules Workbench—Custom Rules, page 15
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Assigning Bladelet Properties

Note

You assign Bladel et properties by means of the Bladel et Properties window (Figure 2-1) and subsequent
dialog boxes. To open this window, follow the procedure in the “ Creating PEPS” section on page 1-11,
in “Getting Started with Cisco ADS” chapter. The window shown here is for the AccessHTTP Bladelet.

Shared resources are displayed as selectable options when you configure bladelets.

Required Fields

Each required field in the Bladel et Properties window is marked by ared asterisk. Until all required
fields are completed with the correct value, an error message appears on top of the Bladelet Properties
window to indicate which field remains to be completed or indicates that there is a parameter type
mismatch and so on before the Bladelet is completely configured.

Text Area and Auto Complete Field

The Bladel et Properties window provides either atext area or an auto complete field. An Arrow
icon—toggle button—allows to toggle between the text area and auto complete text field. If the datatype
is of the string type, the Text areais the default; otherwise it is an auto complete text field.

The Bladelet Properties window displays an auto complete text field with ayellow background. You can
enter a $ (dollar) sign to trigger the available list of variables in the current scope. You can select a
variable from the list by double-clicking your mouse or by pressing the Enter key. After the variable is
entered in the auto complete text field, you can use a. (dot) to get the attributes of the selected variable.
You can enter $ and . after the selected variable to see if the list includes more methods.

Cisco AON Development Studio User Guide
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Figure 2-1 Bladelet Properties Window

'd
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) | [— e

i st (string) = POST

@1 >[5

@ ! I Fath (strina} =] P

10— — » i

I ) )
®
|G= )

1 |Bladelet properties window. 6 |Manage Variablesicon (displays the
Variables Picker dialog box with two tabs).

2 |Bladelet label. 7 |Advanced Variables icon (displays the
Variables Picker dialog box with three tabs).

3 |Error-log message. 8 |Value Settings area (those marked with ared
asterisk are required for validation).

4 |Error-log messages popup window. 9 |Arrow icon—toggle button. This allows to

toggle between the text area and auto
complete text field.

5 |Properties area. 10 |Text area. Thisisthedefault if thedatatypeis
of the String Type; otherwise it is an auto
complete text field.

Managing Variables

ADS 2.1 hasanew Variable Picker dialog box. It has atabbed panel which allows you to perform all the
operations with the variables in one single dialog box. You can add, delete, rename variables. You can
also initialize variables and set values for the variables before and after a Bladelet Execution. It also
binds the variables to parameters in the Bladel et Properties window. You can also scope variables
through this dialog, where only the variables visible in the current scope are listed in thisdialog. All the
variablesin the current scope and also from the parents scope are visible.
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You can invoke the Variable Picker Dialog window (Figure 2-2) in two different ways:
« By clicking on Manage Variables icon on the top left panel of the Bladelet Properties window.
« By clicking on the Advanced Variable Options icon.

Figure 2-2 Icons to Open the Variables Dialog
= ApplicationOoS Properties
ApplicationQoS 2

Cisco SYSTEMS
Bladelet Group "Message Handling".

Applicaton(jos

-
Hepplicatongos | Input {Message) * | $REQUEST_MESSAGE 16

ApplicationCos {policy) * , b /

155176

1 [Manage Variablesicon This opens a Variables Picker dialog window with two tab pages:
Manage and Initialize.

2 |Advanced Variables This opens a Variable Picker dialog window with three tab pages:
Option icon Select, Manage, and Initialize.

Variable Picker Dialog—Manage and Initialize

Manage Variables Icon

[Q The Variables Picker Dialog (Figure 2-3) with two tab pages—Manage and | nitialize—appears when
you click the M anage Variablesicon within any Bladelets Properties window. You can also open the
same window by Right-Clicking the mouse on a PEP, or Bladelets, or anywhere inside the PEP
Developer Pane.
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Variable Picker—Manage tab

You can select the Manage tab (Figure 2-3) to add, delete, and rename variablesin the current scope. A
list of existing variablesis provided in atable view along with the Scope information. Variables names
are treated unique in a parent/child hierarchy. Therefore, you can define variables of the same name in
different scopes. Deleting variables is restricted to validate if the variable is being used in any of the
Parameters of the bladelets in the current scope. Renaming of a variables renames the references in the
variablesin all the Assignment Blocks, Rules, and also in Bladelet Properties Dialog.

Figure 2-3 Variable Picker—Manage Tab

E Variable Picker

(@

Variable Picker Cisco SYSTEMS

Marme Tvpe Scope

S Rename Close

155114

Variables Definition

The Variables Definition window (Figure 2-4) appears when you click the Add button in the Manage
Tab dialog window.

Cisco AON Development Studio User Guide
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Figure 2-4 Variables Definition

E Variable Definition

Cisco SYSTEMS

Manage Variables,

Name | | |
Type i AOMNSSubject w I
Yalue | |
Scope | Global v|

[ Ok, H Cancel ]

143078

You can add new variables from the Variable Definition dialog window. You can also chose the Type
and Scope of the variable along with an initialization Value. To see the complete list of Variable-Type
choices, see

Cisco AON Development Studio User Guide
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Managing Variables

You can select the Initialize tab (Figure 2-5) to initialize the variablesin the current scope. Each variable
has avalue before and after a Bladelet Execution. You are able to complete the value fields by using the
Auto Complete feature, which provides the drop-down sel ection window. Thiswindow provides an auto
compl ete text field with ayellow background. You can enter a$ (dollar) sign to trigger the available list
of variablesin the current scope. You can select a variable from the list and select it by double-clicking
your mouse or by pressing the Enter key. After the variable is selected, you can also use a. (dot) to get
the attributes of the selected variable. You can enter $ (dollar) or a. (dot) after the variable to seeif the

list includes more methods.

Figure 2-5 Variable Picker—Initialiaze Tab

E Variable Picker

| Manage Initialize
!

Initialize Tab : Initislize the Yariables in the current scope.

(=]
Cisco SYSTEMS

IMSG_POLICY
MaG_TYPE
PEP
PLATFORM
REQUEST_MESSAGE
RESPOMNSE_MESSAGE
SYSTEM

Datakype | MessagePolicyInfo |

Scope |_ Al |

Initialization before Eladelet Execution

Yalue | |

Initialization after Bladelet Execution

Yalue

Close

155116

Note
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Advanced Variable Picker Dialog—Select, Manage, and Initialize

~

Note

Advanced Variables Options

The Variables Picker dialog window (Figure 2-6) with three tab pages—Select, Manage, and
Initialize—appears when you click the Advanced Variables Optionsicon within any Bladelets
Properties window.

This option provides the extra Select tab.

Advanced Variable Picker—Select tab

~

Note

You can bind variables to different parametersin Bladel et Properties based on the type of the parameter.

The variables listed in this tab are either of the same type or the types convertible to the binding type

visible in the current scope.

Figure 2-6 Advanced Variable Picker—Select Tab

Variable Picker

(2

‘ariable Picker Cisco SysTEMS

] Manage ::.Initialize' [

Marmne Tvpe Scope

2|stringialue [string Global

[ Bind H Close I

155114

The variables names in the Select tab appear only after the variables are added in the Manage tab by

adding and binding the new variable names in the Variable Definition window (Figure 2-8).
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Advanced Variable Picker—Manage Tab

You can select the Manage tab (Figure 2-7) to add, delete, and rename variablesin the current scope. A
list of existing variablesis provided in atable view along with the Scope information. Variables names
are treated unique in a Parent/Child hierarchy. Therefore, you can define Variables of the same namein
different scopes. Deletion of Flow Variables isrestricted to validate if the Variable is being used in any
of the Parameters of the bladelets in the current scope. Renaming of a Variables renames the references
in the Variables in all the Assignment Blocks, Rules and also in Bladelet Properties Dialog.

Y
Note  The Mange tab provides the same function as in the two-tab window (Figure 2-3).
Figure 2-7 Advanced Variable Picker—Manage Tab
E VYariable Picker
(2
Manage Tab : Add [ Delete | Rename Yariables in the current scope., Cisco SYSTEMS

e || Tnitialize |

Marne Tvpe Scope

@ inkYalue int Global

9istring'alue string alobal

I_ Add ][ Delete ][ Renarne ][ Close ]

155115

The Variables Definition window (Figure 2-8) appears when you click the Add button in the Manage
Tab dialog. You can add new variables from this dialog window. You can also chose the Type and Scope
of the variable along with an initialization value.
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Figure 2-8 Variables Definition

E Variable Definition

(=)
Cisco SYSTEMS

Manage Variables,

Mame |
Type | AoNSBubjct [ ]
Yalue
Scope '_Glu:.bal v

K ] [ Cancel

Advanced Variable Picker—Initialize tab

Note

143078

You can select the Initialize tab (Figure 2-9) to initialize the variables in the current scope and assign
Value. Each Variable has a value before and after a Bladelet Execution. You are able to complete the
value fields by using the Auto Complete feature, which provides the drop-down selection window. This
window provides an auto complete text field with a yellow background. You can enter a $ (dollar) sign
to trigger the available list of variables in the current scope. You can select a variable from the list and
select it by double-clicking your mouse or by pressing the Enter key. After the variable is selected, you
can also use a. (dot) to get the attributes of the selected variable. You can enter $ (dollar) or a. (dot)
after the variable to see if the list includes more methods.

The Initialize tab provides the same function as in the two-tab window (Figure 2-5).
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Figure 2-9 Advanced Variable Picker—Initialize Tab

E Variable Picker
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Managing Rules Workbench

_ TheRules Workbench dial og box (Figure 2-10) appears when you click the Rules Wizard icon from the
ﬁl ADSicon bar (or choose PEP > RulesWizard). It isalso available from the Bladel et Properties window
for bladelets, such as Branch, Distribute, SetDestination, Authorize, and BalancelL oad.

Figure 2-10 Rules Workbench Dialog Box
Rules YWorkbench @
=
The workbench is a summary view of all the rules, It provides the central dashboard Cisco SYSTEMS
From which rules can be managed.
B New W New Custom Rule @ Edit B Delete
A A A A
C Available Rule:|:
@
®
O,
Rule Description {click on underlined value to edit):
[s]4 ] [ Cancel g
*

1 |Newicon 3 |Editicon

2 |New Custom Ruleicon 4 |Deleteicon
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Rules Workbench—New Rules

The Rules Wizard—Add Conditions dialog box (Figure 2-11) appears when you click the New icon in
the Rules Workbench dialog box. You can select and configure rules from the list.

After you create arule, this dialog box is also available from the Edit or Delete icon in the Rules
Workbench dialog box. You are able to edit or delete arule as needed.

Figure 2-11 Rules Wizard—Add Conditions
H Rules Wizard - Add Conditions
=
Use this dialog ko add additional conditions ta vour rules. Any conditions that are already C g
specified will be pre-selected For vou, Clicking on the + icon allaws waou to add ISC0 SYSTEMS
the same condition more than once.
(" )| select the conditions that you want to apply to your rule:
[l|Compare the value of an element in an XML message with a constant |~
[1|Compare the value of an element in a message with & constant: &=
[1|Compare & primitive variable with a constant 5]
®_< [1|Compare a primitive variable with another primitive variable [_'Ij
[1|Check if a list contains a constant &5
[C1|Check if a list contains a primitive variable [E5]
If the message is of a certain size [E5]
[C]|IF the content is of & certain type E21E%
O Megate this rule
w
Condition Description {click on underlined value to edit):
Compare the size of message to a constant using thiz operator
e
[ Iext ] [ Finish ] [ Cancel =
g
1 |List of available conditions from which to 2 |Conditions Description area

select (click a condition and set its values)
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The Variable Definition window (Figure 2-12) appears when you select “If the message is of a certain
size” and then select message in the Condition Description area of the Rules Wizard—Add Conditions
dialog box (Figure 2-11) to define the message.

This window provides an auto complete text field with a yellow background. You can enter a $ (dollar)
sign to trigger the available list of variables in the current scope. You can select avariable from the list
by double-clicking your mouse or by pressing the Enter key. After the variable is selected, you can also
use a. (dot) to get the attributes of the selected variable. You can enter $ and . to seeif the list includes
more methods.

Figure 2-12 Variable Definition

Use this dialog to add additional conditions o wour rules, Any conditions that are already
specified will be pre-selected For vou, Clicking on the + icon allows vaou bo add
the same condition mare than once.

Cisco SYSTEMS

Select the conditions that you want to apply to your rule:

Compare the value of an element in an XML message with a constant
Compare the value of an element in a message with a constant
Compare a primitive variable with a constant

Cornpare a prinnitiv
Check if  list contal e
Check if a list conta f
If the message is of ol

[C11f the content is of Maniage Variables, Cisco SYSTEMS

ol Megate this ru

jable Definitio

O
]
|l
]
1
.4

Condition Descriptia

Cotnpare the size of

Yalue !$
| T_IY GE Message
@ ®RESPONSE_MESSAGE Massage

fack [ met || Fiish | cancel |

142132

1 |Available Templates area (click atemplate) |2 |Rule Description area(click arule and set its
values)
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Rules Workbench—Custom Rules 1l

The Rules Workbench—Specify Custom Rules dialog box (Figure 2-13) appears when you click the
New Custom Rulesicon in the Rules Workbench dialog box. You can manually enter values that you
want to include in a condition. The rules must conform to the rules XML schema. For the custom rules
XML schema, see the Custom Rule XML Schema section.

Figure 2-13 Rules Workbench—Specify Custom Rule

specify Custom Rule

ko the rules XML schema

Enter Rule XML

Use this dialog to enter a rule when the wizard does not mest vour needs, The rules must conform Cigco SYSTEMS

[ Ok J|_ Canicel

@

142133

Custom Rule XML Schema

<!-- ARML (AONS Rule Markup Language) DTD -->

<!ELEMENT ruleset (rule*)>

<!ATTLIST ruleset name NMTOKEN #IMPLIED>
<!ELEMENT rule (condition?, action*) >
<!ATTLIST rule name NMTOKEN #REQUIRED>
<!ENTITY % booleanExp " (unaryExp | binaryExp | naryExp)">
<!ELEMENT condition (%$booleanExp;)>
<!ELEMENT action (assignment)* >
<!ATTLIST action conditionValue NMTOKEN #REQUIRED>

<!ENTITY % expression " (variable | %$booleanExp; | constant)">

<!ELEMENT unaryExp (%$expression;)>
<!ATTLIST unaryExp operator (not) #REQUIRED>

<!ELEMENT binaryExp (%$expression;, $expression;)>

<!ATTLIST binaryExp operator (eq | neg | 1t | lte | gt | gte) #REQUIRED>

<!ELEMENT naryExp (%expression;)+>
<!ATTLIST naryExp operator (and | or) #REQUIRED>

<!ELEMENT assignment (variable, (%expression;)?)>

<!ELEMENT constant EMPTY>
<!ATTLIST constant

| oL-11798-01
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type (string | boolean | byte | short | char | long | int | float | double | null)
#REQUIRED

value CDATA #REQUIRED>

<!ELEMENT variable EMPTY>
<!ATTLIST variable

name NMTOKEN #REQUIRED

type (string | boolean | byte | short | char | long | int | float | double |
object) #REQUIRED

extensionType (xpath | regex ) #IMPLIED

applyTo CDATA #IMPLIED

applyToType (Document | string) #IMPLIED

applyToValue CDATA #IMPLIED>
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A Bladelet is an operation that is performed on a message. It is a user defined software component that
implements certain interfaces and provides a useful unit of functions. For example, Authentication
bladelet provides authentication against various authentication schemes such as, LDAP, Kerberos, and
Netegrity; it will not do anything else.

Cisco AON Development Studio (ADS) provides a repository of standard Bladelets that are organized
by category—for example, logic, message handling, security, transformation, and so on. This chapter
presents detailed reference information that you need to choose and use ADS Bladelets.

For more information on implementing an AON network, see the following:

= Other chaptersin this guide:
— Getting Started with Cisco ADS
— Setting Bladelet Properties, Variables, and Rules
— ADS PEP Attributes Reference
— ADS Message Types Reference
— E-Mail to Cisco ADS Support

= Other guidesin the AON library:
— AON Installation and Administration Guide (for information on the AMC server and nodes)

— AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)

- Information About Bladelets, page 3-2
- Bladelet Choices, page 3-3
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B information About Bladelets

Information About Bladelets

Bladelets are used in the construction of Policy Execution Plans (PEPS). You construct a PEP with the
graphical-user-interface (GUI) ADS tool, which enables you to drag and drop icons representing
Bladelets onto a canvas. You then "connect” the Bladelets, thus forming a PEP.

Bladelets are highly configurable. Using ADS, you configure Bladel ets during normal PEP construction
by setting their properties, which are grouped hierarchically into three levels:

<configuration-group>
<configuration-subgroup>
<parameter-group> and <parameter>

Figure 3-1 shows the various components of a Bladelet. (The example shown below is an Access DB
Bladelet.)

Figure 3-1 ADS Bladelet

=3

N p
AccessDB

1 |Whole Bladelet icon. 5 |Bladelet input connection (connects to the
output connection of another Bladelet).

7T

152128

2 |Bladelet configuration status: 6 |Bladelet output connection (connects to the

« Red—One or more critical errors input connection of another Bladelet).

If two output connections exist, output paths

« Yellow—One or more warnings .
g usually designate the top one for a successful

» Green—No critical errors or warnings outcome and the bottom one for a failed
outcome.
Bladelet graphic. 7 |Bladelet label.

£

Bladelet exception PEP markers (connection
points for specific types of exceptions).
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Bladelet Choices

This section describes the predefined Bladel ets that ADS displays in its Task Pane, page 1-9, in Getting
Started with Cisco ADS. It also describes any Bladelet properties that you need to set in order for the
Bladelet to function properly.

ADS provides the following Bladelet categories:
» PEP Markers Category, page 3-3
- External Access Category, page 3-4
» General Category, page 3-15
» Logic Category, page 3-25
» Message Handling Category, page 3-38
» Routing Category, page 3-70
» Security Category, page 3-93
- Transformation Category, page 3-146
« Miscellaneous Category, page 3-148

N

Note  Many of the following windows allow you to specify values in one or more of the following ways:

« By typing them in directly
» By selecting them from a drop-down list
« By binding the parameter to a specific value

PEP Markers Category

In the PEP Markers category, there are two markers:
- Exception-PEP Marker
» Break Marker

Exception-PEP Marker

Use the Exception-PEP marker for tracking and recording exceptions in the PEP. It is a good way to
m create instances that you can store as database records to audit exceptions as information is routed
through the PEP.

There are no properties to set for this marker.

Break Marker

Use the Break marker only inside loops. It isonly allowed in aLoop and cannot be used el sewhere. You
0¥ cannot place any other bladelets after the Break marker. The Break marker is used to exit out of the
= loops. For details, see the Loop Bladelet.

There are no properties to set for this marker.
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External Access Category

In the External Access Category, there are two Bladelets:
e AccessHTTP, page 3-4
« Access DB, page 3-11

Access HTTP

Summary

J The Access HTTP Bladel et makes an outgoing HTTP call using the GET or POST method in either the
Componentized or Normal URL Configuration groups.

Prerequisites, Dependencies, and Restrictions
AccessHTTP is synchronous, and thus cannot be used to execute a PEP running on the same node.

Details
Figure 3-2 to Figure 3-4 show required, optional, and advanced settings for the Componentized URL
Configuration group.

Figure 3-5 to Figure 3-7 show required, optional, and advanced settings for the Normal URL
Configuration group.
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Figure 3-2 Access HTTP Properties Window—Input Parameters, Componentized URL, Required
Tab
E AccessHTTP Properties
AccessHTTP @

Cisco SYSTEMS
6 Mandatory parameter "Host" not defined For bladelet "AccessHTTR",

©)

N

(= Configuration group: EC_OMPONENTIZED-URL v
@ rf Export Parameters Hequirea | Optional I Advanced ™
| Method (string) * |POST v-l
® '
Host (string) * \: |
Path {string) E] ‘ -~
@ » !
jﬁ_ 2
1 |Configuration Configuration group, set here to Componentized URL.
group
2 |Method Method. Choices: Post and Get.
3 |Host Hostname or |P address of the HTTP server.
4 |Path Path portion of the URL (/index.jsp).
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Figure 3-3 Access HTTP Properties Window—Input Parameters, Componentized URL, Optional
Tab
E AccessHTTP Properties

AccessHTTP

6 Mandatary parameter "Host" not defined For bladelst "AccessHTTR",

@

Expott Parameters

) S—

Configuration group: iCOMPONENTIZED-URL v]

| Required  Optional Advanceaé

@
Cisco SYSTEMS

© ®

@

( - Input Content: {used only when method is POST): !String hd i
Input (string) E] B
| v
. AW = =
Part (int) | |
Content Type (stri?I |
Headers (list) Add Row
.+ Mame (string) ‘alue (string)
=
x

1 |Configuration

Configuration group, set here to Componentized URL.

Group
2 |Port Port number to be used. Defaults to 80.
3 |Content Type MIME type of the content.
4 |Headers Header name and corresponding val ue (string types).
5 |Input Content Payload of the HTTP call. Required only in case of POST.
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Figure 3-4 Access HTTP Properties Window—Input Parameters, Componentized URL, Advanced
Tab
AccessHI TR =
B Mandltory poraemeter Host™ nok defined for bladeler “roessHTTE S SR
Oni= i contasten o | TR
F Expent Parameliens Requred | Cpeional  Advanced
2} l:-' Bugheantication
3 I Ib Schama (string) »~
4/, | |,':- L {twireg) [5.]
[;5_'._:]— |= —r %]
@ | |h Vet Falry
7) e Coerssction Tmsout (seconds) (] | 50 %]
(;j. lr. Sockst fesd Tmeout (seconds) (nk) | 30 %]
@ L;-_ Nurnber of Retries (int) A
5
[ree ] <
1 |Configuration Configuration group, set here to Componentized URL
Group
2 |Authentication Basic HTTP is the only authentication scheme supported today.
3 |Scheme Basic HTTP.
4 |User User ID.
5 |Password Password.
6 |Timeout/Retires Timeout and retries to establish a connection.
7 |Connection The maximum amount of time in seconds, for which AccessHttp waits to
Timeout (seconds) |open a connection. Default is 60 seconds.
8 |Socket Read The maximum amount of timein seconds for which AccessHttp waitsto read
Timeout (seconds) |from the socket after a connection is established. Default is 30 seconds.
9 |Number of Retries |The number of times a connection is attempted. Default is 3.
Cisco AON Development Studio User Guide
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Figure 3-5 Access HTTP Properties Window—Input Parameters, Normal URL, Required Tab
B fccassHTTP Proparties
AccessHTTP @
ﬂ- eandabory parameter “URL" rek defined For bladelet “accessHT TR, E‘SW SrETEus
(1)
Ly \
IEI Configurabon groug: | RORMAL-URL W
e s . I |
@ ; Rermquned |
§i Export Parameters R | Aubyanced
Mt {skrivng) * | POFST -
LELL {strnwg) = IEI
©,
1 |Configuration Configuration group, set here to Normal URL.
Group
2 |Method Method. Choices: POST or Get.
3 |URL Complete URL.
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Access HTTP Properties Window—Input Parameters, Normal URL, Optional Tab
£ AccessHTTP Properties =
AccessHTTR "
Ciseo SvsvEms
@) Morcatory perameter "URL® nat defined For Bladeint “AcressHTTR
E Configuration group: | NORMAL-LFL -
Bl P snissbons | -
Bt Eupet Poramet s Recpired  Cptinnal | Pebvarmed
g It Corkent (usad ondy wihen method i POSTY:  Stnng %
J Irgu (strived]) [Zl =
2
< ¥
Cunbenit Type Ij:.l.riu,l\" 3]
Headers (kst) Al oo
.. Heme {siring) Ve (strireg])
Lo}
2
e ) ot [ cued J]2

1 |Configuration Configuration group, set here to Normal URL.
group
2 |Content Type MIME type of the content.
3 |Headers Header name and corresponding val ue.
4 |Input Content Payload of the HTTP call. Required only in case of Post.
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Figure 3-7

Access HTTP Properties Window—Input Parameters, Normal URL, Advanced Tab

B AceessHTTP Proparties =
ArcessHTTR =
a bandabory parameter “URL" rok defined For bladelet “arcessHTTR® {hs:n JriTEus
@ \
E‘ Configurabon group: | NORMAL-LEL
F: Expoet Parameters | Regqured | Oplional Acheanced |
E :I." Futlerbication
3}, p Schers (soig) DD -
@ Ir Liser (string) 5
@ . Fassword (st 5l
[:::} %—' Tt fHetry _
@ g Cereactin Timeou (seeerdél nt) |40 5]
@ I L Sockst Mesd Tineout (seconds) (nt) | &)
© i [ @
3
e ] 3
1 |Configuration Configuration group, set here to Normal URL.
Group
2 |Authentication Authentication scheme. Basic is the only scheme supported today.
3 |Scheme Basic HTTPR.
4 |User User ID.
5 |Password Password.
6 |Timeout/Retires Timeout and retries to establish a connection.
7 |Connection The maximum amount of time in seconds, for which AccessHttp waits to
Timeout (seconds) |open a connection. Default is 60 seconds.
8 |Socket Read The maximum amount of timein seconds for which AccessHttp waitsto read
Timeout (seconds) |from the socket after a connection is established. Default is 30 seconds.
9 |Number of Retries |The number of times a connection is attempted. Default is 3.
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Figure 3-8 Access HTTP Properties Window—Export Parameters

K AccessHTTP Proparties =
@

AccessHTTP 5
Cigco SrsTEMs
) Mandatory parameter "UAL” rot defined For bladeiet “ArressHTTRS

(1)
v I.:‘_:LI Fupneted Pasameters
2 Il P sl ers Respoime (<lrirg) w
HE et Porameters
Reradl {{Cooridew) =
{@ Stans (ink) / w
= .
./
i
=] g
1 |Response Response from the HTTP call (string type).
2 |Result Response from the HTTP call (AON content type).
3 |Status Status HTTP call (integer type m).
Outcome
None.
Exceptions

« Malformed URL: Connection cannot be established to the HTTP server host.

» Host Inaccessible: The URL (composed URL in case componentized URL is specified) is not
correct.

Access DB

- Summary
1 Use this Bladelet to make a SQL call out to a database.

Prerequisites, Dependencies, and Restrictions
Access DB does not work with binary objects; it only works with basic types, for example string, int,
and so on.
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Details
Figure 3-9 Access DB Properties Window—Data Source
E AccessDB Properties '
AccessDB 2

Cisco SYSTEMS

e Mandatory parameter "SOL Statement” not defined for bladelet "AccessDE",

Data Source

D=

B @ A patabase Name {policy) * |- Vi

e SOL T

Be Export Parameters v Query Timeout, in seconds; 0 implies no timeout (inty | 0 | @
@ g

1 |Database Name

Property set. After opening a project in AMC the path is Properties >
Application > Global > Databases.

2 |Query Timeout in
Seconds

Desired waiting time set for a query to get executed.

[l Cisco AON Development Studio User Guide

oL-11798-01 |



| Chapter3

ADS Bladelets Reference

Bladelet Choices

Figure 3-10 Access DB Properties Window—SQL
AccessDB 2]
Cisco SYSTEMS
6 Mandatory parameter "SOL Statement” not defined For bladelet "AccessDE"
> Configuration group: | IMSERT %
SQL
¥ SCL Statement (string) * @ A
2
< ¥
Values (list)
@ +v+ Place Haolder (string)
1 |Configuration Configuration group, set hereto Insert. Choices: Insert, Update, Delete, and
Group Query.
2 |SQL Statement The SQL statement in the Java SQL prepared statement syntax. Use ? for
place holders. Do not put ?in quotes in case of string-type parameters.
3 |Values One or morevalues (string types). Each string correspondsto the placehol der

inthe SQL statement. There should be as many entriesin thislist asthere are
placeholders in the SQL statement.

| oL-11798-01
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Figure 3-11 Access DB Properties Window—Export Parameters
AccessDB =
Cisco SYSTEMS
6 Mandatory parameter "SOL Statement” not defined for bladelet "AccessDE",
@ _@ Exported Parameters
B: Data Source *Number of Records Updated {ink) | - |
Bz SoL —_—
@ HE<port Parameters /RESL"t (list} | v |
1 |Number of Records |Number of records updated in case of non-query type of SQL statements.
Updated
2 |Result Result set in case type of SQL statementsis Query. There are as many maps
in the list as there are records retrieved. Each map has name-value pairs,
where name is the column name and value is the column value in the record.
Qutcome
None.
Exceptions

- Database Failure: Database cannot be connected to.
» SQL Failure: The input SQL statement could not be executed properly.

Note  The SQL interface does not support stored procedures.
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General Category

In the General Category, there are three Bladel ets:
e Log, page 3-15
» Retrieve Cache, page 3-19
- Cache Data, page 3-22

Log

- | Summary

“ | The Log Bladelet allows you to log message contents, PEP variables and other important datarelated to
the message, message class, source, destination, time stamps, and PEP name.

Prerequisites and Dependencies
None.
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Details
Figure 3-12 Log Properties Window—Input Parameters
=I wg Propor les &
Lo ]|
D) Marxbabony e wresber Tiskabnss™ e dabirme for bisdisiel Yisg" FEBOIT
O,
-"2 N E Tt Parasneiers \*
LTy sprchvancaten Mods meNsm:rn-mrs -
(5} B Varishes -
Databass (sey) \ -
@ st (Masiage) E
ferwid (trieg) ® BSEIC -
; il | [ [ adimow
(*-@ {| w. N (sring) Exgresson (sring)
@ Cigston basndier (strng)l
Help or || caxe 5
1 |Synchronization Mode of operation:
Mode « Asynchronous—Bladelet executes (in the foreground) while the
database writes (in the background).

« Synchronous—Bladel et waits while the database writes. Use to ensure
that datais entered into the database properly before the PEP goesto the
next step.

2 |Database Property set names for Message L og Policy. After opening aprojectin AMC
the full path is Properties > Application > Node > M essage L og Domain.
3 |Message Auto complete message field.
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Level

Level of logging. Allowed values for the ENUM are the following:

« Basic—Only metadata about the message islogged: entry time, message
type, PEP name, and so on.

» Header—Basic plus SOAP header. For non-SOAP messages, it is the
same as Basic.

» Body—Basic plus SOAP body. For non-SOAP messages, it isthe whole
message.

«  Whole-Message—Entire message without attachment. For non-SOAP
message, it is the same as Body.

» Specify by XPath Expressions—Contents to be logged are specified by
alist of XPath expressions. (See descriptions for the Expressions
parameter.)

Expressions

Optional. One or more X Paths specifying what needs to be logged. Applies
only if level isset to Specify by XPath Expressions. Each X Path containstwo
values:

« Name—String that provides a unique identifier for the contents
specified by the expression

« Expression—Valid XPath expression specifying the contents that need
to be extracted and logged

Custom ldentifier

Optional. String to identify this message log entry.

| oL-11798-01
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Figure 3-13 Log Properties Window—Variables
Log [z
® Cogca Svanima
Mandsbory o anster Tratsbase® ot dafiremd for Bladeist Log
® Varisbles
ou 1= | (e}
'—j Bl (o) Wariatads {obipct])
(%] =8
1 |Variables List of variables to be logged. Each list element contains two values:

« Name—Unique identifier for the contents of the variable

« Variable—Top-level variable or valid variable expression (select from
the drop-down list or use the variable picker)

Qutcome
None.

Exceptions

» LogWrite Failure: A failure occurred during the database write. These are failuresthat are typically

not recoverable. For example, data does not conform to the log schema, or the log policy is disabled
for the database.

Timeout: Timeout occurred. This applies only to synchronous mode. For exampl e, this can happen when
the database is not available or is extremely slow.
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Retrieve Cache

s | Summary

This Bladelet retrieves data from two named caches configured on an AON node. The named caches are
response and variable. The response cache caches arbitrary messages and server responses. The variable
cache caches PEP variables. The response cache is distributed and the variable cache is node local.
Populate these named caches by using the CacheData Bladelet.

Prerequisites and Dependencies
» Ensurethat the cache on the AON node on which the PEP executes has bootstrapped without errors.

Cisco AON Development Studio User Guide
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Details
Figure 3-14 Retrieve Cache Properties Window—Input Parameters
H RetrieveCache Properties
RetrieveCache @
Cisco SYSTEMS
EBladelet Group "General”.
Input Parameters

b Parameters

B2 Export Parameters [ Cache Key Details ) -
® A T
@ L Key {object)

Cache Object Details
@ » Object Type (string) * i}lESPONSE. :I
3

1 |Key Type Hint to the Bladel et to determine the Key to be used for retrieving the object

from the cache.

* Reguest—Bladelet computes the cache key from the payload of the
current request message.

« HTTP-Request-URI—BIladelet inspects the HTTP request and uses the
request uniform resource identifier (URI) as the cache key. Use only if
the request message isHTTP.

« Variable—Bladelet uses a PEP variable as the cache key.

2 |Key Key. Required if the key type is VARIABLE. Bind to this input parameter.
Can be one of the following data types: string, FindResult, or any numeric
type.

For Request and HTTP-Request-URI, the key is ignored.

3 |Object Type Where the Bladelet should go to fetch the data:

» Response—Response cache
« Variable—Variable cache
« Message—Message cache
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Figure 3-15 Retrieve Cache Properties Window—Export Parameters
ﬁ RetrieveCac he Properties .
RetrieveCache =
Cisco SYSTEMS
Bladelet Group "General”.
@ .
& Exported Farameters
@2 _ __ :
= Input Parameters Object {obiact) | v |
HEport Parameters —
Key (string) v
Result {int} I [ v
®
3
1 |Object Exported parameter object. Bind the object retrieved from the cache to this
object.
2 |Key Exported parameter key. Required if the key type is Variable. Bind the PEP

variable to be used asthe key to thisinput parameter. The variable can be one
of the following data types: string, FindResult, or any numeric type.

3 |Result Expected result of export parameter. Bind the result of the cache lookup to
this variable.

Outcome
« A cache hit or "Success" path indicates that the requested data was found in the cache.

« A cache missor "Fail" path indicates that the requested data was not found in the cache.

The Bladel et exports the cache key that was used for the lookup operation, the result of the operation (0
indicates amiss; 1 indicates a hit) as follows:

» On success, it also exports the cached object, which can be bound to a PEP variable of the
appropriate data type. For response type object retrieved from the "response" named cache, the
Bladelet also binds the object to the "RESPONSE_MESSAGE" PEP variable.

» On miss, the exported cache key can be used by a CacheData Bladelet further in the PEP execution
to cache data to the cache.

Exceptions
None.
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Cache Data

Summary

4

J This Bladelet should be used to set data into the named caches configured on an AON node. The named
caches are "response” and "variable". The "response" cache caches arbitrary messages and server
responses. The"variable" cache caches PEP variables. The response cache isdistributed and the variable
cache is node local. You can retrieve data from the named caches by using the RetrieveCache Bladelet.
You can also set and retrieve data from the named and "variable" caches by using the Caching Service
API exposed to Custom Bladelets.

Note  Objects are put into the response cache asynchronously and the variable cache synchronously with PEP
execution.

Prerequisites and Dependencies
» Ensurethat the cache on the AON node on which the PEP executes has bootstrapped without errors.

Details

When itisgiven acache key and optionally a PEP variable, this Bladel et cachesthe variable or the server
response message.
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Cache Data Properties Window—Input Parameters

E CacheData Properties @

142015

CacheData @
Cisco SYSTEMS
e Mandatory parameter "Object Type" not defined for bladelet "CacheData ",
Input Parameters
@ s ;m rCache Key DetaiN
Key Type Gtrr) * | TR |
Kevy (object) / |
@ .
Cache Object Details
Object Type (string) * L\ VJ
Object {object) [ I
@ 2
Expiration Details
@ Expiration Type {string) *IIFW! i
Expiration {string ! I
®
1 |Key Type Hint to the Bladelet to determine the key to be used for setting the object to
the cache.
» Reguest—Bladelet computes the cache key from the payload of the
current request message.
« HTTP-Request-URI—Bladelet inspects the HTTP request and uses the
request URI as the cache key. Use only if the request messageisHTTP.
« Variable—Bladelet uses a PEP variable as the cache key.
2 |Key PEP variable. Required if the key typeis VARIABLE. Bind the PEP variable

types: string, FindResult or any numeric type.
For Request and HTTP-Request-URI the key is ignored.

to be used asthe key to thisinput parameter. Can be one of the following data

3 |Object Type

by the request or a PEP variable.

response cache.

Whether or not the data to be cached should be the server response elicited

« Response—Caches the current response message in the response cache.
» Variable—Caches the PEP variable specified in the Object parameter.
» Message—Caches the message specified in the Object parameter in the

| oL-11798-01
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4 |Object

Value of the PEP input variable. If the object type is VARIABLE, bind the
PEP variable to be cached to this object.

5 |Expiration Type

How to determine the time to live or object expiration.

» Relative—Expiration time is specified as arelative integer value
denoting the number of seconds for which the object should be cached.

» Absolute—An absolute time for which the object should be cached.

e HTTP—Usethe HTTP directives and headers to compute the time to
live.

» Default—Use the default TTL specified in the caching policy on the
AMC server. For the response cache, use the response-cache default
TTL. For the variable cache, use the variable-cache default TTL.

6 |Expiration

Actual timefor which the object should be cached. Required only for relative
and absolute expiration types.

« For relative, specify an integer. —1 indicates that the object should be
cached forever.

« For absolute, specify a date in the following format:
EEE, dd MMM yyyy HH:mm:ss GMT'

Example: Sun, 16 Nov 2003 22:00:00 GMT

Optionally, specify by binding to a PEP variable that contains the expiration
value.

Expiration isignored for HTTP and Default expiration dates.

[l Cisco AON Development Studio User Guide
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Figure 3-17 Cache Data Properties Window—Export Parameters
B cachebata Propertios
CacheDats @
i@ Marcistory porameter “Obiject Type” nok defired For bladelet “CacheCuts ® ikt
Ii.] E=ported Parameters
et B amsters Ky (strieg) w
HE sprl Poraimeslier s
OO | /
WL
1 |Key Exported key parameter. Required if the key type is Variable. Bind the PEP
variableto be used asthe key to thisinput parameter. The variable can be one
of the following data types: string, FindResult, or any numeric type.
Outcome

» On success, the server response elicited by the request of the PEP variable to be cached is set in the
"response” and "variable" cache.

Exceptions
None.

Logic Category

In the Logic Category, there are two Bladelets:
- Loop, page 3-26
» Scope, page 3-30
» Find, page 3-31
- Branch, page 3-35
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Loop

Note

| Summary

The Loop Bladelet allows you to construct a PEP and apply repeated business logic processing based on
the number of items in the data types—Counter, Iterator, or Map—over which the loop is performed.
This construct isidentical to aloop which isfound in the Java or C programming languages. The Loop
Bladelet is represented as a block in which other bladelets are placed.

Figure 3-18 Loop Bladelet
™ oop =
{e -3}
il
&

Prerequisites and Dependencies
None.

Details

A PEP can be viewed as a program expressed in the PEP Description Language (PDL). PDL isa
programming language and defines the variable types used in a PEP as the fundamental datatypes. The
PDL exposes a number of datatypes—List, Map, and Iterator. At runtime, these data types represent a
collection of other datatypes (List and Map) or a cursor into this collection (Iterator). When handling
these datatypes, it isalmost always required to do somekind of repeated processing (Iloop) for each entry
in the collection.

A Break marker is only allowed in a Loop Bladelet and cannot be used el sewhere.

The Loop Bladelet has three different data types—Counter, Iterator, and Map.
Counter

The Counter Loop is used when a given operation (for example, another bladel et needs to be executed)
needs to be performed specific number of times. It issimilar to a“for” loop with counter variable being
initialized to a user specified value and incriminated by a user specified amount. The loop terminates at
auser specified end value. See Figure 3-19 for the details of the Counter Loop parameters.

Iterator

The Iterator Loop must be used to loop through alist. The current object and index is available at each
loop iteration and can be used by bladelets within the loop. See Figure 3-20 for the details of the Iterator
Loop parameters.

Map
The Map Loop is used to iterate over a map. It exposes both the current key and current value at each

loop iteration, both of which can be used by bladel ets within the loop. See Figure 3-21 for the details of
the Map Loop parameters.
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B Loop Properties

Loop

Bladelet Group "Logic",

Bladelet Choices

Loop Properties Window—Counter

©

oo carfiguration N

@@@E

Q@

(e ]

Cisco SYSTEMS
Configur ation group: | counTER: ol
Loop Configuration
Input Parameters 1
- Statt {ink) * |0 f
= Condition {string) * :Less Than v |
3 End {int} # |10 |
3 Lpdate (int) * |1 |
roukpuk Parameters
o Initial Counker {ink) | |
- Current Counter Indes (ink) | Vi
I
™~
-
(o [ 8

1 |Configuration Group Configuration Group, set here to Counter.
2 |Input Parameters—Start |Initializes the loop with the number where we start counting; the index
starts here.
3 |Input This condition must be satisfied at every iteration of the loop. Check if
Parameters—Condition |[the current index is “less than,” “less than or equal to,” “greater than,”
“greater than or equal to” than the End value, in order to determine
whether to continue with the next iteration.
4 |Input Parameters—End |Determines when the loop will terminate.
5 |Input Number of updates of the index after each loop iteration.
Parameters—Update
5 |Output The start index. It is always same as the start index of the input
Parameters—Initial parameter.
Counter
7 |Output Index at which loop iteration ends.

Parameters—Index
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Figure 3-20 Loop Properties Window—Iterator
o | Loop Properties
Loop E]

Cisco SysTEMS
Bladelet Group "Logic”.

@ Configuration group: !ITERATOR v'

Loop Configuration

O,
Inpuk Parameters-\

Tterator (erator)® | $find_output |

O Outpuk Paramieters \

Current Iterator Yalus (object) | curr_value |

Current Iterator Index (ink) | |

1 |Input A pointer to the start of alist of elements. At every iteration of the loop,
Parameter—Iterator the subsequent element in the list will be traversed using this iterator.
Note  Thisisan auto complete field and provides alist of variables.
2 |Output The element that is pointed to by theiterator at this iteration of the loop.
Parameter—Current
Iterator Value
3 |Output Theindex of the element that is pointed to by theiterator at thisiteration

Parameter—Current of the loop.
Iterator Index
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Figure 3-21 Loop Properties Window—Map
=1 L.oop Properties @
Loop 2]
Cisco SYSTEMS
Bladelet Group "Logic”,
@ Configuration group: IMAP _v_i
W Loop Configuration
@
~Input Para\mWrs 1
Map (map) * §$curr_value [
@
Oukput Parameters
Current Key {object) | . E
Current Yalue (object) | E
®
2
2

1 |Input Parameter—Map |A collection of elements. Each element is comprised of akey and avalue.
At every iteration of the loop, the subsequent element in the map will be
traversed and the associated key and value will be exposed.

2 |Output The key of the element that is being traversed at this iteration of the loop.

Parameter—Current
Key
3 |Output The value of the element that is being traversed at this iteration of the
Parameter—Current  |loop.
Value
Outcome

Loops can be nested to arbitrary levels and there is no pre-defined limit to the number of loops that can

be used in a PEP. For each type of data that the loop executes over, a different set of PEP variables are
exported.

Exceptions
None.
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Scope

Summary

The Scope Bladelet is used to define a physical block within a PEP that allow localized definition of
variables and business logic.

Scope =

148730

Prerequisites and Dependencies
None.

Details
There are no properties to set for this Bladelet.

The scope construct in the PEP Description Language (PDL) allowsyou to define physical blockswithin
the PEP that allow localized definition of variables and businesslogic. Thisissimilar to the{} operator
in the Java or C++ programming languages where a block of execution bounded by the braces serves as
acontainer for variables that are not visible outside the execution block.

A single scope block can only have one immediate parent scope (the scope block within which it is
nested) and the global scope (always present) is the top level scope and is the root node in the tree
representation of all the scopesin aPEP. There are some semantics that apply when using a scope block.
In general a scope block is most useful when it is used to restrict the scope of a PEP variable ensuring
that a variable defined in one part of the PEP is not available for use in other parts of the PEP. The
restrictions on the variables in a Scope are dependent on the visibility of the variable in that block. A
scope block can recognize those variables that are defined in its parent scope.

In Figure 3-22 the root node of the tree represents the default Global scope that is always present in a
PEP. You can add additional scopes by dragging the scope construct from the palette to the canvas and
including it at any point in the flow. Figure 3-22 shows a sample PEP containing two explicit scope
blocks and the global scope (represented by the white background region on the canvas).

Cisco AON Development Studio User Guide
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Figure 3-22 Sample Scopes within a PEP
Scope 1 =
Success
{ f }
Fail
Authenticate Authorize =
Log
In the first scope the Authenticate Bladelet can only use the variables defined with global and Scope. In
the second scope, Scope 1, the Authorize Bladelet can only use variables defined with global or Scope
1. The Log Bladelet can only use variables defined with Global or Scope 1.
Outcome
Scopes can be nested within each other with no pre-defined limit on the number of scopes that can be
included in a PEP.
Exceptions
None.
Find
Summary
O\ The Find Bladelet queries an XML message and extracts all nodes identified by regular (for regular
expressions, the message type does not need to be in XML format) and XPath expressions from the
message currently being processed by the PEP. After regular and common X Path expressions are
evaluated by this Bladelet, they are available for use by other Bladelets. Either XPath or Regex
expressions can be evaluated; if both need to be evaluated, you must incorporate multiple instances of
the Find Bladelet.
The Regex evaluation engine used by the Find bladel et uses Java Regex APl from Sun Microsystems,
Inc. Thereare several APIsto chosefrom, so we recommend that you use the API that matchesthe whole
input string rather than finding only amatch. You need to use the API that matches the whole input string
because Find Bladelet needs to save the result of Regex evaluation.
For details of Java Regex API from Sun Microsystems, Inc., see
http://java.sun.com/docs/books/tutorial /extra/regex/.
Y
Note  You can use the Find Bladelet to get the FindResultMapL istlterator and refer to the resultsin the Rules
Wizard in Branch Bladelet.
Or
You can also use the Rules Wizard to perform Regex evaluation.
Cisco AON Development Studio User Guide
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Note

Prerequisites and Dependencies
None.

Details

The Find Bladelet finds multiple items from within the message using X Path expressions (for XML
messages) or Regular Expressions for Non-XML messages. It works on both MIME as well as
NON-MIME data. The output of the find Bladelet is placed inside a PEP variable of type

FindResultMapL istlterator. Thisdatatypeisacomplex datatype that encapsulates resultsthat are found
from all parts (> 0 if MIME) of the message that is being searched. The structure of the datatypeis as
follows:

FindResultM apL istlterator:

List of parts of the message on which the Find Bladel et operates (List of size 1 containing the results
if itisNon-MIME; List of size > 1 if more than 1 MIME part is in the message)

Map of al the different expressionsthat were searched (recall that you enter avalue on the left-hand
list box in the Find Bladelet and for each of these you specify alist of expressions on the right-hand
table. The map contains key-value pairs with the key being the entries on the left-hand box and the
value being alist (size of this list = number of expressions entered for each key). The elementsin
thislist are the actual search results.

IMPORTANT: Today it is not possible to use the PEP variable-picker dialog to select values from the
tree view. You must enter a specific value to extract the returned results.

Example:

Key (Left hand side list box) XPath Expression list

k1 el
e2

k2 e3

Assume a regular input message (NON-MIME). The way to extract the results are (assume that
the output of Find is bound to a PEP variable called findResults) in the Specify Value
text box of the PEP Variable Picker dialog type:
findResults.elementAt (0) .elementAt (k1) .elementAt (0) .value ()
This expression returns the value of the search result using expression el on the message
while
findResults.elementAt (0) .elementAt (k1) .elementAt (1) .value()
gives the value of the search results for e2.
The value() function is used if you know your xpath result is of type boolean, string,
integer; or if you want only the string value of the first node in the XPath Result (which
is a nodeSet)
If the XPath result of e3 is known to be a nodeset, then to get e3 result's 2nd node's
string value:
findResults.elementAt (0) .elementAt (k2) .elementAt (2) .nodevalue (1) .
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m. oL-11798-01 |



| Chapter3

ADS Bladelets Reference

Bladelet Choices

The input parameters for this Bladelet (configuration group is set to XPath) are shown in Figure 3-23.
Input parameters for a Bladel et whose configuration group is set to Regex are shown in Figure 3-24.

Figure 3-23

= Fimil Properlins

Find Properties Window—lInput Parameters, XPath

Cisco Syxvems

) S
-I.h.] Configrstion grop: | MPATH &
_ F.Lml P avetens npat Firdireeberd
(2)
Brpalt {Content mzwdu’:‘\* |i|
Content Modfed (bodlesn) *  TALE -
=
\-a-"l FPath Laprksaang
Lspebaors [maptsdat) * M""‘"" |
[ teame Current Recond: More
| mdd hacord
: 3
[ o[ |3
1 |Configuration Configuration group, set here to XPath. Valid values are X Path and Regex.
Group
2 |Input Input, such as DVar.
3 |Content Modified |[Whether or not message content has been modified—for example, by a
preceding encryption Bladelet or transformation Bladelet.
If thisisthefirst Find Bladelet in the PEP, then this parameter is always true
because, to this Bladelet, every message is a new message.
4 | Xpath Expressions |XPath expressions under which the condition is evaluated. Add one or more

records and at least one row for each record added with an expression list in
string format.

| oL-11798-01
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Figure 3-24 Find Properties Window—Input Parameters, Regex
" @
{8 Panciatory P arwster “trga” risc defires For bladeien “Fraf Cizco Syarems

l&] Corfeppstion grogp:  RECED w
. F Lgeart, Par arvesbars ARk Div Satesd
'::i.f — \
Ingeat (oremeL It Mee o] * 5
Fsguby E-prespong
Expresyions (mappedust) * [ st
Plame | Currenl Regoed: Mo
* RiGE
@ |
BLELR
= == |2
1 |Configuration Configuration group, set here to Regex. Valid values are XPath and Regex.
Group
2 |Input Content input parameter such as DVar.
3 |Regular Any number of regular expressions, such as a sample. Add records with one
Expressions or more rows of expression lists to be evaluated.
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Figure 3-25 Find Properties Window—Export Parameters
EI i B rispeer Lies
Cizgo Svanpms
Bl G ooy “Ligc”,
-
®
:I_] Lapaated Parameters \
B Erpuk Par simeters Rl [P esatapl st erstor) "- =
B
Help | o || Cencel |13
1 |Result Result to be exported. Export parameter result to a variable such as | Var.
If no PEP variable is available in the list, add one without exiting the
properties window as described in the “Managing Variables’ section on
page 2-3, in “ Setting Bladelet Properties, Variables, and Rules’ chapter.
Outcome

- If al expressionsin the Find Bladelet are evaluated to null, the output path is set to Fail.

» If any expression is evaluated to other than null, the output path is set to success. On success, a PEP
variable of type FindResultMapL istlterator is exported for use by other Bladelets in the PEP.

Exceptions

Invalid Content Type: The content type isinvalid for evaluation. This happens when expression type is
XPath while the message is NOT XML documents.

Branch
Summary
#™ | This Bladelet establishes conditions for message route branching based on rules and message labels.
There are two main sections in the Branch Properties window.
Prerequisites and Dependencies
None.
Cisco AON Development Studio User Guide
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Details
Figure 3-26 Branch Properties Window—Input Parameters
B3 ranch Proparties 3
Branch 7
Citco Svitimi
Msdslet Group Loge”,
E_l Inpast Parameters
: Dxport Fisamaters Configd Cordiiny
. ||| oo iy
':'_‘J ‘ . M i) Labed {itring)
{2 !
&
e | o[ cead JI%
1 |Conditions Rulesand labels. Eachruleisevaluated in the order it is specified; evaluation

stops at the first rule that evaluates to true. The label corresponding to that
particular rule is set as the output path of this Bladelet. If none of the rules
evaluates to true, the default output port is activated.

Cisco AON Development Studio User Guide
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Figure 3-27 Branch Properties Window—Export Parameters
-.E‘_
Cagto SYsTEMS

Branch
Elaclot GroiE oo
Exported Paranseters
Lebei{stongy w
/f

(F5}
B! Inguk Poromesters

(x| comd ]

Label that is chosen as the output path.

1 |Label

Outcome
On success, the output port activated is the same as the one corresponding to the rule that eval uates

to true.
If none of the rules evaluate to true, the default output port is activated.

Exceptions
None.
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Message Handling Category

In the Message Handling Category, there are nine Bladelets:
- Validate, page 3-38
» Build Composite Content, page 3-43
» Discard, page 3-49
» Create Message, page 3-51
» Update Message, page 3-55
« Create Content, page 3-61
- Extract Composite Content, page 3-64
« Create Response, page 3-66
« Application QoS, page 3-68

Validate

Summary

The purpose of this Bladelet is to validate XML messages based on a schema (XSD) or DTD. The
schema referred by the XML message must already be loaded into AON in an appropriate Schema
Extension package using the AMC server.

Prerequisites and Dependencies

- Loadall schemasincluding XSD and DTD filesthat can be referred to by incoming XML messages
into AON using the AMC server’s Extension-Uploading and Deployment mechanism.

» Configure any Schema Validation policies, if required, and deploy them from the AMC server.

Details

The Validate Bladel et has two main partsin its properties window: input parameters and advanced input
parameters.

Cisco AON Development Studio User Guide
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Figure 3-28 Validate Properties Window—Input Parameters, Validate
E Yalidate Properties
Yalidate =

Cisco SYSTEMS
Bladelet Group "Message Handling".

@] Input Parameters
R .
ks Advanced Input Parameters [ Conert bo Yalidate -
Input {Content) * | $REQUEST_MESSAGE.content() | @

 Part of Message to Validate: !Full Message W

®

- Type of Validation: l: s J

Use DTD i Available (boolean)

@ J lse 5D iF Available (boolean)

1 [Input Content Source-content input. XML message content to be validated by the Bladelet.

2 |Part of Messageto |Full Message—Whole XML message needs to be validated.
Validate

3 |Typeof validation |Grammar Check—Whether or not to validate XSD in addition to DTD.

Validate the input XML message against XSD, if the box is checked and
DTD, if the box is checked. Check the box if you expect incoming messages
to contain X SD references that need to be validated. If unchecked, XML
messages that refer to X SD references are not validated.
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Figure 3-29 Validate Properties Window— Input Parameters, Check Well-Formedness Only
E'\I’alidate Properties
validate =

Cisco SysTEMS
EBladelet Group "Message Handling",

@J Input Parameters
T
B: Advanced Input Parameters Content ko Yalidate
Input (Content) * | SREQUEST_MESSAGE. content() | 5]
I ‘ ‘ - Part of Message to Yalidate: ;Partial Message vl

#Path {string) * | http:/f

Type of Yalidation: iCheck Wwell-Formedness Only

® @E®

A
(o [ a8
1 [Input Content Source-content input. XML message content to be validated by the Bladel et.
2 |Part of Messageto |Partial Message—Only part of the input XML message is validated. Thisis
Validate determined by the XPath value entered in the XPath input field.
3 | XPath String XPath value.

4 |Type of Validation |Check Well-Formedness Only—Whether or not to ensure the input XML
message is formed according to XML standards.
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Figure 3-30 Validate Properties Window—Advanced Input Parameters 1
E‘H’alidale Properties
Yalidate =

Cisco SYSTEMS
Bladelet Group "Message Handling",

@ Advanced Input Parameters

B: Input Parameters
Hadvanced Inpuk Parameters

- Limit Mumber O Mode Occurance: |Disable v

)

Limnit Murnber of Entity Expansions: ;Disable b :

®

- Action For Messages With Mo Grammar Available: | Disallow Message v '

®

[ Full Schema Constraint Checking {boolean)

®

=

142072

1 |Limit Number of Disable—No limit is set on the number of content model nodes in the XML
Node Occurrence | message.

2 |Limit Number of Disable—No limit is set on the number of entity expansions and parser can
Entity Expansions |permit any number of entity expansions in the XML document.

3 |Action For When the input XML message does not refer to any Schemaor DTD to
Messages With No |validate against.

Grammar Available Disallow Message—Fail the validation and set the failure path in the PEP

execution.
4 |Full Schema (Optional) Determine if the schemas must be checked for well-formedness.
Constraint
Checking
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Figure 3-31

E ¥alidate Properties

Yalidate

[l

e Mandatory parareter "Schema Reference” not defined For bladelet "validate .

Validate Properties Window—Advanced Input Parameters 2

2
Cisco SYSTEMS

Advanced Input Parameters

= Input Parameters
Hadvanced Input Parametets

Limit Mumber OF Mode Occurance: gEnabIe v'

=

Maximumn Murnber OF Node Occurances (Integer) *ﬂ 3000

- Limit Mumber of Entity Expansions: iEnabIe w :

Maximumm Mumber OF Enkity Expansions {Integer) * | 100000

- Action For Massages With Mo Grammar Awvailable: g\-'alidate with Defaule Schema s |

Scherna Reference (policy) *ﬂ!- v

|1’__| Full Schema Constraint Checking (boolean)

DE® ®®

i
H
i
i

1 |Limit Number of Enable—Set the limit on the number of content model nodes in the XML
Node Occurrence  |message. The limit is configured in the “Maximum Number of Node
Occurrences’ input field.
2 |Maximum Number |The limit of the maximum number of node occurrences.
of Node
Occurrences
3 |Limit Number of Enable—Set the limit on number of entity expansions that the parser should
Entity Expansions |permit in a XML document. The limit is configured in the “Maximum
Number of Entity Expansions” input field.
4 [Maximum Number |The limit of the maximum number of entity expansions.
of Entity Expanses
5 |Action For When the input XML message doesn't refer to any Schema or DTD to
Messages With No |validate against.
Grammar Available Validate with Default Schema—Validate the input XML message with the
default schema defined by the Schema Reference (Policy) input field.
6 |Schema Reference |Schemareference policy. Must already be set on the AMC server.
Policy
7 |Full Schema (Optional) Determine if the schemas must be checked for well-formedness.
Constraint
Checking
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Outcome
» The Success output path is taken when the XML message is found to be valid—that is, it conforms
to the XSD or DTD used to validate the message.
« The Failure output path is taken in the following cases:

— The XML messageisfound to beinvalid—that is, it does not conform to the XSD or DTD used
to validate the message.

— Theinput message is not awell-formed XML message and therefore could not be validated
using any schema.
— The schemareferred by the XML message does not exist in AON.

Exceptions
None.

Build Composite Content

Summary

A% Creates multipart content from the given input message and the parts that need to be
added/del eted/overwritten.

Prerequisites and Dependencies
None.

Details

The Build Composite Content Bladelet’s properties are, as with some other Bladelets, dependent on the
type of configuration group that is used. If the index in the configuration group Attach is null, the
Bladelet attaches the parts to the end of the input content. If the index specified is blank in the

Cisco AON Development Studio User Guide
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configuration group Overwrite, it overwrites the Input Content based on the Content-1d of the parts. In
configuration group Delete, index and parts are mutually exclusive. Both cannot be specified. If the
index is blank, the parts are deleted based on the Content-1d.

Figure 3-32 Build Composite Content Properties Window—Input Parameters, Attach

H BuildCompositeContent Properties

BuildCompositeContent 2

Cisco SYSTEMS
EBladelet Group "Message Handling".

Configuration group: . AT'I_'.C:CI-(_\Tl
: - =

k= Export Parameters Basic | Advanced

©)

! -Base Content . I

Input {Content) | |
A

Indes {ink) | |
P

| FContent To Attach

O®

Parks {ContentListlterator) * | $REQUEST_MESSAGE.content(). terator() |
@
1 |Configuration Configuration group, set here to Attach.
Group
2 |Input Base-content input message. Base content to which parts are attached and it
has to be a multipart.
3 |Index Optional. Index to attach. If blank, attaches to the end.
4  |Parts List of contents to attach.
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Figure 3-33 Build Composite Content Properties Window—Input Parameters, Overwrite

E BuildCompositeContent Properties

BuildCompositeContent =

Cisco SYSTEMS
Bladelet Group "Message Handling",

Configuration group: ;OVERWRITE v |
k

= Export Parameters Biasic | Advanced |

-Base Content

Input {Content) *ﬁ. $REQUEST_MESSAGE. cantent ()| |
@ I | | | Index (ink) | |
®
Content ko Replace-
Parts (ContentlistIterator) * l.:gaéétl_égf:ﬁégsaaacontent(j...i-tator() |
@ &
1 |Configuration Configuration group, set here to Overwrite.
Group
2 |Input Base-content input message. Base content to which parts are overwritten.
Must be a multipart content.
3 |Index Optional. Index to overwrite.
4 |Parts List of contentsto Overwrite. Use to overwrite existing contents at the index
specified. If blank, it overwritesthe input content based on the Content-1d of
the parts.
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Figure 3-34 Build Composite Content Properties Window—Input Parameters, Delete

E BuildCompositeContent Properties

BuildCompaositeContent =

Cisco SYSTEMS
Bladelet Group "Message Handling",

—_———

Configuration group: | DELETE v

R= Export Parameters | Advanced |

rBase Content

Input {Content) * | $REQUEST_MESSAGE.cantent() |

~Selector

Index (it} ﬂiw i

‘ Count (ink} | 10 i

Conkent ko Delets -

® ®® ® ©6

Parts {ContentListIterator) ﬂ'- i
1 |Configuration Configuration group, set here to Delete.
Group

2 |Input Base-content input message. Base content to which parts are overwritten.
Must be a multipart content.

3 |Index Optional. Index to overwrite.

4 |Count Number of parts that need to be deleted from the index specified.

5 |Parts List of contentsto delete. Select from the drop-down list or bind to a specific
value. Use to delete existing contents from the Input Content. Mutually
exclusive with Index.
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Figure 3-35 Build Composite Content Properties Window—Input Parameters, Advanced, Attach
E BuildCompositeContent Properties
BuildCompositeContent =
Cisco SYSTEMS
Bladelet Group "Message Handling".
Configuration group: |AT'I-'PE;|-_\7
- _ i 4
@ = Export Parameters | Basic Advanced l
l -Envelope for Resulk-
Type {int) * _;J
®
Subtype (int) * | Defaulk for Envelope Type v |
®
2
=
1 |Configuration Configuration group, set here to Attach.
Group
2 |Type Output-message type. Default is None, which isthe same asaregular MIME

message. RosettaNet outputs the message in RosettaNet format.

3 |Subtype Header for subtypes when the input content is null. Can be set only when
Configuration Group is set to Attach.
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Figure 3-36 Build Composite Content Properties Window - Input Parameters, Advanced,
Overwrite/Delete

E BuildCompositeContent Properties

BuildCompositeContent @
Cisco SYSTEMS
Bladelet Group "Message Handling”,
Configuration group: 'IZ_)ELE%E_\T
CETE B9
: B: Export Parameters | Basic Advanced |
! -Envelope For Result- 1
Type (int) * IT\IO_NE \;_]
@
1 |Configuration Configuration group, set here to Overwrite. Window looks the same if the
Group value is set to Delete.
2 |Type Output-message type. Default is None, which isthe sameasaregular MIME
message. If set to RosettaNet, outputs the message in RosettaNet format.
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Figure 3-37 Build Composite Content Properties Window—Export Parameters

H BuildCompositeContent Properties

BuildCompaositeContent 2

Cisco SYSTEMS
Bladelet Group "Message Handling",

Exported Parameters
B2 Inpuk Parameters Result {Content) [ v'
HE<port Parameters - =

1 ‘Result Type of exported parameter such as ZVar.
Outcome

» On Success, the BuildCompositeContentBladel et exports a Content that is built from the inputs and
other parameters specified.

Exceptions
ParsingException: Exception thrown when input datais not MIME or when the data could not be parsed.

Discard

Summary

“¥| The Discard Bladelet discards a message based on whether it meets certain policies or message
requirements established in the PEP and has no user-configurable input parameters.

Prerequisites and Dependencies
None.

Details
There are no properties to set for this Bladelet.
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Outcome

« On success, PEP processing stops and connection to the client is lost. In case of Queue based
messages (JMS/MQ), the adapter transfers the message to dead letter queue, if oneis configured.

Exceptions
None.

Send Reply

Summary
¥ The Send Reply Bladelet sends a reply from the PEP before the end of the flow is reached.

Prerequisites and Dependencies

There should be a Send or a Create Response preceding this bladelet so that a response message is
available to be sent out.

Details

The Bladel et takes the message to be sent asreply asinput. The exception SendReplyFailed is generated
if sending the reply out fails. If the Bladelet is used in a one-way PEP, a generic bladelet exception is
given. If two Send reply bladelets are used in the same path of atwo-way PEP, the second bladelet is
ignored and a notice-level log message is printed.

Inthe normal usage scenario, the bladel et would cause the response message to be sent back to the client.
Once the response is sent out, the PEP starts executing again starting with the bladel et after the send
reply bladelet. If no Send Reply bladelet is added to the PEP path, then the response is sent back to the
client at the end of the PEP (default behavior).
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Figure 3-38 Send Reply Properties Window
x|
SendReply _-:I

Cisco SYSTEMS
EBladelet Group "Message Handling”.

IE Input Parameters

f m Message (Message) | il
O, 5

1

230403

(0] 4 | Cancel |

1 |Input send message |The message to be sent as a reply from the PEP.

Exceptions
SendReplyFailed exception is generated if there is a failure in sending the reply out.

Create Message

. Summary

| This Bladelet creates a message within a PEP. You can use the message body as an input parameter to
this Bladelet or set as the response_message in the PEP context. You can use create message to shorten
amessage, request PEPs, or speed up responses.

Prerequisites and Dependencies
None.
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Details

In the Create M essage properties window under the Input Parameters section, tabs show required
(Figure 3-39) and optional (Figure 3-41) settings.

Figure 3-39 Create Message Properties Window—Input Parameters, Required 1
nr.reneumrum Praperiies E|
Create™ewsage @

Crsco Svsems
Flncislet Growp THesnace Handing™.
EI Retuirnd | cgeawl
F Esport P meters mmm/fm -
1
O Ingust (string) o §MESG_POLICY, Somanl §PLP.Jocstiond)) 5]

® -

) )

1 |Message Content M essage content (string type). Required.
2 |Input Input content mentioned in 2 above.
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Create Message Properties Window—Input Parameters, Required 2

nl'.reﬂﬂ-'m::s-:m Properties E
CreateMessage &
Cogea SYSTEMS
Flnckslst Group TMesssacn Handing™.
EI PRoerirnd | Ctional
FE-WtPaM:ﬂ Meszege Conbent: | &0N  w
@ g
| Ingut (Conkerd) | SPEQUEST MESSAGE hesder() (5]
@ 2
Hep | (3 Carcel E
1 |AON AON content is created using the bytes in the input. Set as the message
payload. Required.
2 |Input Input content to be set as the content of the message being created.
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Figure 3-41 Create Message Properties Window—Input Parameters, Optional
B crestemhestate Iroperties X
Creaberiessage 7
Cisco SriTims
Dot Group Message Manding”.
] Frequred Cptiond |
t:m Eetination Uil (string) | &)
1-\ i Exprd Piaramsbers
I:J Mg Haaeiers (Wt [ A Focaw
[ .. Name {string) Waue (strirg)
@) 1
E}, Rt Codé () o 5]
@ Il | Eaeusm-sﬂqe[mm;l# 5]
Heip: 0K Canced IE
1 |Destination URI Destination of the new message. Need not be set in case of a response

message or if the URI can specified in the Bladelets that work on this
message (example: Send).

2 |Message Headers | Optional. One or more headers of the created message. Add rows as needed
and enter a header name and value (string types).

3 |Status Code Optional. Status code of the created message. Useful if you haveto create an
error response message with a certain status code such as 500.

4 |Status Message Optional. Status message string.
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Figure 3-42 Create Message Properties Window—Export Parameters

Crestesessage &

Cisco SriTims
Dladelst Group Hessags Handing”.
L_L'I E=portesd Parameters
3 Brgmt Pl Rk (Hetise] | Geo EsT MESSAGE v

T t
)

[ Help o || cence :ér
1 ‘Result Resulting created message.
Outcome

» On success, a new AON message is produced that can be consumed via a variable and used in
Bladelets such as Send, BalanceL oad, Distribute, SetDestination, and Branch.

Exceptions
None.

Update Message

Summary
Lu&-‘ The UpdateM essage Bladel et updates an existing AON message in the PEP. User can optionally update
the destination, content or the headers of the message. You can use this Bladelet to update the payload
of the incoming message or modify some header information as it forwards on to an endpoint or to the
client.

Prerequisites and Dependencies
None.
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Details
Figure 3-43 Update Message Properties—Input Parameters
E UpdateMessage Properties
UpdateMessage 2
Cisco SYSTEMS
Bladelet Group "Message Handling".
Input Parameters
Birput Parameters | Input (Message) * | $REQUEST_MESSAGE |
@ B: Headers Vadl
= Export Parameters Destination-LIRI (string)/fl |
@ Input Content (Conkent) ‘l- |
@ -
2
1 |Input Message to be updated. Required.
2 |Destination URI URI to be set as the destination of the message being updated.
3 |Input Content Input content to be set as the content of the message being updated.

The Headers section has three tabs when the Configuration group is set to Modify (Figure 3-44 to
Figure 3-46). You can set the Configuration group to Replace (Figure 3-47).
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Figure 3-44 Update Message Properties Window—Headers, Modify, Add Tab
UpdsteMrssoge @
Cisen SysTems
Elsdelet Group Message Hancling™.
Lﬂ Conliguralion groupe | MODIFY |+
@r)- im A | Change | Deleto
HE - f i
@) J ||| Meeesan vinda iy
= L i Hame (string) Walue (string)
] CE=f
1 |Configuration Configuration group, set here to Modify. Choices: Modify and Replace.
group
2 |Add Message Header name-value pairs that are added to the existing set of headers of the
Headers message being updated.
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Figure 3-45 Update Message Properties Window—Headers, Modify, Change Tab
H UpdateMessage Properties g|
UpdateMessage 6]
Cisco SYSTEMS
Bladelet Group "Message Handling",
@ Configuration group: iMODIFV v
@ E: Input Parameters f
AFcaders | Add nange | Delete |
5 Export Parameters |
@ F f Message Headars (list)
L .+ Mame (string) Walue (string)
||
1 [Modify Configuration group, set here to to Modify.
2 |Change Message Header-name values (string type), arranged in a two-column table. Use to
Headers update the headers of the message being updated. If the header does not
exist, the new valueisadded. If it exists, the valueis changed. Add arow for
each instance.
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While the Configuration group is still set to Modify, delete one or more header names as necessary.

Figure 3-46 Update Message Properties Window—Headers, Modify, Delete Tab
E UpdateMessage Properties
UpdateMessage =

Cisco SYSTEMS
EBladelet Group "Message Handling".

Configuration group: EMODIF\" vi
@_ _E = Tnnn it ParAmebers |
AHeaders Add || Change Delete |
: Export Parameters |
Message Headers (list) Add Row

.+ Mame (string)

e

[ [ )8
1 [Modify Configuration group, set here to Modify.

2 |Delete Message Names of the headers to be deleted from the message being updated (string
Headers type). Delete as many header names as required by adding rows.
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Figure 3-47 Update Message Properties Window—Headers, Replace
E UpdateMessage Properties E]
UpdateMessage =

Cisco SYSTEMS
Bladelet Group "Message Handling",

Aeaaers

&= Export Parameters

® f Message Headers (list)

. Mame {string) Walue (string)

1 |Replace Configuration group, set here to Replace.

2 |Message Headers |Same as the message that was input. No new message is created by this
Bladelet. Changes only the headers/content of the input message.
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Create Content

ﬂ

Bladelet Choices

Figure 3-48 Update Message Properties Window—Exported Parameters
UpdateMessage @

Cisco SYSTEMS
EBladelet Group "Message Handling",

Exported Parameters

k= Input Parameters Result {Message) | v
ki Headers .
HExport Parameters

3
1 |Result Same as the message that was input. No new message is created by this

Bladelet. Changes only the headers/content of the input message.

Outcome
» On success, the input message is modified as specified by the parameters.

Exceptions
None.

Summary

The CreateContent Bladel et creates AON content from a string or converts one type of AON content to
the other. Bladel ets such as CreateM essage, UpdateM essage, AccessHTTP and BuildMIME operate on
AON content that is produced by this Bladelet.

The content headers in the optional configuration group are applicable only to content that is used as a
MIME part. If you want to add headers to the message, CreateM essage or UpdateM essage should be
used, based on the requirement.

If the content type needs to be more specific than what is shown in the Required/Content-Type
drop-down list, you can specify it as one of the headers. For example: Content-Type (header name) and
“application/xml” (header value). The entry in the header overrides the default content type.

| oL-11798-01
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Prerequisites and Dependencies

None.
Details
Figure 3-49 Create Content Properties Window—General, Required Parameters
x|
CreateContent 2|

Cisco SySTEMS
a Mandatory parameter "Content: Type" not defined for bladelek "CreateContent,

il General I Advanced |
@7:-. EXpart Paramerers - Imput Content: IString LI
@ Input {string) _’I ;I

[ Map Encoding Pequired (boolean)

©)
@ Content Type (enum) * | LI

42017

Help | oK Cancel |

1 |Input Content Input content:
« String—AON content is created from the bytes in the string.

« AON content—AON content is created from the bytes in the input
content. Useful to convert one type of content (say Stream) to another
(say SOAP). The input content should be convertible to the desired

output type.
2 |Input (string) The input string.
3 |Map Encoding Selecting this option requires map encoding for content creation.
Required
4 |Content Type Content type. Choices: Stream Content, XML Content, SOAP Content, and
Map Content.
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Figure 3-50 Create Content Properties Window—General, Optional Parameters
H CreateContent Properties
CreateContent 2

Cisco SYSTEMS
6 Mandatory parameter "Content Type" not defined For bladelet "CreateContent”,

[E:] ﬁequired- Optional l
@ E: Export Parameters j Content Part Headers (Only applies to Multipart MIME messages) (list) add Row
L .o+ Mame (string; Yalue {string)

142018

1 [Content Part Optional. Headers (name-value pairs) that apply to MIME parts only.
Headers

Cisco AON Development Studio User Guide
RCET g 363 |



Chapter 3 ADS Bladelets Reference |

M Bladelet Choices

Figure 3-51 Create Content Properties Window—Export Parameters
E CreateContent Properties
CreateContent =
Cisco SYSTEMS
6 IMandatory parameter "Content Type" not defined For bladelet "CreateContent”,
Exported Parameters
Result {Conkent) | B
L __|
2
o)==k
1 ‘ Result Created AON content.

Outcome
» On success, AON content is produced that can be consumed via a variable.

Exceptions
None.

Extract Composite Content

-~ Summary
lJ""‘
-~ The Extract Composite Content Bladelet extracts the contents from a multipart content message.

Prerequisites and Dependencies
- Ensure that InputContent is available from the request message or create it from another Bladelet.
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Details

Figure 3-52

ExtractCompositeContent

EBladelet Group "Message Handling".

&

E <traction Configuration
: Export Parameters

E ExtractCompositeContent Properties

Extraction Configuration

Source Content

Input {Content) # | SREQUEST_MESSAGE. header($REQUEST_MESSAGE timeStamp())

Bladelet Choices

Extract Composite Content Properties Window—Extraction Configuration

@
Cisco SYSTEMS

-Search Criteria

Extraction Map (list) *

.+ Mame (string)

Walue (string))

$MSG_POLICY . qosDamaint)

[§.I $PeP interactionstyl=()

5]

142039

1 |Source Content

Input content.

2 |Extraction Map

Names and values for one or more extraction maps (string types).
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Figure 3-53 Extract Composite Content Properties Window—Export Parameters
E ExtractCompositeContent Properties
ExtractCompositeContent E]
Cisco SYSTEMS
Bladelet Group "Message Handling",
Exported Parameters
Extraction Configuration Result (SearchResultListIterator) | : |
[Export Parameters _/1 )
@
g
1 ‘Result Variable selected as exported parameter.

Qutcome

» On success, the ExtractCompositeContentBladel et returns a SearchResultListlterator. Use this to
extract specific contents as needed by other Bladelets.

Exceptions
ParsingException: Exception thrown when input datais not MIME or when the data could not be parsed.

Create Response

- | Summary

23| The CreateResponse Bladel et tags an existing AON message in a PEP as the response message that has
to be sent back to the client. Normally response messages are created in a PEP by way of a Send Bladel et
or aDistribute Bladelet. The users can also handcraft response messages without involving an endpoint
using CreateM essage Bladelet. RetrieveCache can put a response message into the PEP that was
previously cached by the CacheData Bladelet. In the cases that do not involve Send and Distribute,
CreateResponse has to be used to mark a particular message as the response message.

This Bladelet does not have to be used after Send or Distribute Bladelets. This Bladelet istypically used
in conjunction with CreateMessage or RetrieveCache. It may also be used when the PEP has multiple
Sends and based on some logic, one of the replies needs to be picked.
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Prerequisites and Dependencies

None.
Details
Figure 3-54 Create Response Properties Window—Input Parameters
E CreateResponse Properties
CreateResponse @
Cisco SYSTEmS
EBladelet Group "Message Handling',
Input Parameters

] Message (Message) | — ]
@ 4

1 [Message Optional. Input message to be tagged as the Response message. If no input

is specified, the Bladel et picksthe current value of RESPONSE_M ESSAGE
variable. (Send/Distribute and RetrieveCache set their output to this
variable).

Qutcome

» On success, the specified input message is tagged as the response message of the PEP and is updated
with necessary internal header information so that it can be sent back to the client at the end of PEP
processing.

Exceptions
None.
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Application QoS

Summary

The Application QoS Bladel et enables the network to provide true application Quality of Service (QoS)
by inspecting the message content and context. The application QoS functionality isimplemented within
an Application QoS Bladelet combined with other AON bladelets, such as Encrypt and Sign forms a
Policy Execution Plan (PEP). The Application QoS Bladelet makes use of AON PEP variablesto extract
information from the message to set DSCP values.

Prerequisites and Dependencies
None.

Details

« Application QoS values are assigned based on message classification. Based on classification, a
message can be assigned the following Application QoS values:

— Bulk Data Transfer—AF11 <001010>
— Mission Critical—AF31 <011010>

— Network Management—CS2 <010000>
— Transactional Data—AF21 <010010>
— Default—0 <000000>

For classified packets, Mission Critical would have the highest priority and Bulk Data Transfer
would have the lowest priority. Based on this information, it is easy to map the DSCP values (from
the baseline document, default values), extending QoS beyond the L3 and L4. You can configure
these DCSP mapping values and override the default as needed. Application QoS can be assigned
on one AON node and be carried forward to al downstream AON nodes.

« All message processing on a given AON node is prioritized based on the Application QoSin a
message, through the use of Queues and Queue Priority.

» A message that does not have any application QoS is processed with a default priority.
Y

Note  Mapping of QoSto DSCPisdonein AMC and message classification in a PEP using an Application QoS
Bladelet isdonein ADS.
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Figure 3-55 Application QoS Properties Window

E ApplicationQoS Properties

ApplicationQos

Bladelet Group "Message Handling”,

©
=

®

@
CIsco SYSTEMS

ApplicatonQos
Input (Message) * | $REQUEST_MESSAGE ]
Applicationqos (policy) * | Bulk Data Transfer  |v

Bulk Data Transker
Mission Critical

Metwork Management
Transactional Data
Def ault

155121

o J[ema )]

1 |Input Message

Application QoS Bladelet acts on this message. By default, the
variable is REQUEST_MESSAGE. Application QoS can also be
applied to RESPONSE_MESSAGE.

2 |ApplicationQoS Policy

Policy to be applied to ApplicationQoS Bladelet:
- Bulk Datatransfer
- Mission Critical
« Network Management
- Transactional Data
» Default

These policies can be mapped to the Application QoS valuein AMC.
This policy is available under Application. This must already be
configured on the AMC server. The full pathin AMC isProperties>
Application > Global > QoSM apping.

Note If you do not choose an application QoS value for an AON
message then by default Application QoS is set to the DSCP
value of 0 (zero).

Qutcome

» Oncean application QoSisassigned to amessage, it is put in aprioritized Inbox queue to be picked
up by the PEP management subsystem. Instead of having a single Inbox queue, a separate Inbox is
used for each application QoS value that can be assigned to a message.
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Exceptions
None.

Routing Category

In the Routing Category, there are four Bladelets:
- Distribute, page 3-70
» Set Destination, page 3-74
« Send, page 3-76
» Balance Load, page 3-80

Distribute

Summary

Distribute sends the same message over to multiple endpoints. In case of request-response PEPs, it
gathers the responses, chooses one based on a selection criteria, and sets it as the response message.
Distribute sets the response message of the PEP to the one chosen. It is aterminal Bladelet, so no
Bladelet can follow this Bladelet.

N

Prerequisites and Dependencies
None.
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Details
Figure 3-56 Distribute Properties Window—Input Parameters, Required
E Distribute Properties
Distribute 2]
Cisco SYSTEMS
Bladelet Group "Routing”.
El Required 1 Optional | Faiure Determination| N
QLB haratietis Destinations (ist) * -W
|| i URI(string)
@ 1\ | [E] $requEST_MESSAGE destPratacal() I3

Response Selection Policy {required for request-response Flows) (enum) | AMY-SUCCESS  (» |

1 |Destination One or more destination URIs (string type) to which the message should be

distributed. Required.

2 |Response Selection [Message to be considered as the response message. Required in request
Policy response PEPs. Not required for request-only PEPs.

« Any-Success—First successful message to come back from the
endpoints.

« Any-Failure—First failed message to come back from the endpoints.

« Any-Response—Any message to come back from the endpoints. Can be
an error message or a proper response.

If none of the messages matches the selected criteria, an error message is
returned to the client.
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Figure 3-57 Distribute Properties Window—Input Parameters, Optional

x|
Distribute |

Cisco SYSTEMS
@ Mandatary parameter "Destinations” not defined For bladelet "Diskributa",

1 ocisod ankianal et sm i suis )
1
B im!w@ Input Message (Message) \l _sl!

Destination for Response Selection (list) Add Row |

o | Destination (string) I

P Nature of Distribution (enum) | LI

P Excephion Generation Policy (applicable in one-way) (erum) | LI

142030

Help | ok | Cancel |

1 |Input Message Optional. The message that should be distributed. If not specified, the
message used is based on the position of the Bladelet. If the Bladelet is
placed before the response marker, then REQUEST _MESSAGE is used. If
the Bladelet is placed after response marker, then RESPONSE_M ESSAGE
is used.

Destination for Optional. One or more destination URIs (string types) that form a subset of
Response Selection |the list of destinations to which the message is distributed. Use only in case
of request-response PEPs, to filter certain destinations whose responses are
not of interest.

If the URIs specified here are not in the list of destinations specified,
validation errors result. If variables are involved, runtime exceptions can
result if thisis not a proper subset of the original set of destinations.

2 |Nature of Optional. Specifies the nature of the distribute operation. It can be one of
Distribution one-way, two-way or inherit from the PEP's interaction style. The default is
inherit.
3 |Exception Optional. Specifies when the exception is generated. The choices are: never;

Generation Policy  |when any send fails; when all sends fail. The default is never. In the case of
when any send fails, an exception is generated when any single send fails. In
the case of when all sendsfail, an exceptionis generated only if all the sends
fail.
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Figure 3-58 Distribute Properties Window—Input Parameters, Failure Determination
E Distribute Properties E|
Distribute @
Cisco SYSTEMS
EBladelet Group "Routing”,
[EJ | Required | Optional  Failure Determination l
: I
Failure Determination {used in request-response flows)
@ ( Failure Status Codes (list)
L .. Failure Status Caode (string)
@ P Failure Condition {rule) V_
1 |Failure Status Optional. Failure error codes (examples: 404, 500) (string types) that
Codes indicate a failure message. If none specified, any error code in the 400-600

range is considered to be afailure. Specifying particular error code helps if
only some of these errors should be considered fatal.

If the requirement is to treat a couple of error codes as non-fatal, instead of
specifying the whole list, use Failure Condition (below) and specify arule
accordingly (use RESPONSE_MESSAGE.status() as the variable to
compare against).

2 |Failure Condition |If the condition evaluates to true, the response message is considered to be a
failed message. Typically, the condition should be evaluated against a
field/body of the RESPONSE_MESSAGE.

Select a displayed choice or add a rule by clicking the Rules Wizard icon.

Qutcome

» Onsuccess, all destinations receive the input message. In case of request-response PEPs, a message
that matches the criteriais set as the response message of the PEP.
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Exceptions

If the Distribute operation fails, a DistributionFailed exception israised. A failure in a two-way
distribute operation occurs when none of the responses are qualified under the specified Response
Selection Policy. A failurein aone-way distribute operation depends on the Exception Generation Policy
setting and the results of individual sends performed as part of the distribute operation. Because
Distributeisterminal, you cannot continue PEP execution by connecting a bladel et to the exception path.

Set Destination

Summary

#_ | This Bladelet routes messages to destinations based on rules. It determines the final endpoint (URI)
destination of the message being processed by the PEP.

Prerequisites and Dependencies
None.
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Details
Figure 3-59 Set Destination Properties Window—Input Parameters
E SetDestination Properties
SetDestination =
Cisco SYSTEMS
EBladelet Group "Routing”.
Input Parameters
Export Parameters rConfigure conditions
@ ( Conditions {list) *
.o Rule {rule) LRI {uri}
[BDRule_setDest [Z3]] $RESPONSE_MESSAGE.URI() 5.
O Default Destination {uri) ﬁ
2 , :
I ‘ Input Message (Message)’ =
®
o
1 |Conditions Required. Rules and URIs (string type). Each ruleis evaluated in the order it

isspecified and the eval uation stops at the first rule that evaluatesto true. The
URI corresponding to that particular ruleis set as the destination URI of the
message. |f none of the rules evaluates to true, the URI specified as the
default destination is used.

Select a displayed choice or add a rule by clicking the Rules Wizard icon.
2 |Default Destination |Destination to be used if none of the rules evaluates to true.

3 |Input Message Message to be routed (whose destination should be updated). If not
specified, the message used is based on the position of the Bladelet. If the
Bladelet is placed before the response marker, then REQUEST _MESSAGE
isused. If the Bladelet is placed after response marker, then
RESPONSE_MESSAGE is used.
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Figure 3-60 Set Destination Properties Window—Export Parameters
E SetDestination Properties -
SetDestination =

Cisco SYSTEMS
Bladelet Group "Routing”,

Exported Parameters

R= Input Parameters Destination {string) | v
4 <pork Parameters

1 ‘ Destination Destination that was set on the input message (string type).
Outcome

» On success, the destination of the input message is updated and set to the one corresponding to the
rule that evaluates to true.

« If none of the rules evaluates to true, the URI given by Default Destination is set as the message
destination. If a default destination is not specified, the original destination is not modified.

Exceptions
None.

Send

Summary

f The Send Bladelet is the last item in a message request PEP and sends a message to a selected
destination. The Bladelet performs protocol translation if the destination URI of the message to be sent
out has to go out via an adapter that is different from the one that received the message.

Prerequisites and Dependencies
None.
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Figure 3-61

H'Scnrl Properiics

Send

Bladaler Group Reuting”.

Fi

I HTTP Prssmeders

Bladelet Choices

Send Properties Window—Input Parameters, Basic

C)

I r Laport Parametens

™)

)

=

@

Cizca SveTems

Bk | advanied

Dstinaition LR (shrng) [gl
A =

| Message (Messagn) 5.1

:

1 |Destination URI

Destination URI to be set as the destination of the message being sent out.
Overwritesthe destination set in the input message. If thisfield is not set and
the message does not have avalid URI, send fails and the client is sent an
error message.

2 |Message

Message to be sent. If none is specified, the message associate to the
REQUEST_MESSAGE variable is used as the input.
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Figure 3-62 Send Properties Window—Input Parameters, Advanced
x
Send _-:I
Cisco SYSTEMS
Exported reply message is not bound to any Flow variable
IE Basic Advancedl
F im!w@ Mode {enum} ﬂl 'l
@ F Export ;-;;;;-;rs = Disable Retries (boolean)
@ ’
‘ ‘ Mature of Send (enum] | LI
® %
‘ ‘ Retry/Timeout Properties {policy) I LI
@
&
1 |Mode Mode. Choices: Clear or SSL.
2 |Disable Retries If enabled, no retries are attempted during the send operation if thereisa

failure. If disabled (the default), retries are attempted in case of afailure and
the retry behavior is determined by the "Retry/Timeout Policy" selection.

3 |Nature of Send The default is equivalent to having no value selected, in other words the
nature of Send (either one-way or two-way) is same as the PEP's interaction
style. If the PEP's interaction style is Request-Only, then the send is
one-way; if it is Request-Response, the send is a two-way.

For aone-way send, the Reply export parameter is be populated at the end of
send operation. For atwo-way send, the export parameter will be popul ated.
You can override the default behavior by selecting either ONE-WAY or
TWO-WAY explicitly. In this case the nature of the send doesn't depend on
the PEP's interaction style and is governed by whatever is specified for this
parameter.

4 |Retry/Timeout By selecting Send Properties, you can specify the values of the request
Properties (policy) |timeout, the number of retries, and the interval between retries that need to
be used for this operation. If none are specified, the default Send Properties
property set is used to obtain these values.
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Figure 3-63 Send Properties Window—HTTP Parameters
E Send Properties
Send =

Cisco SYSTEMS
Bladelet Group "Routing".

@l HTTP Parameters

= Inpuk Parameters

HTTF Methiod (string) | GET v/

HTTP Wersion (skring) | V:

1 |HTTP Method Method. Choices: Get or Post. Used only if the messageis sent out viaHTTP.
2 |HTTP Version 1.0 or 1.1. Used only if the message is sent out viaHTTP.
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Figure 3-64 Send Properties Window—Export Parameters

E $end Properties

Send

Bladelet Group "Routing"”,

=

Exported Parameters

% Input Parameters
= HTTP Parameters
HEport Parameters

Reply (Messade) | RESPONSE_MESSAGE |

7

@
Cisco SYSTEMS

oK Canicel é
1 |Reply M essage from the end point if the send istwo-way. Thisisnot set if the send
isone-way. Thisbehavior is governed by the Nature of Send parameter under
the Advanced tab in the Input Parameters.
Outcome

» On success, the response from the endpoint is output as the reply of this Bladelet that can be used
viavariables. If thisisthe terminal Bladelet in the PEP, the response returned by the endpoint is sent

back to the client.

Exceptions

If the send operation fails, a SendFailure exception israised. The failure of a send operation may be due
to avariety of factorsincluding connection failures and timeoutsin retrieving aresponse. You can chain
any bladelet (including more Send bladelets) to the exception path to handle the failure. The
Exceptioninfo flow variable ($PEP.exeception()) has the error code information corresponding to the

failure.

Balance Load

Summary

# | This Bladelet distributes the message load to multiple devices for improved throughput service.
Balancel oad employs one of four different algorithms to decide which particular endpoint should
receive the next message. It updates the destination URI of the message based on the algorithm. The
Send Bladelet that follows the Balancel oad Bladelet sends the message to the chosen destination.
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Balancel oad does not send the message out to the destination, but just updates the destination of the
input message. A send Bladelet that follows Balancel oad and is given the same input message uses the
decision made by the Balancel oad.

Using URI composition choices, you can specify a portion of the eventual destination URI inthe bladel et
and can also use information in the URI of the incoming message to formulate the whole URI. One of

the typical use casesisto specify the details of the actual serversfor load balancing in the bladelet (such
as scheme, host and port), while letting the path and query string be picked up from the request message.

Figure 3-65 Balance Load Properties Window—URI Composition Window, Choice 1

BalanceLoad 2|
Cisco SYSTEMS

a Mandatary parameter "Destinations” nok defined for bladelet "Balanceload”,

@

Configuration group: IUSE-FULL-URI-SPECIFIED-IN-DESTINP.TIONS-PF'.RP-METER LI

Algorithm
|- Input Parameters

Help | oK | Cancel |

230399

1 |Configuration group: The URIs in the destination parameter are used asis. No
USE-FULL-URI-SPECIFIED- |rewriting is performed.

IN-DESTINATIONS-
PARAMETER
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Figure 3-66 Balance Load Properties Window—URI Composition Window, Choice 2

BalanceLoad

@ Mandatary parameter "Destinations” nok defined For bladelet "Balanceload”,

x|
=

Cisco SYSTEMS

O

Algorithm

Input Parameters

R

Configuration group: |BASIC-REWRITE-OF-URI-PART-B\"-PART LI

Rewrite URI by selecting parts of Input Message URI to be retained

[-Parts of the URI not retained here are obtained from the URT in the Destinations Parameter

P [~ Retain Scheme (hoolean)

[~ Retain Hast (haclean)

: I Retain Port (boolean)

» [ Retain Path (boolean)

@@®@®

}-:- v Retain Query String (boolean)

The Destination attribute of Input Message that should be used as the base URT (string)ﬂl i I

®

Help |

oF | Cancel |

230400

1 |Configuration group:
BASIC-REWRITE-OF-
URI-PART-BY-PART

Allows you to retain some parts of the URI of the input message. The
parts not retained are picked from the selected destination from the list
of configured destinations.

2 |Retain Scheme

Selecting this option retains the scheme portion of the URI of the input
message.

3 |Retain Host Selecting this option retains the host portion of the URI of the input
message.

4 |Retain Port Selecting this option retains the port portion of the URI of the input
message.

5 |Retain Path Selecting this option retains the path portion of the URI of the input

message. This option is selected by default.

6 |Retain Query String

Selecting this option retains the query string portion of the URI of the
input message. This option is selected by default.

7 |Destination attribute

Allowsyou to choose which destination to use as the source. By default,
the current destination is used.
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Figure 3-67 Balance Load Properties Window—URI Composition Window, Choice 3

sl DalanceLoad Properties (Project Finance) 3|
Balanceload :I

Cisco SYSTEMS
@ Mandatary pararmeter "Destinations” not defined For bladelet "Balanceload".

©,

il Configuration group: |ADVANCED-REWRITE-OF-URI—P.C\RT-B\"-PART LI

FW—L Scheme ¢ |u53 the scheme From the URIin this bladelet’s Destinations Parameter j

>

& Input Parameters

@ ®

P Host: IUse the host from the URT in this bladelet's Destinations Par ameter LI

Mo patameters defined.

Port ¢ |Use the port From the URI in this bladelet's Destinations Parameter Li -

®
Y

Mo parameters-defined.

Path ¢ |Use the path from the URI in this bladelet's Destinations ParameterLI

@
A J

[io parametets defined,

Q)

:I Query String IUse the query string From the URI in this bladelet's Destinations ParameterLI i

1 |Configuration group: Allows you multiple ways of configuring each portion (scheme,
ADVANCED-REWRITE-OF |host, port, path, and query string) of the URI of the input
-URI-PART-BY-PART message. Each individual portion can be configured to one of the

following:
» Usethe[portion] from the URI in the bladelet's destinations
parameter
» Usethe[portion] from the Destination URI of the Input
Message
» Specify the [portion] as a variable or literal

2 |Scheme Allows you to set the scheme portion of the input message.

3 |Host Allows you set the host portion of the input message.

4 |Port Allows you to set the port portion of the input message.

5 |Path Allows you to set the path portion of the input message.

6 |Query String Allows you to set the query string portion of the input message.

In case of afailurein send, Balancel oad and Send work together to go through the remaining live
destinations to try and find a valid destination to send the message through. Failover is not optional.

The following algorithms mentioned above are used as different approaches for load balancing:
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» Round-robin (Figure 3-72 on page 3-89)

» Weighted round-robin (Figure 3-73 on page 3-90)
- Adaptive (Figure 3-74 on page 3-91)

« Highest Priority (Figure 3-75 on page 3-92)

Prerequisites and Dependencies
None.

Details
Two tabs, FailOver Management and Session Management, are under the Input Parameters section
(Figure 3-68 to Figure 3-71).

Note  Eachrequired field in the Bladelet Properties window is marked by ared asterisk. Until all required
fields are completed with the correct value, an error message appears on top of the Bladelet Properties
window to indicate which field remains to be completed or indicates that there is a parameter type
mismatch and so on before the Bladelet is completely configured.
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Figure 3-68 Balance Load Properties Window—Configure Parameters, FailOver Management

BalanceLoad

e Mandatory pararmeter "Destinations” not defined For bladelet "Balanceload”,

i‘

x|
=l

Cisco SYSTEMS

FailCer Management | Session Management

URI Composition
Algorithm

Inpuk Paramekers

| i~Configure Failure Detection -
|

Failure Status Code (list) Add Row |

I Failure Status Code (string) I

A

|

Failure Condition (rule)ﬂl il I E’

I
Input Message (Message) ,

& &

Retry Interval in Seconds (int) IISUU

Pl

Help l

142156

o | Cancel |

1 |Failure Status Code

Optional. One or more failure error codes (examples: 404, 500) that indicate
afailed endpoint. If none specified, any error code in the 400-600 range is
considered to be a failure. Specifying particular error codes helps if only
some of these errors should be considered fatal. If the requirement isto treat
acouple of error codes as non-fatal, instead of specifying the wholelist, use
Failure Condition (below) and specify arule accordingly (use
RESPONSE_MESSAGE.status() as the variable to compare against).

2 |Failure Condition

Failure condition. If the condition evaluates to true, the destination is
considered to have failed. Typically, the condition is evaluated against a
field/body of the RESPONSE_MESSAGE.

Select a displayed choice or add a rule by clicking the Rules Wizard icon.

3 |Input Message

M essage type for the message whose destination is to be updated. If not
specified, the message used is based on the position of the Bladelet. If the
Bladelet is placed before the response marker, then REQUEST _MESSAGE
is used. If the Bladelet is placed after response marker, then
RESPONSE_MESSAGE is used.

4 |Retry Interval in
Seconds

Time for which a destination is not used again once it is considered to have
experienced afailure.
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Figure 3-69 Balance Load Properties Window—Input Parameters, Session Management 1

aad B3lanceload Properties (Project Finance) = -

BalanceLoad

@ Mandatory parameter "Destinations” not defined for bladelet "Balanceload",

_-_:l

Cisco SYSTEMS

il Failowver Management  Session Management
URI Composition
Algorithm | Configure Sessions: |Cookie Based Ll
@ . .
| Cookie Mame (string) ﬁ E.J
@ .
1 T
O | Length of Session ID (int}ﬂ §.J
3 .
| Offset of Session ID (int}% E.J
O, '
Session Timeout in Seconds (int) 13600 EJ
®

Help |

oK | Cancel |

142157

1 |Cookie Based

Select the session type. In the figure, Cookie Based is selected.

2 |Cookie Name

Name of the cookie that carries the session information (example: in Unit3
thisis JSESSIONID) in both request and response.

3 |Length of Session
ID

If the session ID is only a part of the cookie value (as opposed to being the
whole cookie value), length of the session ID within the cookie value. Need
not be specified if the session ID isthe entire cookie value (example: Unit3).

4 | Offset of Session
ID

If the session ID is only a part of the cookie value (as opposed to being the
whole cookie value), offset from where the session ID starts in the cookie
value. Need not be specified if the session ID is the entire cookie value
(example: Unit3).

5 |Session Timeout in
Seconds

After asession is established, time for which it is considered active. Should
equal the session timeout on the endpoint for predictable behavior.
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Figure 3-70 Balance Load Properties Window—Input Parameters, Session Management 2
[~ x|
Aalancel nad il
ﬁ Mandabnry paramster Trestmariors” nol defined Foar biadeiel “Falaneel oo Cisca Svereus
1_1 Fadorer Manasment Sk Manageimen, ]
Be LRI Compmsition
ket algawithm Configure Sessior: | Sesann [derefiee nr‘-h-.w'.\j-Fwi,-;I
(1)—=-
py (| mequest Session Toentfiees (k) fukd Picrer
il Rt Session $Path {skrivg) |
b=
] e ———— Add o
el Fiespanss Session 1ath (sting) |
™, /
\3) 4
Y
Sesn0n Tmeous i Seconds (nt) (3600 5
(2 A Il
WS ]
1o 0¥ caet | (E

1 |[Session Identifier | Configuration sessiontype. Inthefigure, Session Identifier in Message Body
in Message Body  |is chosen.

2 |Request Session Request-session | Ds. Each string is an X Path, which is evaluated against the
Identifiers Input message body and the resultant value is treated as the session ID. The
first X Path evaluation that resultsin anon-null valueistreated asthe session
ID.

3 |Response Session  |Response-session |Ds. Each string is an XPath, which is evaluated against
Identifiers the response message body and the resultant value is treated as the session
ID. Thefirst XPath eval uation that resultsin anon-null valueistreated asthe
session ID.

4 |Session Timeout in |After asession is established, time for which it is considered active. Should
Seconds equal the session timeout on the endpoint for predictable behavior.
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Figure 3-71 Balance Load Properties Window—Input Parameters, Session Management 3

[ Balancel oad Properties (Project Finance) = -

BalanceLoad

@ Mandatary parameter "Destinations” not defined For bladelet "Balanceload”,

G

_-_:I

Cisco SYSTEMS

Failowver Management  S&ssion Management

OEE®E G

O)

¢ URI Composition
R Algorithm | Configure Sessions: IURL rewriting based j
e
| Parameter Mame (string) ﬂl E'J
Length of Session ID {int) ;} EJ
| | Offset of Session ID (ink) | .§'J
= bl
| | Cookie Name (string) J .§'J
A
| | | Length of Session ID in Cookie {ink) ﬂl EJ
| Offset of Session ID in Cookie (ink) ,I E.J
Session Timeaut in Seconds (int) (3600 EJ

Help |

oF | Cancel |

142002

1 |URL Rewriting
Based

Configuration session type. In the figure, URL rewriting based is chosen.

2 |Parameter Name

Name of the parameter in the rewritten URL that carries the session
information (for example, in Unit3 thisis “jsessionid=").

3 |Length of Session
ID

If thesession ID isonly apart of the parameter value in the URL (as opposed
to being the whole cookie value), length of the session ID within the
parameter value. Need not be specified if the session ID isthe entire
parameter value such as Unit3. It isvery unlikely that arewritten URL hasa
parameter in which the Session ID is only a part of the whole parameter.

4 | Offset of Session
ID

If the session ID isonly apart of the parameter value in the URL (as opposed
to being the whole cookie value), offset from where the session ID startsin
the parameter value. Need not be specified if the session ID is the entire
parameter value such as Unit3. It isvery unlikely that arewritten URL hasa
parameter in which the Session ID is only a part of the parameter value.

5 |Cookie Name

Name of the cookie that carries the session information (example: in Unit3
thisis JSESSIONID) in the response message headers.
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6 |Length of Session |If the session ID isonly a part of the cookie value (as opposed to being the
ID in Cookie whole cookie value), length of the session ID within the cookie value. Need
not be specified if the session ID is the entire cookie value such as Unit3.

Appliesonly to response message headers, associated with the Cookie Name

parameter.
7 | Offset of Session If the session ID is only a part of the cookie value (as opposed to being the
ID in Cookie whole cookie value), offset from where the session ID starts in the cookie

value. Need not be specified if the session ID isthe entire cookie value such
as Unit3. Applies only to response message headers, associated with the
Cookie Name parameter.

8 |Session Timeout in |After asession is established, time for which it is considered active. Should

Seconds equal the session timeout on the endpoint for predictable behavior.
Figure 3-72 Balance Load Properties Window—Algorithm, Round-Robin
BalanceLoad |

Cisco SysTEMS
@ Mandatory parameter "Destinations" not defined For bladelet "Balanceload”,

il Configuration group: IROUND-ROBIN ;‘
@ e 11T et 1
| Round Robin
Input Parameters
@ Destinations (list} * Add Ry |

A

| LIRI (string) |

1 |Configuration Configuration group, set here to Round-Robin.
Group
2 |Destinations One or more destination URIs to be load-balanced, based on the following:

« Endpoint with least response time
« Endpoint with least average wait time (when concurrency > 1)
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Figure 3-73 Balance Load Properties Window—Algorithm, Weighted Round-Robin

. N |
BalancelLoad :‘
Cisco SYSTEMS

6 Mandatary parameter "Destinations” not defined for bladelet "Balanceload”,

LI Configuration group: [WEIGHTED-ROUND-ROBIN ~ |
= i 1
® F

| Weighted Round Robin

Inpuk Parameters

Destinations (list) * Add Row |

| URI {string) Weight (int) |

s

142004

Help | (0] 4 | Cancel |

1 |Configuration Configuration group, set here to Weighted-Round-Robin.
Group
2 |Destinations One or more URIs (string) and weight (int). This algorithm picks the

destination based the corresponding weights. Distribution of messagesto the
destination is in proportion to the corresponding weight. So, if the weights
of two destinations are 1 and 2, the destination with weight 2 gets twice as
many requests as the one with weight 1.
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Figure 3-74 Balance Load Properties Window—Algorithm, Adaptive

Elsalanceload Properties (Project Finance) x|
BalanceLoad _'=|
Cisco SYSTEMS

@ Mandatary parameter "Destinations” not defined For bladelet "Balanceload”,

_Srl Configuration group: IADAPTIVE LI
@ = 10T amnneition | ﬁ
___ | Adaptive
F.—.‘ Input Parameters
@ Destinations Cist) * fadd Row |

5| LRI {string) |

142005

Help | oK | Caniel |

1 |Configuration Configuration group, set here to Adaptive.
Group
2 |Destinations One ore more destination URIs, such as ZVar.
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Figure 3-75 Balance Load Properties Window—Algorithm, Highest Priority

: ! x|
BalancelLoad :!
Cisco SYSTEMS

@ Mandatary parameter "Destinations” not defined For bladelet "Balanceload”,

j Configuration group:  |HIGHEST-PRIORITY =1
b= 18T arnnnsition |
F | Highest Priority
Input Parameters
f Destinations (list) * Add Row |

5| LRI {string) Highest: Priority (int) |

Help | oK | Cancel l %
1 |Configuration Configuration group, set here to Highest-Priority.
Group
2 |Destinations One or more URIs (string) and Highest Priority (int). This algorithm picks

the destination with the highest priority (highest integer valuein the priority
column) that is currently available. If the destination with a higher priority
is unavailable, the destination with the next-highest priority is picked.

Qutcome

» On success, the destination URI of the input message is updated to be the one chosen by the
BalancelL oad algorithm.

- This Bladelet also performs failover, so if the first endpoint chosen is not available to serve the
request, Balancel oad and Send work together to go through the rest of the destinations to find one
that is available. If all endpoints are unavailable, the client receives an error.

Exceptions

If all the end points and destinations specified in Balancel oad are unreachable, the bladelet raises a
LBFailed exception. The correct way to achieve Balancel oad functionality is to have a Balancel oad
followed by a Send. When an LB failure occurs due to the failures in the send operation, the exception
path of Balanceload is activated and not that of send.
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Security Category

In the Security category, there are eight Bladelets:

Authorize

Authorize, page 3-93
Encrypt, page 3-103

Verify Signature, page 3-115
Sign, page 3-118

Decrypt, page 3-130

I dentify, page 3-134
Authenticate, page 3-138
Verify ldentity, page 3-144

Summary

ﬂ The Authorize Bladel et uses access control to secure application resources in the PEP and is able to
execute AON authorization procedures and other authorization-type procedures. By comparing
authorization policies within the message to those within the PEP, the Authorize Bladelet is able to
determine the proper course of action based on authorization.

Authorize Bladelet in AON provides the function of computing authorization decisions and enforcing
authorization decisions on an incoming message. It supports three different authorization mechanisms
as described in the Details section.

Prerequisites and Dependencies

For LDAP-Based and SAML-Based authorization, provide AONSSubject. AONSSubject in case of
SAML-Based authorization specifiesa SAML Authorization Assertion that is verified by the
Bladelet. In case of LDAP-Based, AON SSubject must specify a user object in LDAP repository. Use
the Identify Bladelet to extract the identities present in the message.

For LDAP-Based authorization, use the AMC server to define LDAP property sets that specify the
LDAP configuration parameters. The full pathin AMC is AMC > Properties > Authorization &
Authentication > L DAP.

For SAML-Based authorization, either verify the SAML assertions by using Identity Verify Bladel et
in PEP before the Authorizer Bladelet or use Authorizer Bladelet to verify the signature of the
assertion.

For SiteMinder 5.5 authorization, use the AMC server to define SiteMinder configuration
parameters. The full path in AMC is AMC > Properties > Application > Netegrity SiteMinder.

The user info must be defined in SiteMinder Policy Server or LDAP repository configured in
SiteMinder Policy Server for Authorize to recognize. The identity of the user must be extracted
using ldentify Bladelet before Authorize can be used in a PEP. Before a user can be authorized to
access a resource using SiteMinder 5.5 method, user must be authenticated using SiteMinder 5.5
authentication method because SiteMinder authorization requires user to be authenticated.

| oL-11798-01
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Note

Details
SAML-Based Authorization

Identify Bladelet extracts the SAML Token containing Authorization Assertion, which can be signed or
unsigned. You can configure Authorizer to accept an unsigned assertion, in which case it processes a
SAML Assertion and enforces it even if it is not signed by a SAML Authority.

Once the SAML Assertion is extracted by the Identify Bladelet, it can be verified by an Identity Verify
Bladelet before passing to Authorizer. However, if verification is not done at that point, it performs the
signature verification of the SAML Assertion if it is needed.

Authorizer enforces the authorization decision specified in the SAML Assertion by ensuring that
resource to authorize is allowed Permit access in the SAML Assertion and the Action configured in the
Bladelet matches the Action in the assertion.

If it results in the Deny access then corresponding output path is set on the Authorizer Bladelet.
LDAP GROUP-Based Authorization

LDAP Group Based Policy Rules defines Authorization Policies based on the subject's group
membership in an LDAP Directory. Such a Rule essentially is a Policy Rule that comprises of Rule
Condition and Rule Action where Rule Action specifies one or more LDAP Groups to allow the access.

If all the conditions specified in the policy rule evaluate to true, then list of the groups specified Active
Group Name parameter are allowed access. If you specified in the Subject to Authorize is a member of
any of the groups that allowed access, accessis allowed.

RULE-Based Authorization

Authorizer can make authorization decision based on the results of eval uation of Content Rules specified
on Authorizer. Content Rule essentially is a policy rule that comprises of Rule Conditions and a Rule
Action. When aPolicy Ruleis selected for evaluation, all its conditions are evaluated and, if all evaluate
to true, Rule Action can be taken.

Rule Action may specify if the Authorize should result in PERMIT or DENY of the Authorization
decision. Based on the Rule Action specified and results of Rule Condition evaluation Authorizer sets
the output path of Authorizer Bladelet.

SiteMinder 5.5

SiteMinder 5.5 method for authorization uses SiteMinder 5.5 Policy Server for authorization. This
method authorizes a user's access to a web application resource configured in the Authorize Bladelet.
Access method for accessing the resource usually can be GET or POST which is determined from the
request message being handled by AON.

Further resource being accessed must be a protected resource in SiteMinder Policy Server. If resourceis
not protected, it will result in function failure and access will be denied.

SiteMinder authorization requiresthat user to authorize is authenticated using SiteMinder authentication
method. Authenticate bladelet can be used to authenticate a user using SlteMinder Policy Server before
the user is authorized by Authorize bladelet.

Each required field in the Bladelet Properties window is marked by a red asterisk. Until all required
fields are completed with the correct value, an error message appears on top of the Bladelet Properties
window to indicate which field remains to be completed or indicates that there is a parameter type
mismatch and so on before the Bladelet is completely configured.
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Figure 3-76 Authorize Properties Window—Authorization Mode, SAML-based Authorization 1
B austhorize Properties E|
Authoree |'E|
ﬂ Mariatony patarater Paih rol delired for Bladeler “fuatharice” cﬂ-tﬂ-sﬂ-'ili
@ IxJ Corfigu :n‘-wﬂ\-l:l:ua'?.r SAML-BASED ALITHORLZATION w
Tthor st o= |
Bo Advanced Subjet | Resourcs bo duthoroe
St
Subject bo Autharize (AONSSbject) * ]
@ "
Help L= I Cans :n’,
1 |Configuration Configuration group, set here to SAML-Based Authorization.
Group
2 |Subject to Subject to use for SAML authorization verification. Extract this subject
Authorize before the authorization Bladelet isinvoked in the PEP using Identify
Bladelet.
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Figure 3-77 Authorize Properties Window—Authorization Mode, SAML-based Authorization 2
B Authorize Properties E|
Authorize E]
Cisco Svenems
@ Marcistory par amster “Subject bo Authortes” not debired for bladelet *Authorioe®
@’ 159 cmwutmqm}' SAML-BASED AUTHORITATEON v
. m
:_- Acdvanced Subiject  Resource to Authorze ::
O Resourte 1o Authorize: SRS EUEG IR RV [OPTSTT Ta sy
2
@ Source (Message) * - @
Header Nams (string) * | S0RPACtion
@ 7
Help | ca | Cancel E
1 |Configuration Configuration group, set here to SAML-Based Authorization.
Group

2 |Message Header Whether or not the resource to authorize is specified in the value of a
Based Resource message header field.

3 |Source Message that identifies the resource.

4 |Header Name M essage header that contains the resource to authorize. By default,
SOAPAction is specified as the header name.
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Figure 3-78 Authorize Properties Window—Authorization Mode, SAML-based Authorization 3
B austhorize Properties E|
Authoree |'E|
ﬂ Mariatony patarater Paih rol delired for Bladeler “fuatharice” cﬂ-tﬂ-sﬂ-'ili
@ IxJ Corfigu ln‘-M:l'\-l:l:uJL'rIr SAML-BASED ALITHORLZATION w
:Mﬂed Shject nm:amm.trnm|

LT RN f e gi Bl M s By Based Fedougs

@ -
@ | | Source (Content) " 5]
@ | | *Path (stong) * P
o] ok [ caneel g
1 |Configuration Configuration group, set here to SAML-Based Authorization.
Group
2 |Message Body Whether or not the resource to authorize is found in the message body. An
Based Resource XPath expression extracts the resource value from the message body.
3 |Source M essage whose body contains the resource.
4 | XPath XPath expression that is applied on the message body to extract the resource
value.
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Figure 3-79 Authorize Properties Window—Authorization Mode, SAML-based Authorization 4

B austhorize Properties E|

Authoree L?]

) Mardatory parterster “Subject 1o Authorize” not definmd for bladelet “Autherion” SHACe U
@ 15 ':n'-‘wn‘.mgw.’-’.' SAML-BASED AUTHORIZATION b
EMﬂed Shject nm:ammmw|
Resourte to Authorce: ST

@ o :
@ | Resource (arg) " (5]

(1 | o || cancel g
1 |Configuration Configuration group, set here to SAML-Based Authorization.

Group
2 |Explicit Resource |Whether or not the resource to authorize is specified explicitly.
3 |Resource Resource value. Can be explicitly specified or it be bound to a PEP variable
(String) that specifies the resource.
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Authorization

Bladelet Choices

Authorize Properties Window—Authorization Mode, LDAP Group-Based

Authoree LE‘
£ Mariatony parnmater "LDAP Intisksation Far ametis” not defred for bladslet “Autheriz Cisco Svsvemy
@ IXJ 'a'.l:\-'-"cl'xl':'!i-al‘l}""ut'?.r LEWR GROUP-BASED ALTHORITATION
:_. Ecbearread Autharization Mode
Suibpact
@ Subtec o Authortse (AONSSect]* |
Authoreaton Cohbelt
LOWAP Bz oo Paramebors (pobcy) * -
-
@ | Bctive Group Puls (ns) v B
@ £ “
Actvn Group Yo (1t} [ addpow ]
| kst (NG )
® 1
Help o || cawe g
1 |Configuration Configuration group, set here to LDAP Group-Based Authorization.
Group
2 |Subject to Subject to use for LDAP group-based authorization. This subject should be
Authorize extracted before the authorization Bladelet isinvoked in the PEP using
I dentify Bladelet. Further this subject should be avalid subject present in the
LDAP repository specified by the LDAP Initialization Parameter below.
3 |LDAPInitialization |Connection parametersto L DAP server. Also defines the configuration
Parameters information used to access L DAP groups that you associated with
AONSSubject (Subject to Authorize) occupies.
4 |Active Group Rule |Policy rule that defines one or more conditions in a conjunctive expression
that, if true, allow access to all the groups specified in the Active Group
Name parameter.
Select a displayed choice or add arule by clicking the Rules Wizard icon.
5 |Active Group Name |One or more user groups (list-value) inthe LDAP repository that are allowed

access if all conditions specified in Active Group Rule evaluate as true.
Specify each group name by its distinguished name (DN).
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Figure 3-81 Authorize Properties Window—Authorization Mode, Rule-Based Authorization
B austhorize Properties E|
Authoree |'E|
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Authorization Conbaxt
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®_ [Match Action (string) ® DENY w
® *
i— : B
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1 |Configuration Configuration group, set here to Rule-Based Authorization.
Group

2 |Authorization Rule |One or more conditions in a conjunctive expression. If all conditions
evaluate as true, then action specified in Match Action parameter is taken.

3 |Match Action Action to be taken when all conditions specified in the authorization rule
evaluate as true.
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Figure 3-82 Authorize Properties Window—Authorization Mode, SiteMinder 5.5
B austhorive Propertics %
Autherize @
€ Mandistory pm asber “Subiect” riot b for bladelet “Auttvre” CuscoSritius
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Subject To Authare
@ Subject [ACNESSubject) = - @
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@ Resturce (sting) * o &)
@ | Profils (policy) * # bt
1 |Configuration Configuration group, set here to SiteMinder 5.5.
Group
2 |Subject AONSSubject. It specifies the subject which is authorized.
3 |Resource String. Resource the subject is trying to access.
4 |Profile Policy. Property set that specifies parameters used to connect to a Policy
Server. These parameters are SM Policy Server, Agent Name, and Agent
Secret.
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Figure 3-83 Authorize Properties Window—Advanced
B austhorize Properties E
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1 |Accept Unsigned
Assertion

Whether or not to accept an unsigned SAML assertion in the message:
« Yes—Accepts an assertion even if it is not signed.

« No—Does not process and verify an assertion if it is not signed.

2 |Indeterminate
Action

Action that must be taken if the assertion verification resultsin an
Indeterminate Action. It treats an Indeterminate Action as Deny or Permit
based on the value of this parameter.

3 |No Token Action

If the Authorization Mode is set to SAML-Based Authorization, and if no
SAML assertion is found in the AONSSubject, then it can result in Deny or
Permit based on the value of this parameter.

Qutcome

« On success, auser is allowed or denied access to the resource.

— If auser is allowed access, it sets the Success output path.

— If auser isdenied access, it sets the Fail output path.

Exceptions
None.
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Encrypt

Summary

* | The Encrypt Bladelet encrypts all or parts of the input message to maintain dataintegrity. Encrypt parts
of an XML or SOAP message by specifying the XPath locations of the elements to be encrypted in the
message. AON can encrypt XML, SOAP and non-XML messages and their attachments.

Prerequisites and Dependencies

- If the Bladelet is configured to encrypt attachment content, ensure that an Extract Composite
Content Bladelet exists in the PEP before this Encrypt Bladelet. Configure the output of the Extract
Composite Content Bladelet as input to the Encrypt Bladelet to encrypt the attachment content.

« Configure Encryption Policies and deploy them using the AM C server to send policies and keystores
to AON.

Details

This Bladelet encryptsincoming SOAP, XML, and Non-XML messages using a dynamically generated
symmetric key. The symmetric key is encrypted using the asymmetric public key of the message
recipient. Given the public key of the recipient message as an input parameter, this Bladelet moves the
CPU-intensive encryption operation to AON. Configure one or more elements in the message to be
encrypted using X Path expressions.

Set Encrypt Bladelet's Output Content only if the output content is a MIME content. This happens for
encrypting of SOAP with Attachments, XML with Attachments, non-XML and non-XML with
Attachments.

For other cases (Xpath encrypting of SOAP and XML), the input content is modified in-place, so you
need not create a new content variable. In such cases, use the Content that was passed as input to the
Bladelet.

Cisco AON Development Studio User Guide
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AON checks the destination URI of the message to determine the key alias for Encryption. For
asymmetric key encryption, the encryption key aliasisidentical to the destination hostname. For
example, if the destination URI is http://serverl.domain.com/someservice, the encryption Bladelet
expects an RSA key with the alias serverl.domain.com in the keystore.

Figure 3-84 Encrypt Properties Window—Advanced Input Parameters
B tncrmt Pragerties E
Trerypt 2]
) Mardatory parterater “Ignt” rot defired for bladelet "Encrypt” Cuscodrittus
E Advanced Input Passmelers
Bi Ercrypbion Scheme
B Koy Cordiguraton Ercryption idgoeithun
Bty anced Input Parameters = T w
(D P | e e i
ey Trarsport Algorikhm {string) * RSAVIS
@ z
Cre ] o )] §
1 |DataEncryption Algorithm used to encrypt the actual data. Choices: Triple-DES, AES128,
Algorithm AES192, and AES256.
2 |Key Transport Encryption key. Currently only RSAv1.5 is supported.
Algorithm
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Figure 3-85 Encrypt Properties Window—Key Configuration, Resource URI Based
B tncrmt Pragerties E|
Ereryp @
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1 |Resource URI URI of the intended recipient of this encrypted message. The key alias
Based corresponding to this resource encrypts the symmetric key. Must already be

configured on the AMC server.
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Figure 3-86 Encrypt Properties Window—Key Configuration, Key Alias Policy Based
B tncrmt Pragerties E
Ereryp @
) Marsdatony: v rmatar bty ek defired for bladelet Encrypt Cisco Svatens
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1 |Policy Based Reference of the encryption policy. The key alias in this policy encrypts the

symmetric key, regardless of the resource URI that may be configuredinthis
policy. Must already be configured on the AMC server.

Three types of Configuration groups in the Encryption Scheme section affect the way the settings are

determined:

» SOAP (Figure 3-87 to Figure 3-89)
e XML (Figure 3-90 and Figure 3-91)
« Non-XML (Figure 3-92 and Figure 3-93)
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Figure 3-87 Encrypt Properties Window—Encryption Scheme, SOAP, SOAPBody
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®
SOAP Body: SOAPBody W
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1 |Configuration
Group

Configuration group, set here to SOAP.

2 |Input

Content to be encrypted—XML or SOAP content containing the data that
needs to be encrypted.

3 |Key Reference

The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:
« Binary Security Token
« Subject Key Identifier
» Issuer and Serial #

4 |SOAPBody

SOAP Body: SOAP body encryption.
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Figure 3-88 Encrypt Properties Window—Encryption Scheme, SOAPR, XPaths
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1 |Configuration Configuration group, set here to SOAP.
group
2 |Input Content to be encrypted.

3 |Key Reference The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:
« Binary Security Token
« Subject Key Identifier
» Issuer and Serial #

4 | XPaths XPath Locations of the elements to be encrypted in the SOAP message. You
may add multiple XPath strings using the "Add Row" button.

5 |Content Content to be encrypted. May be an XML or SOAP content containing the
data that needs to be encrypted.

6 |[Level Level, set hereisto Element.
Level choices:

» Element—Whole XML element needs to be encrypted, including the
element name

« Content—Only the contents of the XML element need to be encrypted;
causes the name of the element to be shown
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Figure 3-89 Encrypt Properties Window—Encryption Scheme, SOAP, Attachments
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1 |Configuration Configuration group, set here to SOAP.
Group
2 |Input Content to be encrypted. Set if the encryption scheme is an attachment.

3 |Key Reference The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:
« Binary Security Token
« Subject Key Identifier
» Issuer and Serial #

4 | Attachments List of attachmentsto be encrypted. Thislist isthe output of aMIME-Extract
Bladel et that should have preceded the Encryption Bladel et and extracted the
attachments to be encrypted.

4 |Content Content to be encrypted. May be an XML or SOAP content containing the
data that needs to be encrypted.
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Figure 3-90 Encrypt Properties Window—Encryption Scheme, XML, XPaths
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1 |Configuration Configuration group, set here to XML.
Group
2 | XPaths XPath Locations of the elements to be encrypted in the XML message. You
may add multiple XPath strings using the "Add Row" button.
3 |Content Content to be encrypted.
4 |Level Level:

« Element—Whole XML element needs to be encrypted, including the
element name.

« Content—Only the contents of the XML element needs to be encrypted;
causes the name of the element to be shown.

5 |Input Content to be encrypted. May be an XML or SOAP content containing the
data that needs to be encrypted.
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Figure 3-91 Encrypt Properties Window—Encryption Scheme, XML, Attachments
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1 |Configuration Configuration group, set here to XML.
Group
2 |Attachments List of attachmentsto be encrypted. Thislististhe output of aMIME-Extract
Bladelet that should have preceded the Encryption Bladel et and extracted the
attachments to be encrypted.
3 |Content Content to be encrypted.
4 |Input Content to be encrypted. May be an XML or SOAP content containing the
data that needs to be encrypted.
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Figure 3-92 Encrypt Properties Window—Encryption Scheme, Non-XML, Source Content
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1 |Configuration Configuration group, set here to Non-XML.
Group
2 |Source Content Non-XML content to be encrypted, if the content is of type non-XML.
3 |Input Content to be encrypted. This may be an XML or SOAP content containing
the data that needs to be encrypted.
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Figure 3-93 Encrypt Properties Window—Encryption Scheme, Non-XML, Attachments
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1 |Configuration Configuration group, set here to Non-XML.
Group
2 |Attachments List of attachmentsto be encrypted. Thislist isthe output of aMIME-Extract
Bladel et that should have preceded the Encryption Bladel et and extracted the
attachments to be encrypted.
3 |Attachments Type of attachment.
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Figure 3-94 Encrypt Properties Window—Export Parameters
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1 |Result Output variable that contains the encrypted output of this Bladelet. Must be
set if attachments (XML, SOAP, or non-XML) are being encrypted. In all
other cases, the input content type is modified inline to replace the original
data with the encrypted data.

Outcome
» Success: Path taken if the Bladelet successfully encrypts the incoming message

- Failure: Path taken if the Bladelet is unable to encrypt the message for any reason

Exceptions
» Public Key Not Found: Path taken if the Bladelet is unable to find a public key to encrypt the

symmetric key with. This may happen if the configuration for selecting an asymmetric key is
incorrect or if the Encryption policy and keystore have not been correctly provisioned.

- Data Not Found: Path taken if the Bladelet is unable to find the data that was configured to be
encrypted, in the message. This happens when one or more XPaths configured in the Bladel et
configuration do not resolve to any elements in the message.
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Note
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Summary
As the name suggests, verify signature verifies digital signature contained in XML/SOAP/non-XML
message.ln summary:

» The signature verification Bladelet usually verifies all the signatures contained in the original
message, including multipart and nonmultipart messages.

- If the XKMS verification is enabled, then the AON node should be capable of reaching external
VERISIGN website.

Prerequisites and Dependencies
» Create and import necessary keystores.

Details
The Verify Signature Bladelet usually verifies all the signatures contained in the original message,
including multipart and nonmultipart messages.

If the XKMS verification is enabled, then the AON node should be capable of reaching external
VERISIGN website.

Each required field in the Bladel et Properties window is marked by ared asterisk. Until all required
fields are completed with the correct value, an error message appears on top of the Bladelet Properties
window to indicate which field remains to be completed or indicates that there is a parameter type
mismatch and so on before the Bladelet is completely configured.
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Figure 3-95 Verify Signature Properties Window—Content to Verify
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1 |Input If you are operating on request message then usually this value is bound to

REQUEST_MESSAGE.content(). If you are operating on response message
then the value of the PEP variable is RESPONSE_MESSAGE.content().
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If Local Certificate Trust and/or Certificate Chain Verification is enabled, then configure the local Trust
Store. The Certificate found in the Signature is expected to be found in the local Trust Store.

Figure 3-96 Verify Signature Properties Window—Advanced Input Parameters
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1 [XKMS Whether or not XKM S-based trust verification is performed. Choices:
Disable, Pilot, and Production.

2 |Local Certificate Whether or not local-trust-store verification is performed for the certificate
Trust KeyStore used in the digital signature. Choices: Disable, Enable, and Both.

3 |Certification Chain |Whether or not certificate-chain verification is performed. Choices: Disable,
Enable, and Both.
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Figure 3-97 Verify Signature Properties Window—Export Parameters

VerilySignature 2

Cisco Syavems
Elsdalel Garoup “Seturly”

|§] Expeirted Parsmelers
@ E: Contert Enput Parameters Resuit (Content’ -

Bo Adbvared Inpit Parsmeters >

b

b o J(os ]| §
1 ‘Result New content that needs to be exported from the Bladelet.

Outcome
» On success, it verifies all signatures, then takes the success path.

- If even one signature verification fails, it takes the fail path.

Exceptions
» Signature Not Found: No signature information is available in the message.

Sign
Summary

Sign Bladelet basically creates digital signature on partial or entire SOAP/XML documents. This
Bladelet is capable of signing non-XML and multipart messages. In summary:

« If thesigning Bladelet signsrelevant parts of MIME message, execute the ExtractCompositeContent
Bladelet before the signing Bladelet so asto obtain contentListlterator variables that can be used in
signing Bladelet.

» A new export variable should be created so as to contain the signed MIME message. This sign
MIME message can integrated back into the original message by using the CreateM essage Bladel et.

- For non-MIME message, the original message is modified inline and hence no need to configure the
export parameter.
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Prerequisites and Dependencies
« Create and import necessary keystores and create a node based signing policy by configuring key
aliasto a particular key pair's key alias, existing in the keystore.
« If the original message is a MIME message, execute the Extract Composite Content Bladelet to
extract the base content and interested attachment's contentListlterators.
Details
If you use the Sign Bladelet to sign relevant parts of MIME message, execute the Extract Composite
Content Bladel et before the signing Bladel et so asto obtain contentListlterator variablesthat can be used
in the Sign Bladelet.
Create a new export variable to contain the signed MIME message. I ntegrate this signed MIME message
back into the original message by using the Create Message Bladel et.
For a non-MIME message, the original message is modified inline and hence no need to configure the
export parameter.
Figure 3-98 Sign Properties Window—Advanced Input Parameters
E Sign Properties
Sign E]
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1 |Digest Algorithm | Type of digest algorithm to be used to create digital signature.
2 |Canonicalization Type of canonicalization algorithm to be used to create digital signature.
Algorithm
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Figure 3-99 Sign Properties Window—Key Configuration, Node Based
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1 [Node Based Type of key configuration. Use node-based key alias instead of any signing
policy. Uses the AON key for signing. Must already be configured in
AMC-Keystore.
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Figure 3-100
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1 |Subject Based Type of key configuration. Key alias is extracted based on the value of the
AONSSubject PEP variable.
2 |Subject Select subject form the auto complete text field.
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Figure 3-101 Sign Properties Window—Key Configuration, Policy Based

E Sign Properties
Sign @

Cisco SYSTEMS
e Mandatory parameter "Policy” nok defined for bladelet "Sign",

Key Configuration
B Signing Scheme : 1
Hker Configuration - Key flias Selection Mechanism: | Policy Based v%-
@ k: Advanced Input Parameters 17
CLApULraraneiE s ol
[ Palicy {policy) - |

@ ' Z

o (e
1 |Policy Based Type of key configuration. Signing policy containing configuration to the
key alias.
2 |Policy Policy. Must already be configured on the AMC server.
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Figure 3-102 Sign Properties Window—Signing Scheme, SOAP, SOAPBody
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1 |Configuration
Group

Configuration group, set here to SOAP.

2 |Input

Source-content input. If you are operating on request message then usually
thisvalueisbound to REQUEST_MESSAGE.content(). If you are operating
on response message then the value of the PEP variable is
RESPONSE_MESSAGE.content().

3 |Key Reference

The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:
« Binary Security Token
« Subject Key Identifier
» Issuer and Serial #

4 |SOAPBody

SOAPBody Signing Scheme. Whole soap body should be signed.
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Figure 3-103 Sign Properties Window—Signing Scheme, SOAP, XPaths
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4 5.
@ A
K
(o (w8
1 |Configuration Configuration group, set here to SOAP.
Group
2 |Input If you are operating on request message then usually this value is bound to

REQUEST_MESSAGE.content(). If you are operating on response message
then the value of the PEP variable is RESPONSE_MESSAGE.content().

3 |Key Reference The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:

« Binary Security Token
» Subject Key Identifier
» Issuer and Serial #

4 | XPath Signing List of Xpath expressions that are used to sign relevant portions on soap
Scheme message.
5 |XPath Value XPath values (string form).
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Figure 3-104 Sign Properties Window—Signing Scheme, SOAP, Attachments

E Sizn Properties

Sign

e Mandatary parameter "aAttachments" not defined For bladelst "Sign®,

E._ Key Configuration Signing Scheme /

@
Cisco SYSTEMS

Configuration group: SOAP v]

®

= MOVANCEd INpUC Parameers
= Export Parameters

“Source Content

Trput (Cantent) */@h’ééﬁéé’f_hﬂiéé'shéé.cEﬁ't'éﬁEt) j

key Reference

©O®

Type of Key Reference to be included in the message (string) * | Binary Security Token v |

S04P Body: | TR v |

@ ®

| Attachments (Contentlistlterator) * | |
)
1 |Configuration Configuration group, set here to SOAP.
Group
2 |Input If you are operating on request message then usually this value is bound to

REQUEST_MESSAGE.content(). If you are operating on response message
then the value of the PEP variable is RESPONSE_MESSAGE.content().

3 |Key Reference

The Type of Key Reference to be included in the message here is Binary
Security Token.

Type of Key Reference choices:
« Binary Security Token
« Subject Key Identifier
» Issuer and Serial #

4 | Attachments
Signing Scheme

Attachments of multipart message, where root part is SOAP message, to be
signed.

5 |Attachments

Attachments of multipart message, where root part is SOAP message, to be
signed.

| oL-11798-01
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Figure 3-105 Sign Properties Window—Signing Scheme, XML, XPaths

E Sign Properties
Sign E]

Cisco SYSTEMS
6 Mandatory parameter "Locations” not defined For bladelet "Sign”,

EI Configuration group: |><ML v

E Kew Confinnratinn Signing Scheme

©

% Advanced Input Parameters
¢ Export Parameters ~Source Conbent
Input {Content) ayi_:gliEQ_L-lE_S:l:.__l\'ﬁE_gS:Q_G_E.content() | 5]
® -
@ » Path: ExPaths v
Locations (list) *
o alue (string)
@ L 3]
Signature Type {string) * EEN\"ELOPED ‘_’u
®
5
1 |Configuration Configuration group, set here to XML.
Group
2 | XPaths List of Xpath expressions that are used to sign relevant portions on soap
message

3 | XPath Locations One or more XPath locations (in string form).

4 |Signature Type Signature type: Enveloped or Enveloping.

5 |Input If you are operating on request message then usually this value is bound to
REQUEST_MESSAGE.content(). If you are operating on response message
then the value of the PEP variable is RESPONSE_MESSAGE.content().
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Figure 3-106

E Sign Properties

Sign

6 Mandatory parameter "Attachments" not defined for bladelet "Sign”,

E- Kew Configuration Signing Scheme

/!

©

¢ Advanced Input Parameters
= Export Parameters

rSource Content

Bladelet Choices

Sign Properties Window—Signing Scheme, XML, Attachments

@
Cisco SYSTEMS

Configuration group: IXML

b

@E® ®

Input (cUntent);’i_glié.dﬂé%:r__ﬁég-s.;\GE.content()

wPath: | v l

Attachments (ContentlistIterator) *ﬂl |
Signature Location {string) * ﬂl |

142058

1 |Configuration
Group

Configuration group, set here to XML.

2 |Attachments

Attachments of a multipart message, whereroot part is SOAP message, to be
signed.

3 |Attachments List

Selected attachments.

4 |Signature Location

Location of the signature.

5 |Input

If you are operating on request message then usually this value is bound to
REQUEST_MESSAGE.content(). If you are operating on response message
then the value of the PEP variable is RESPONSE_MESSAGE.content().
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Figure 3-107 Sign Properties Window—Signing Scheme, Non-XML, Source Content

E Sizn Properties

Sign @
Cisco SYSTEMS
@ Mandatory parameter "Input” not defined For bladelet "Sign®,
|_2_L‘J Configuration group: |NON_—>;|:‘1L_\:
@ E Kew Configuration Signing Scheme
= Advanced Input Parameters
R EXpOrE Parametets ~ Content: iSourceContent v|
® o] 0
Input {(Contenk) * L |
@ ol
2
=]
| Help (0]4 Cancel ol
[ ] §
1 |Configuration Configuration group, set here to Non-XML.

Group

2 |Source Content Base content of the original MIME message.

3 |Input Input content.
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Figure 3-108 Sign Properties Window—Signing Scheme, Non-XML, Attachments

E Sign Properties El
Sign @
Cisco SYSTEMS
e Mandatory parameter "Attachments" not defined for bladelet "Sign”,
Configuration group: |NOI:I—><ML:i
E, Kew Configuration Signing Scheme /
@ k= Advanced Input Parameters
s Export Parameters Content !.
A
@ | Attachments {ContentListIterator) * | I
2
1 |Configuration Configuration group, set here to XML.
Group
2 |Attachments Data structure that stores list of interested contents, which need to be
digitally signed.
3 |Attachments List One or more attachments.

Cisco AON Development Studio User Guide
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Figure 3-109 Sign Properties Window—Export Parameters

E Sign Properties

Sign @
Cisco SYSTEMS

e Mandataory parameter "attachments" not defined For bladelet "Sign”,

@ Exported Parameters

= Signing Scheme Result {Content) |- _';_i

B: Key Configuration
k= Advanced Input Parameters
O HiE<port Parameters

1 |Result Signed content. Usually use when the original message is a MIME message

or non-XML message.

Qutcome

» On successfully signing, requested messages that are not multipart messages contain digital
signature information. For non-XML and multipart messages, export signed content of the Bladelet.

Exceptions
« Private Key Not Found: If the private key cannot be extracted from configured key alias.

» Data Not Found: No datais found to create the digital signature.

Decrypt

Summary
* | The Decrypt Bladelet decrypts encrypted XML, SOAP or non-XML messages as well as attachments.

Prerequisites and Dependencies

» Configure decrypt policies and deploy them using the AMC server o send policies and keystores to
AON.

Cisco AON Development Studio User Guide
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Details

The Decrypt Bladelet decrypts SOAP messages containing data that has been encrypted with a
symmetric key that has also been encrypted using an asymmetric public key. Given the private key of the
recipient message as an input parameter, this Bladelet moves the CPU-intensive decryption operation to
AON. Decrypt any or all of the encrypted datain a SOAP document by specifying the corresponding
elements using X Path expressions. AON checks the destination URI of the message to determine the key
alias for Decryption. For asymmetric key decryption, the Decryption key aliasisidentical to the
destination hostname.

Figure 3-110 Decrypt Properties Window—Key Configuration, Resource URI Based

E Decrypt Properties
Decrypt @
Cisco SYSTEMS
6 Mandatory parameter "Input” not defined For bladelet "Decrypt”,
EI Key Configuration
= Conkent Input Parameters = i
& Configuration Key Alias Selection Mechanism: |Resource URI Based w 1
s Expart Parameters -
@ —
Resource LRI {skring) * | @
© & |
&
1 |Resource URI Resource URI Based is set as the key alias selection method.
Based
2 |Resource URI URI of the intended recipient of this encrypted message. The key alias

corresponding to this resource decrypts the symmetric key. Must already be
configured on the AMC server.

Cisco AON Development Studio User Guide
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Figure 3-111 Decrypt Properties Window—Key Configuration, Policy Based

E Decrypt Properties
Decrypt @
Cisco SYSTEMS
e Mandatory parameter "Input” not defined for bladelet "Decrypt”,
Key Configuration
= Content Input Parameters
@ 3 r Parameters
Policy (policy) * | V_|
@
&
1 |Policy Based Policy Based is set as the key alias selection method.
2 |Policy Reference of the decryption policy. The key alias in this policy decrypts the

symmetric key, irrespective of the resource URI that may be configured in
this policy. Must already be configured on the AMC server.
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Figure 3-112 Decrypt Properties Window—Content to Decrypt

E Decrypt Properties

Decrypk @
Cisco SYSTEMS
6 Mandatory parameter "Input” not defined for bladelet "Decrypt”,

Content Input Parameters

kent Input Parameters

ey Configuration Source Content

m= Export Parameters Input {Conkent) * [ |

@ al

~#Path

Locations {list) Add Row
.+ Walue (string)

@) &)

142027

1 |Input Input content that contains the encrypted data.

2 | Xpath Locations One or more XPaths for elements to be decrypted in the message. If blank,
decrypts all encrypted data in the message.
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Figure 3-113 Decrypt Properties Window—Export Parameters

E Decrypt Properties E|

Decrypt @

Cigco SYSTEMS
6 Mandatory parameter "Input” not defined for bladelet "Decrypt”,

[EJ Exported Parameters

Content Input Parameters Result {Conkent) |

Kew Configuration 3
AE<port Parameters /

1 |Result Output variable that contains the decrypted output of this Bladelet. Need not

be set if the message being encrypted is of plain XML, SOAP or non-XML
types (without attachments).

Outcome
» Success: Path taken if the Bladelet successfully decrypts the incoming message.

« Failure: Path taken if the Bladelet is unable to decrypt the message for any reason.

Exceptions
« Private Key Not Found: Path taken if the Bladelet is unable to retrieve the private key needed to
decrypt the encrypted symmetric key from the message.

» Encrypted Data Not Found: Path taken if the Bladelet does not find any encrypted data in the
message. Also if one or more XPaths are specified to decrypt, then this Exception is thrown if no
encrypted elements are found at those X Path locations.

Identify

Summary

@ AON messages can use several types of claims or proof of identity. These items are generically referred
to as “subjects.” This Bladelet can extract all subjects of specified types from the message being
processed by the PEP.

Cisco AON Development Studio User Guide
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Extract multiple types of identities at either the transport or message level, but not both.

Different types of identities are put into different sublistsin SecurityContext and can be retrieved with
different get functions.

Aslong as there is one identity extracted, the output path is“ Success.” When no identity is extracted,
the output path is“Failure.”

When there is no identity extracted, no HTTP-level challenge or soapfault is generated. Those message
can be generated only by subsequent Bladelets that try to use the identity information for different
purposes, such as authenticate and identity verify.

Prerequisites and Dependencies
None.

Cisco AON Development Studio User Guide
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Details

Figure 3-114 Identify Properties Window—Input Parameters, Transport Level Identity

E Identify Properties

Identify 2]

Cisco SYSTEMS
@ Qutput parameter not baund

Configuration group: !TRANS-POIi:I'LEVE_L\_q
@ E Export Parameters Input Parameters /
roource
Input Message (Message) * :{RE%PONS_E_MESSB.GE |
@ '
Identity Location
J HTTP Basic Authentication (boolean)
@ []HTTP Megatiate Authentication (baalean)
L []55L Peer Certificate (boolean)
3
1 |Configuration Configuration group, set here to Transport Level.
Group
2 |Input Message Incoming message to extract identity information from.

3 |ldentity Location |Location from which to extract HTTP information:

« HTTP Basic Authentication—Extracts HTTP basic authentication
information from incoming message.

- HTTP Negotiate Authentication—Extracts HT TP negotiate
authentication information from incoming message.

e SSL Peer Certificate—Extracts SSL peer certificate from incoming
message.
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Figure 3-115

Identify

E Identify Properties

@ Cutput parameter not bound

E. Export Parameters Input Parameters /

Bladelet Choices

Identify Properties Window—Transport Layer Identity, Message Level Identity

@
Cisco SYSTEMS

Configuration group: :MESSAGE LEVYEL |

roource

Inpiit Content {ContentListTterator) * | $RESPONSE_MESSAGE.content().iterator() i

~ | rIdentity Location

WS Security Username Token {boolean]

[] s Security SPNEGO Token (boolean;)

[ w3 Security %.509 Certificate Chain Token (boolean)

[ ws Security SaML Token (boolean)

142045

=

Configuration
Group

Configuration group, set here to Message Level.

Input Content

List of content to extract identity information from.

I dentity Location

L ocation from which to extract security-token information:

* WS Security Username Token—Extract WS-Security Username Token
information from incoming contents.

* WS Security SPNEGO Token—Extract WS-Security SPNEGO Token
information from incoming contents.

e WS Security X.509 Certificate Token—Extract WS-Security X.509
Certificate Token information from incoming contents.

» WS Security X.509 Certificate Chain Token—Extract WS-Security
X.509 Certificate Chain Token information from incoming contents.

« WS Security SAML Token—Extract WS-Security SAML Token
information from incoming contents.

| oL-11798-01
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Identify Properties Window—Export Parameters

Figure 3-116
Tdentily @
o Cisco SrsTimg
CHRpE Py ameees fet beard M
= Exported Parsmeters
1 Ingut Parameters Fiecrlt { SecunitiConkextiistiternsbor ) -
g oois Faramoted: Pl
I.r'i'\ /
s
1 b
o _J(owed ]|g

1 |Result Data structure that stores the identity information extracted from the
incoming message or contents. Allows the subsequent Bladelet to make use

of the identity extraction results from the Identify Bladelet.

Outcome
On success, a SecurityContextL istlterator is populated with all the identity information extracted

from incoming message.
On failure, an empty SecurityContextL istlterator is exported.

Exceptions
None.

Authenticate

. | Summary
“ | The Authenticate Bladelet authenticates various credentials from the | dentify Bladelet. An HTTP header

or SOAP message are among the variety of sources that the Authenticate Bladelet can obtain identities
from. You can set various property types for the Authenticate Bladelet.

oL-11798-01 |
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Prerequisites and Dependencies
« The AONSSubjects to be authenticated are generated by Identify Bladelet. Ensure that |dentify
Bladelet precedes Authenticate Bladelet in avalid PEP and that the export parameter of Identify
Bladelet retrieves the AONSSubjects.

Details
An Authenticate Bladel et authenticates only one type of identity. To authenticate multiple types of
identity, you must use multiple instances of Authenticate Bladelet in the PEP.

To perform HTTP-based authentication, put an Authenticate Bladelet on the “Failure” path of the
Identify Bladelet used to extract the credential to generate proper HTTP authentication challenge.

In order to generate HT TP response or proper soapfault message on exception cases, no Bladelet should
be put on the exception path of the Authenticate Bladelet.

Each required field in the Bladel et Properties window is marked by ared asterisk. Until all required
fields are completed with the correct value, an error message appears on top of the Bladelet Properties
window to indicate which field remains to be completed or indicates that there is a parameter type
mismatch and so on before the Bladelet is completely configured.
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Figure 3-117 Authenticate Properties Window—Advanced Input Parameters

E Authenticate Properties

Authenticate =

Cisco SYSTEMS
@ Mandatory parameter "Profile" not defined for bladelet "Authenticate”,

[?EJ Advanced Input Parameters

¢ Input Parameters

Hadvanced Input Parameters HTTP Authentication Options -

ﬂ'—il Basic Authentication (boolean)

I | | Basic Authentication Realm (string)/!

| [¥] Megatiate Authentication {boolean)

@ ®C

142140

o)==

1 |Basic Whether or not this Bladelet supports HTTP basic authentication.
Authentication

2 |Basic Customized basic authentication realm. If nothing is defined, AON node
Authentication hostname is used as default realm name.
Realm

3 |Negotiate Whether or not this Bladelet supports HTTP negotiate authentication.
Authentication

Cisco AON Development Studio User Guide
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Figure 3-118 Authenticate Properties Window—Input Parameters, LDAP

Authenticate

@ Configuration group: | LDAP |

Authenticate Properties

e Mandatary parameter "Profile” not defined For bladelet "authenticata",

Advanced Inpuk Parameters Input:Parameters

O

“Subjects to Authenticate -

Bladelet Choices

Cisco SysTEMS

@ Input Subjects (SecurityContextListIterator)*é — |
I Method (string) * ;}jTTP-BASIC \:l
®
rResult Caching Cptions -
@ Expiration Interval in Seconds {long) *ﬂés-DD
@ Profile (policy) * 3'_-__\9
Mulkiplicity (string) * E_ALL = |
® ~
BT
1 |Configuration Configuration group, set here to LDAP.
Group
2 |Input Subjects Data structure that stores the identity information to be authenticated. It
should be exported by an Identity Bladelet.
3 |Method Type of the identity to be authenticated in this Bladelet.
4 |Expiration Interval |Time-to-live value for locally cached credentials.
in Seconds
5 |Profile LDAP policy with configuration information for LDAP servers used to
authenticate the subjects.
6 |Multiplicity Whether or not all or any subject in the list needs to be valid for the final
success of the Bladelet.
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Figure 3-119 Authenticate Properties Window—Input Parameters, Kerberos

E Authenticate Properties

Authenticate

e Mandatory parameter

"Profile” not defined for bladelet "Authenticate,

E. Advanced Inouk Paramekers Input Parameters

=
Cisco SYSTEMS

Configuration group: : KERBEROS w ;

&

-Subjects ko Authenticate

Input Subjects {SecurityContextListTkerator) */ i @

‘ Method (string) * |HTTP-NEGOTIATE ~ |

| Prafile {policy) * lﬂ v

Mulkiplicity {skring) * .[ALL N

@ ®@®

142148

o [ ]

1 |Configuration
Group

Configuration group, set here to Kerberos.

2 |Input Subjects

Data structure storing theidentity information to be authenticated. Should be
exported by an Identity Bladelet.

3 |Method Type of the identity to be authenticated in this Bladelet.

4 |Profile Kerberos policy with configuration information for KDC and Kerberos
services used to authenticate the subjects.

5 |Multiplicity Whether or not all or any subject in the list needs to be valid for the final

success of the Bladel et.

[l Cisco AON Development Studio User Guide
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Figure 3-120 Authenticate Properties Window—Input Parameters, SiteMinder 5.5

E Authenticate Properties

Authenticate =
Cisco SYSTEMS

e Mandataory parameter "Resource” not defined For bladelet “authenticate”,

EJ Configuration group: | SikeMinder 5.5 |

E- Advanced Input Parameters cg.authnscheme

&

rSubject ko Authenticate
Subject (AOMSSUbject) * | |
@ "
rExtension Configuration
@ Resource (string) * /' | [E]
Extension Profile (policy) * | v!
®
1 |Configuration Configuration group, set here to SiteMinder 5.5.
Group
2 |Subject AONSSubject. It specifies the subject being authenticated.
3 |Resource String. Resource the subject is trying to access.
4 |Extension Profile | Policy. Property set that specifies parameters used to connect to a Policy
Server.

Qutcome

= On success, valid AONSSubject is marked as authenticated and can be retrieved through the
following attributes of SecurityContext:

— wssUsernameTokensA uthenticated
— httpBasicAuthsAuthenticated

— wssSPNEGOTokensA uthenticated
— httpNegA uthsAuthenticated

Exceptions

» Credential Unavailable: No credential is available for the specified type in the source
SecurityContextListlterator object.

- Communication Failure: Failed to communicate with the configured LDAP server or KDC.
« Credential Invalid: Authentication failed due to invalid credential.

| oL-11798-01
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Verify Identity

| Summary

2

ﬂ This Bladelet verifies whether the following types of identities are trusted by the AON node. The trust
can be verified by CA root trust only or you can enforce that the certificate itself hasto be present in the
node's trust store.

Prerequisites and Dependencies

- The AONSSubjects to be verified are generated by |dentify Bladelet. Ensure that Identify Bladelet
precedes Verify |dentity Bladelet in avalid PEP. Use the export parameter of Identify Bladelet to
retrieve the AONSSubjects.

» Populate “trustedCACerts:” with trusted CA certificates. If the certificate itself hasto be in the trust
store to be considered trusted, populate the "trustedCerts" properly as well.

Details

A Verify ldentity Bladelet can verify only one type of identity. To verify multiple types of credentials,
multiple instances of Verify Identity Bladelets need to be used in the PEP.

In order to generate proper soapfault messages for exception cases, no Bladelet should be put on the
exception path of the Verify Identity Bladelet.

Cisco AON Development Studio User Guide
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Figure 3-121 Verify Identity Properties Window—Input Parameters

YerifyIdentity @
Cisco SYSTEMS
Bladelet Group "Security”,
Input Parameters
Minput Parameters |
5ubjects-
O Input Security Conkext (SecurityContextListIberator) "‘ﬁ.fRESPONSE__MEéAGEh;d;:) |
1 .
Identity Tvpe (string) *
@
Configuration -
Multiplicity: (string) * | ALL ;
[] CA Root Yalidation Only (boolean)
@
(o e 8
1 |Input Security Data structure that stores the identity information to be authenticated.
Context Should be exported by an Identity Bladelet.
2 |ldentity Type Type of the identity to be verified in this Bladelet.
3 |Multiplicity Whether all or any of the subject in the list needs to be valid for the final

success of the Bladelet.

4 |CA Root Validation |Whether the certificate needsto be trusted by one of the CAsin the CA trust

Only store or to be present in the trust store of the node.

Outcome

« On success, valid AONSSubject is marked as verified and can be retrieved through the following
attributes of SecurityContext:

Excepti

wssX509CertTokensVerfied
wssX509CertPathTokensVerified
SAMLAssertionsVerified

SSL PeerCertsVerified

ons

« Token Unavailable: No identity information is available for the specified type in the source
SecurityContextListlterator object.

« Token Invalid: Theidentity is not trusted by the node.
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Cisco AON Development Studio User Guide



Chapter 3 ADS Bladelets Reference |

M Bladelet Choices

Transformation Category

The Transformation Category has one Bladelet:

« Transform

Transform

Summary
o and

L] This Bladelet performs transformation on AON Message Content. It can transform an XML message
content to an XML or Non-XML content using XSLT Based Transformation mechanism. Further,
Non-XML message content can also be transformed to XML or Non-XML message content by providing
acontent parser extension.

If the message is not a multipart message, then its contents can be transformed and result of the
transformation can be placed in the specified message and additionally can be exported as a PEP
variable.

If the message is a multipart message and the list of contents are transformed in to alist of result
contents, you must use BuildCompositeM essage to build a result multipart message.

Prerequisites and Dependencies
- Define a Transform Property Set value from the AMC server.

» Transform property set specifies a Style Sheet to use in transformation. In the Transform Property,
specify the name of the style sheet and the package in which it is provided. Transform packages are
created using ADS and loaded and registered in AMC. Deploy the transform package on a node
before using the style sheet in transformation in PEP on the node.

» For using Content Parser property set in the Bladelet, define Content Parser property set from the
AMC server.

« If the Content Parser property set so defined uses Parser Plug-in and Transformer Plug-in classes,
design these classes and provide them in a Content Parser package in ADS. Load the package and
register it with the AMC server.

Cisco AON Development Studio User Guide
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Details

Figure 3-122

Transform

1
s Export Parameters

ﬂ Transform Properties

G Mandatory parameter "Input” not defined for bladelet "Transform®,

Bladelet Choices

Transform Properties Window—Input Parameters

@

Cisco SysTEMS

Input Parameters

Source Content

P Irput {(Contentlistteratar) * I @

®E

» Update Message (Message) | I @

~Transform Parser Package

S

©

‘}_" Content Parser {policy) | w

~Transform Package -

®

» Style Sheet (policy) | v

Help

142062

1 |Input

List of contentsto transform. Content can come from either of the following:

« It can be extracted and provided in alist by calling method
content->iterator() on the Message PEP variable.

= It can come from the results of a ExtractCompositeM essage Bladelet.

2 |Update Message

M essage in which the transformation result is placed.

If input contains multiple contents, you must export the result of
transformation in a Result. Use BuildCompositeM essage Bladelet to build a
multipart message.

Additionally or alternately, you can export the result in a PEP variable
selected under the Export Parameter section in the Result field.

3 |Content Parser

Content Parser property set. Defines parser plug-in and transformer plug-in
classesto use if specified. Must already be created in the AMC server.

4 |Style Sheet

Transform property set. Defines name of the style sheet to use for
transformation. Must already be created in the AMC server.

| oL-11798-01
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Figure 3-123 Transform Properties Window—Export Parameters

E Transform Properties
Transform @
Cisco SYSTEMS
9 Transformation result not updated in message of exported,
@] Exported Parameters
:-. Input Parameters Result (ContentListIterator) | _"v |
Export Parameters = g
@ 7
]
o ) )
1 |Result List that contains transformed contents. After the results of the

transformation are placed in a PEP variable, they can be used in subsequent
transformation or can be used to build a mulitpart message using
BuildCompositeM essage Bladelet.

Qutcome

- Transform Bladelet performs the transformation of message content based on the Style Sheet
property and Content Parser policy. If transformation is successful, transformed content can be
updated in the message selected in Updated Message field. If transformation is operating on a list
of contents, the result of transformation must be exported in Result parameter.

If transformation is successful, Success output path is set. In case of failure, Fail output path is set.

Exceptions
None.

Miscellaneous Category

The Miscellaneous category contains no Bladelets.
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ADS PEP Attributes Reference

Revised: March, 2007, OL-11798-01
This chapter presents detailed reference information that you need to use Cisco AON Development
Studio (ADS) to assign Policy Execution Plan (PEP) attributes.

S

Note  For more information on implementing an AON network, see the following:

» Other chaptersin this guide:
— Getting Started with Cisco ADS
— Setting Bladelet Properties, Variables, and Rules
— ADS Bladelets Reference
— ADS Message Types Reference
— E-Mail to Cisco ADS Support
« Other guidesin the AON library:
— AON Installation and Administration Guide (for information on the AMC server and nodes)

— AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)

Contents

» Information About PEP Attributes, page 4-1
- PEP Attribute Window and Dialog Boxes, page 4-2
» PEP Attribute Variable-Type Choices, page 4-2

Information About PEP Attributes

PEP attributes are items such as name, package, description, interaction style, and operating variables
that apply to the entire collection of Bladelets and paths that constitute a PEP.
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M PEP Attribute Window and Dialog Boxes

PEP Attribute Window and Dialog Boxes

Common tasks involving creating PEPs are discussed in “ Getting Started with Cisco ADS” chapter. This
section describes how to assign PEP attributes, when you start to create a PEP or at any later time.

You assign PEP attributes by means of the PEP Attributes window (Figure 4-1) and subsequent dialog
boxes. (To open this window, follow the procedure in the “Creating PEPS’ section on page 1-11.)

Figure 4-1 PEP Attributes Window
E PEP Attributes [Project Finance) @

@

Ise this dialog to edit the attributes of the PER, The PEP name cannot be changed.  Cisco SYSTEMS
Grayed out varisbles are system defined and cannot be deleted

HMame | Stackouate| |
Package | : | stocktrades |
Fram AMC - {locally created)

Description [ ‘
Interaction Stvle éRequest—Respunse V

PEP Attribute Variable-Type Choices

PEP attributes are listed in Table 1.

Table 1 Variable Definition: Available Types

Type Description

AONSSubject Subject of the AON message.
AONSSubjectListlterator Iterator for alist of AONSubject objects.
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Table 1 Variable Definition: Available Types (continued)
Type Description
Content Content of the AON. An object of thistype is created by the

CreateContent Bladelet and is consumed by the CreateM essage
Bladelet. You do not create this directly; rather, it is created by the
CreateContent Bladelet. The message type has a content attribute that
returns the content of the message (example:
REQUEST_MESSAGE.content() gives the content of the incoming
message). Content has the following attributes:

« numParts—If the underlying contentisaMIME content, returnsthe
number of parts in the content. The number of parts of aMIME
content in the incoming message is given by
REQUEST_MESSAGE.content().numParts().

« document—If the underlying content is of the XML type, returns
the Document object corresponding to the actual content. The
document representation of the content in the incoming message is
given by REQUEST MESSAGE.content().document().

ContentL istlterator List of content values (see Content for details) that can be accessed one
at atime.
Document DOM document. An object of this type can be extracted from the

Content object (see Content for details) if the content is XML. You do
not create this directly.

FindContentL istlterator Iterator for content list search results (see Content for details).

FindResult Collection of search results for one Xpath. You do not create this
directly; rather, it is generated by the Find Bladelet. It has the following
attributes:

» String value—For a single node, returns the string value of the
node; for alist of nodes, returns the string value of the first node.

- String node Value(i)—Returns the string value of the ith node

« int size—Returns the size of the result set.

FindResultMaplterator Iterator for amap of X path/Regex search results. The key for themapis
the name of the input Xpath. The value of the map is the FindResult
corresponding to that Xpath. Thisis generated by the Find Bladelet. It
has the following attributes:

+ FindResult first
« FindResult last
« Findresult elementAt

FindResultMapL istiterator |Iterator for a map list of Xpath/Regex search results (see above).
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Table 1 Variable Definition: Available Types (continued)
Type Description
Message AON message. The PEP variable REQUEST_MESSAGE of thistypeis

available in the request-action and represents the incoming message.
The PEP variable REQUEST_MESSAGE of thistypeisavailablein the
response-action and represents the outgoing message. The

CreateM essage Bladel et can create an object of thistypeinthe PEP. You
do not create this directly. It has the following attributes:

« messagel d—Returns the id of the message. The id of an incoming
message is given by: REQUEST _MESSAGE.messagel d()

« timeStamp—Time at which the message was created. The
timestamp of the incoming message is given by
REQUEST _MESSAGE.timeStamp()

» srclP—IP address of the message source. The source IP of the
incoming message is given by REQUEST_MESSAGE.srcl P()

- srcPort—Port number of the message source. The source port of the
incoming message is given by REQUEST_MESSAGE.srcPort()

« destlP—IP address of the message destination. The destination IP
of the incoming message is given by
REQUEST_MESSAGE.destIP()

» destPort—Port number of the message destination. The destination
port of the incoming message is given by
REQUEST_MESSAGE.destPort()

» destProtocol—String representation of the message protocol. The
protocol name of the incoming message is given by
REQUEST_MESSAGE.destProtocol()

» header—Value of the header in the message. The User-Agent
header of the incoming message is given by
REQUEST _MESSAGE.header(User-Agent)

« content—AON Content of the message. The content of the
incoming message is given by REQUEST _MESSAGE.content()

» URI—Destination uniform resource identifier (URI) of the
message. The URI of the incoming message is given by
REQUEST_MESSAGE.URI()

SearchResult Maps a search specifier to alist of content. In each case, the search
specifier isdetermined by a previously specified search criteria. You use
the search specifier to locate the corresponding result for a particular
search criteria.

SearchResultListlterator Iterator over alist of SearchResult objects.

SecurityContext Store of subject and credential information for certain message or
content.

SecurityContextListlterator |lterator for alist of SecurityContext objects.

Boolean Value of either true or false.

byte Value that you can input directly. Range: —128 to 127.
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Table 1 Variable Definition: Available Types (continued)

Type Description

double Value that you can input directly. Range: 4.9E-324 to
1.7976931348623157E308.

float Value that you can input directly. Range: 1.401298464324817E-45 to
3.4028234663852886E38.

int Value that you can input directly. AON usesthisin its Bladelets. Range:
—2147483648 to 2147483647.

iterator Keeps the state of aposition in alist. It can be used for accessing items

from the data structure and can be viewed as alist, array, or stream. It is
able to do so one at atime.

list List or collection of objects. The element of alist can be any object (such
as astring). It has the following attributes:

« Size—Returnsthe size of thelist. For example, if aPEP variable “1”
of type list is defined in the PEP, |.size() gives the number of
elementsin the list. To retrieve the nth element in alist, specify
list[n]. For example, to get the first element in alist, specify list[0]

long Value that you can input directly. Range: —-9223372036854775808 to
9223372036854775807.
map Collection of name-value entries. AON supports maps of string-typed

keysto string-typed values. It has the following values:

« Size—Returns the size of the map. For example, if a PEP variable
“m” of type map is defined in the PEP, m.size() gives the number of
entries in the map.

To retrieve the value in a map corresponding to key “K”, use map{K}.
In case of alist of maps, to access the value corresponding to key “K”
inthe first map in the list, use list [0]{ K}.

object Any object. You do not provide this directly. If input to a Bladelet is of
this type, any PEP variable can be bound to the input.

short Value that you can input directly. Range: —32768 to 32767.

string String of characters. Type the string in the ADS text box or text area.
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= CHAPTER 5

ADS Message Types Reference

Revised: March, 2007, OL-11798-01
This chapter presents detailed reference information that you need to use Cisco AON Development
Studio (ADS) to assign message types.

For more information on implementing an AON network, see the following:

» Other chaptersin this guide:
— Getting Started with Cisco ADS
— Setting Bladelet Properties, Variables, and Rules
— ADS Bladelets Reference
— ADS PEP Attributes Reference
— E-Mail to Cisco ADS Support

« Other guidesin the AON library
— AON Installation and Administration Guide (for information on the AMC server and nodes)

— AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)

» Information About Message Types, page 5-1
» Message Type Window and Dialog Boxes, page 5-2

Information About Message Types

A message type is afilter that determines what type of message a PEP is to process. An AON node
identifies a message of interest based on the details you specify in a message type. These details, which
can include items such as message content, | P addresses, or message headers, are used to trigger the
associated PEP. They can also be used to trigger encoding and message delivery properties.

| oL-11798-01
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Message Type Window and Dialog Boxes

Common tasks involving creating PEPs are discussed in “ Getting Started with Cisco ADS” chapter. This
section describes how to assign message types.

You assign message types by means of the Message Type Definition window (Figure 5-1) and
subsequent dialog boxes.

Figure 5-1 Message Type Definition Window
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Message Type Choices
N

Note - Only the nameis arequired field. Other fields are optional, although you will want to configure as
many fields as possible to ensure that the node properly identifies messages of interest.

« Many of the following windows allow you to specify values in one or more of the following ways:
— By typing them in directly
— By selecting them from a drop-down list
— By binding the parameter to a specific value

Table 1 Message Type Definition Window

Field Description

Name Name for the message type.

Message Classifier M essage classifier. |P address and port of the originator and destination of a

message. Must already be configured on the AMC server. The full pathin
AMC is AMC > Network Nodes > Configure > ACL /Classifier.

URI Uniform resource identifier (URI) for the message.
Rule Type Rule type:
« Parameter Rules—Identify messages based on data contained in their
URLs.
» Header Rules—Identify messages based on data contained in their
headers.
« Content Rules—Identify messages based on content in the message
body.
Rules Rule, typically with the following components:

« Item that the node should identify
« Equalsor Not Equals
- Value associated with the item
The following example shows an XPath-expression content rule:

//PO/poRequestInfo[l] /poRequest/purchaseInvoiceNumber equals
100000

When the node receives an XML message in which the invoice number
equals 100000, the message is further processed by the associated PEP and
other policies.

Note  Due to limitations within the Windows user interface, it is possible
to unknowingly include spaces before or after an expression,
especially if you are pasting alengthy string from another
application. These extra spaces can cause processing errors when
actual messages arrive without the spaces. To avoid including extra
spaces, check the “Trim trailing and leading spaces...” box.

PEP Existing PEP to be used to process messages identified by the message type.
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Table 1 Message Type Definition Window (continued)
Field Description
Encoding Encoding property that defines how and when a message is to be

compressed. This must already be configured on the AMC server. The full
pathin AMC is Properties > Application > Node > Edit Properties >
Encoding.

Delivery Delivery property that affects the ordered and reliable delivery of messages
to destinations. Depending on the configuration, multiple messages can be
delivered in a predefined order, and the node continues attempting to deliver
amessage until successful. This must already be configured on the AMC
server. The full pathin AMC is Properties > Application > Node > Edit
Properties > Delivery Connection.

QoS Mapping real Application QoS value to a ToS/DSCP value using a global
policy in AMC. This policy is available under Application. This must
already be configured on the AMC server. The full path in AMC is
Properties > Application > Global > QoSM apping.

Note If you do not choose an application QoS value for an AON message
then by default Application QoSis set to the DSCP value of 0 (zero).

Cisco AON Development Studio User Guide
m. oL-11798-01 |



= CHAPTER 6

E-Mail to Cisco ADS Support

Revised: March, 2007, OL-11798-01
This chapter presents detailed information about the E-mail to ADS Support.

S

Note  For more information on implementing an AON network, see the following:

» Other chaptersin this guide:

Getting Started with Cisco ADS

Setting Bladelet Properties, Variables, and Rules
ADS Bladelets Reference

ADS PEP Attributes Reference

ADS Message Types Reference

« Other guidesin the AON library

AON Installation and Administration Guide (for information on the AMC server and nodes)

AON Programming Guide (for information on custom Bladelets, custom adapters, and
application program interfaces)

Contents

E-mail Support

- E-mail Support, page 6-1

» Prerequisite for E-mail to ADS Support, page 6-2

« Accessing the E-mail to ADS Support Template, page 6-2

« E-mail Attachments, page 6-4

AON 2.1 introduces the E-mail to Cisco ADS Support feature. This feature provides a built in E-mail
template dialog in ADS. You can now send E-mail to Cisco Technical Assistance Center (TAC) with the
Policy Execution Plans (PEPs) attachments or logs to get help on specific issues and support for Cisco

ADS.

| oL-11798-01
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M Prerequisite for E-mail to ADS Support

The E-mail template is designed with all the basic E-mail features—From, To, CC, Subject, and
Message. Additionally, the template also provides the Service Request I dentification number (SR #)
field where you must enter your Service Request Identification number. This helps Cisco TAC to
identify you as a customer.

The From address and the mail server name is pre-populated from the settings defined in the E-mail
template, provided you have set the E-mail Preference during the stepsin “ Starting and Exploring Cisco
ADS’ section, in Chapter 1, Getting Started with Cisco ADS.

The E-mail template also provides an extensive way to attach the elements of ADS with the E-mail to
Cisco TAC. You can attach logs, PEPs, Nodes, Message Types, or packages by selecting a check box.

Prerequisite for E-mail to ADS Support

» TheFrom address and the mail server name must be set in the E-mail Preference, otherwise you will
not be able to send any E-mail to Cisco TAC. To set E-mail Preference, go to Tools > Options >
Set Email Preference and add your E-mail address and mail server name.

» You must enter your Service Request Identification number (SR #) in the E-mail template, if the
E-mail is sent to the Cisco TAC to “attach@cisco.com”.

N

Note  You get the Service Request I dentification number (SR #) from Cisco when you get your licence; if you
do not have the number, please contact your Cisco representative.

Accessing the E-mail to ADS Support Template

Use the E-mail to ADS template and send an e-mail to Cisco TAC, perform the following steps.

Stepl  To access the E-mail to ADS Support template (Figure 6-1), go to Help > Support > Email ADS
Support.
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Accessing the E-mail to ADS Support Template

Figure 6-1 E-mail to ADS Support Template
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1 |Propagated Project |This panel ( your propagated Project Explorer Pane) allows you to select

Explorer Pane PEPs and Message Types as attachments with the E-mail by clicking acheck
box.

2 |From Your E-mail address.

To The E-mail address for Cisco TAC—attach@cisco.com. This box provides
alist of all the previously used addresses and allows you to select the
address.

4 |CC Other addresses.

5 |Subject A brief description of your problem.

6 |SR# Your Service Request Identification Number.

7 |Attachments Types of files. See the “E-mail Attachments” section on page 6-4.
8 |Message The message window.

When your message is complete and you have selected the attachments for Cisco TAC, click Send.
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W  E-mail Attachments

E-mail Attachments

E-mail Attachmentsis an important feature of the support provided by ADS 2.1. You can attach the Log
Files, the Synchronization Files, or the Database Dump as attachments with the E-mail by clicking a
check box in the E-mail template (Figure 6-1). This allows Cisco TAC to successfully recreate the
problem or the issue at the development site and provide the solution accordingly. The following
attachment options are provided by default:

- Logs—The default Log File associated with ADS displays all the WARN, ERROR, INFO Level
messages on the Log-4j settings.

- Database Dump—A backup of the existing databaseis constructed and zipped up to be attached with
the E-mail. This would provide an effective way of re-creating the problem seen in the client site.

« Synchronization Log Files—For every Synchronization Operation, a“ Sync from AMC” and “ Sync
to AMC” log files are created to store all the information transferred during Synchronization. These
files could help Cisco TAC to identify whether the problem happened during the Synchronization
process or not.

N

Note  Cisco TAC receives all the attachments as one zip file called, “ Email Attachments.zip” with your E-mail
message. The zip fileis an archived file with the selected PEPs, Message Types, Log Files,
Synchronization Log Files, and the Database Dump.
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